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A Word from the Conference Chairmen 

One of the goals that Tom and I had for the 73rd 
conference was to bring in talented speakers that have 
not presented at the NECCC conference before. This 
year’s conference was planned with the active, engaged 
photographer in mind. Hence, we added more hands-
on activities, more pre-conference workshops, 
character models (in addition to our regular female 
models), walk-abouts, and interactive sessions.  

Each year our annual NECCC photography 
conference contains a magnitude of opportunities to 
learn new techniques, catch up with friends, and 
expand your portfolio. This year’s theme is Recharge, 
Reconnect, Learn, and Be Inspired. We are 
extremely pleased to welcome Canon Explorer of Light 
DARRELL GULIN to  our  Fine Arts stage 
Saturday evening. His presentation is brought to us 
through the generosity of CANON. For the past ten 
plus years Hunt’s Photo and Video has graciously 
sponsored the Sunday morning event. We thank them 
once again for this year’s event of delightful restored 
vintage cars from Cam Snappers Car.  

This conference would not be possible without the 
support of several groups: 

 Our sponsors who provide highly regarded 
speakers, equipment, door prizes. Check out the 
Sponsors listed at the end of these notes.   

 The vendors who provide photographic loaning of 
equipment which has expanded to nine 
companies; Canon, Fuji, Lensbaby, Nikon, 
Olympus, Panasonic, Sigma, Sony and Tamron 
which offer lenses and SLR and mirrorless 
cameras for your use throughout the weekend.  

A conference of this size takes many volunteers 
whose tireless efforts start about ten months prior to 
the Conference. Our sincerest appreciation goes to 
ALL of them. We are indebted to ALL of the chairs and 
their committee members for their many hours of 
work to run a conference of this caliber. Our thanks 
also go to Courtney Richards and Rebeccah Johnson 
from UMASS Conference Services.  Finally, a big thank 
you to our speakers who have taken an additional 
significant effort to prepare these written notes of their 
presentations.  

We are also extremely grateful to Antoinette 
Gombeda and Susan Mosser for their support and 
tutelage; their guidance, sage advice, infinite patience, 
and hands-on assistance was priceless and 
appreciated.  

Tom and I think of the annual NECCC 
photography conference like an annual family reunion 
where, in addition to getting to learn new things, be 
inspired by awesome speakers, and be awed by 
photographs with impact, we get to catch up with so 
many of our photo enthusiast friends - and make new 
friends. We look forward to seeing you in 2019 on 
July 12th, 13th, and 14th for NECCC’s next 
photographic endeavor. Come and bring a 
friend or two! 

Tom Cuchara, MNEC and  
Lisa Cuchara, HonNEC, Cr, Photog.  

2018 NECCC Conference Co-Chairs  
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Photography Basics  

Focus and Exposure can be considered the 
technical parts of photography while composition 
is the artistic part of photography. 

Composition 

The term “composition” applies not only to 
visual arts, but to music, dance, literature and 
virtually any other kind of art.  In certain con-
texts, such as writing, this term may not be as 
widely used, but is just as valid nonetheless.  In 

general, the term “composition” has two dis-
tinctive, yet related meanings. 

First and foremost, “composition” describes 
placement of relative objects and elements in a 
work of art.  Consequently, composition is a key 
aspect of a good work of art. There is hardly a 
way to overemphasize the importance of com-
position.  Any aspiring artist ought to give com-
position of his work a lot of attention. 

Good Composition is a key element of good 
photographs yet is something that is hard to 
define. Instead of looking at composition as a 
set of 'rules' to follow – I view it as a set of 

guidelines that can be used to create a great pho-
tograph. 

Today we are going to look at five guidelines 
that I commonly use when I create my photo-
graphs.  I not only use them but also combine the 
guidelines to create better images. 

I use the word create instead of take because I 
believe that great photographs are created not 
taken. You take a snapshot or a picture of your 
dog with your iphone.  As a professional, ad-
vanced amateur or aspiring photographer, we 
need to create our images instead of taking them. 

These five guidelines I will talk about today 
help me create my images. 

Leading Lines 

 Our eye is naturally drawn along lines 

 A leading line will pull the viewer into the 
picture, affecting the way they view the 
image 

 A leading line will take us towards the 
subject 

 A leading line will take us on a journey 
through the scene 

 There are different types of lines:  
straight, curvy, zigzag, radial, etc. 

Making Better Nature Pictures 
By Hector Astorga (TX) Sponsored by Santa Clara Ranch 

©  Hector Astorga 

http://santaclararanch.com/
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Leading lines are more attractive when start-
ing from the edges of a photograph. Some lines 
are very obvious while others are not so much. 

Leading lines can also be used in wildlife.  Ra-
dial and curvy lines are more attractive than 
straight lines. 

I always like when we get a curvy line that cre-
ates what I call the “Question Mark Line.” 

Some leading lines are very obvious but work 
great. 

Rule of Thirds 

Probably the most talked about of the compo-
sitional guidelines is Rule of Thirds. We have all 
heard of rule of thirds at one point or another. 

Divide image in 9 equal segments by two ver-
tical and two horizontal lines (tic-tac-toe lines).  

Place the most important elements along these 
lines or at points where they intersect.  This 
adds balance and interest to the photograph. 

You can also combine guidelines to make 
images more attractive. 

Backgrounds 

Probably one of the guidelines that I follow 
the most is backgrounds. 

If you look at my work you will see that I fol-
low this guideline a lot. I believe that this is 
what makes or breaks an image, especially 
when shooting wildlife. 

Clean backgrounds make your subject stand 
out.  A busy background lacks impact because 
the subject blends into it.  A clean background 

takes the two dimensional effect out of a photo-
graph.  Good backgrounds don’t distract or de-
tract from the subject. 

It is important for your background to have 
the same amount of light as the subject. 

Depth 

The main purpose of Depth is to take away the 
2-dimensionality of an image. 

The better we can recreate what our eye sees, 
the better the image. 

Create depth by including objects in the fore-
ground, middle ground and background.  By cre-
ating depth, we take away the two dimensionality 
of a photograph.  Overlap one object with anoth-
er to create depth.  The human eye recognizes 

Lines take the viewer to the main subject of the photo. In this 

case, the lonely tree on top of the sandstone formation.   

Zion National Park, Utah 

©  Hector Astorga 

Main subject matter in this image is the head of the  

rattlesnake and the curved tongue. 

Western Diamondback Rattlesnake @ Santa Clara Ranch 

©  Hector Astorga 

Where are the leading lines here?  The tail and the back 

stretched-out leg. Those lines take us to the main subject 

matter in this image which is the cheetah’s yawn. 

Cheetah at Maasai Mara, Kenya. 

©  Hector Astorga 
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this and mentally separates them to create depth 
in an image.  The better we can recreate what our 
eye sees, the better the image. 

Point of View 

Viewpoint has massive impact on the compo-
sition of the image.  Shoot from different angles, 
from below, from above, from behind, etc.  This 
greatly affects the message that the photograph 
conveys. 

Illustrative Examples 

See the following pages for more examples of 
these guidelines.  Your images will have more 
impact as you employ them. 

Hector Astorga 

Text and images © Hector Astorga 

www.hectorastorga.com 

www.santaclararanch.com 

Sponsored by Santa Clara Ranch 

  

Hector D. Astorga (TX) is 

a professional nature  

photographer based in 

South Texas where he is 

serves as ranch manager 

and guide for visiting 

photographers at the 

Santa Clara Ranch.  For 

his photographic ability, he has been awarded  

multiple Grand Prizes in nature photography 

competitions including  the National Wildlife 

Federation and his work has been featured in many 

national publications. In 2016, one of his images was 

selected as a “Best of Show” by the North American 

Nature Photography Association (NANPA) where he is 

also a member. Hector’s preconference workshop and 

his teaching presentations are sponsored by the Santa 

Clara Ranch.  In addition to his presentations, he is 

also  a member of the Digital Image judging panel and 

is a Conference Speaker Image Reviewer.    

Leading lines from top right corner and also from the 

bottom left. 

Pyrrhuloxia on Huisache perch @ Santa Clara Ranch 

©  Hector Astorga 

This is an example where the leading line is obvious and it 

leads the viewer straight into the main subject matter of the 

photograph. 

Sandstone formation outside of Page, Arizona 

©  Hector Astorga 

Again here is an 

example of the 

“Question Mark 

Line.” 

Start from the 

bottom left and 

follow the birds 

back to its colorful 

beak.  

Key Billed Toucan 

in Costa Rica 
©  Hector Astorga 

http://www.hectorastorga.com
http://www.santaclararanch.com
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Here is an example where the leading line is not as obvious.  

The line is the Armadillo’s back leading you to the long 

tongue as he drinks.  

Nine Band Armadillo at Santa Clara Ranch. 

©  Hector Astorga 

Another example of the leading line not  

being as obvious.  The creek starting from 

the bottom right takes you towards the  

waterfall.  

Glacier National Park, Montana. 

©  Hector Astorga 

Obvious leading lines,  

but very attractive  

due to the curvyness. 

Highway traffic coming from Downtown Dallas 

©  Hector Astorga 

http://santaclararanch.com/
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Here we see several of the guidelines that  we have talked 

about:  leading lines, rule of thirds and background. 

Audubon Oriole at Santa Clara Ranch 

Here is an interesting application of the rule of thirds:  The 

bee is bulls-eyed in the image.  Rule of thirds is applied to 

the snake’s eyes and not the bee. The bee complements the 

image but the main subject is still the snake. 

Coachwhip Snake at Santa Clara Ranch. 

©  Hector Astorga 

©  Hector Astorga 

Rule of thirds here  

is the eyes  

of the bobcat. 

Bobcat at Santa 

Clara Ranch 

©  Hector Astorga 

Obvious rule of thirds since the small glass frog  

is the main subject and not the flower.  

Glass Frog in Costa Rica 

©  Hector Astorga Rule of thirds is applied here on two spots:  Where the 

waterfall begins and where the fall meets the water on the 

bottom.  

Brasstown Falls at Sumnter National Forest, SC  

©  Hector Astorga 

Where is the rule of thirds applied here? The gorilla’s eyes 

and hands.   And here is one that is not so obvious. The  

leading line is the difference in light on the ape’s shoulder. 

Mountain Gorilla at Bwindi National Park, Uganda. 

©  Hector Astorga 



Authors retain the rights to their articles which are published here with permission. 8 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

 

 

 

By blurring the 

background the 

subject really 

stands out. 

Squirrel Cuckoo at 

Pico Bonito Natl. 

Park, Honduras. 

The Milky Way is 

the anchor for 

the rule of thirds 

here.  

Arches National 

Park, Utah 
©  Hector Astorga 

Example of when we don’t want the same light on the 

background as our subject. Use fill flash to create a black 

background to give the illusion of night photography. 

Eyelash Viper – Pico Bonito Natl. Park, Honduras 

©  Hector Astorga 

©  Hector Astorga 

The blurred background really makes 

this hummer stand out and look 3-D.  

Juvenile Ruby throat Hummingbird South Texas. 

©  Hector Astorga 

The difference of 6-12 inches. By lowering yourself to be at 

the level of the animal will give you a better background. 

Point of View is also displayed here. 

Cheetah at Serengeti National Park, Tanzania. 

©  Hector Astorga 

Sometimes we can blur our background using post  

processing. The key is to make it look like it was done in 

the field.  This background was enhanced using Adobe 

Photoshop. 

Great Kiskadee at Santa Clara Ranch. 

©  Hector Astorga 



Authors retain the rights to their articles which are published here with permission. 9 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

 

  

Foreground – Poppies  

Middle Ground – Brush line  

Background – Sky 

Fenessy Ranch, Refugio TX 

Foreground – Rocks  

Middle Ground – Pool  

Background – Waterfall 

Would this image be as effective  

if the rocks where not there?  

Sacate Waterfalls – Pico Bonito Natl Park, Honduras 

©  Hector Astorga ©  Hector Astorga 

Foreground – Fall color trees  

Middle Ground – Treeline  

Background – Mountain Range 

Rocky Mountain Natl. Park, Colorado 

©  Hector Astorga 

Left image:   Here is an example of a landscape that 

was not shot at f/18 or above.   By shooting this wide 

open, I was able to create depth.  

The yucca stands out more since the  

background is slightly out of focus. 

Foreground – Lines on sand 

Middle Ground – Yucca  

Background – Sand dunes and Mountain Range  

White Sands National Monument, New Mexico 

©  Hector Astorga 

Right image:  Depth also works when shooting wildlife.   

Foreground – Snake’s head  

Middle Ground – Snakes body  

Background – Blurred out ground behind subject.  

Coachwhip Snake at Santa Clara Ranch. 
©  Hector Astorga 
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The use of ground blinds can be 

very helpful in keeping yourself 

lower than your subject. 

Greater Roadrunner at Santa 

Clara Ranch ©  Hector Astorga 

Ground blind use. 

King Vulture, Costa Rica 

©  Hector Astorga 

Here is an example of where going higher made a better 

composition than going lower. 

Zion National Park, Utah 

©  Hector Astorga 

By shooting lower than our subject, we make them look 

bigger than what they are.  

Javalinas, South Texas 

©  Hector Astorga 
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Recipe for Success 

There are a number of ingredients in the reci-
pe for successful images in nature photography 
contests. 

 Three Basic MUST HAVE elements 

 Creating the “Wow” factor 

 Know your subjects 

 Don’t take photographs, create them! 

 Leave your emotions out of the equation 

 

Three Basic MUST HAVE Elements 

There are three BASIC MUST HAVE elements that we need for a photograph to be successful.  If 
these three elements are present, we can start to consider entering the image in a photo competition. 
Without them, it doesn’t matter how unique or rare the image is, we do not enter them. 

 Sharp Focus 

 Great Exposure 

 Good Composition 

What Makes An Award Winning Image?   
By Hector Astorga (TX) Sponsored by Santa Clara Ranch 

©  Hector Astorga 

This image has the basic elements covered. 

Focus – YES 

Good Composition – YES  

Correct Exposure – YES 

©  Hector Astorga 

What about this one?   

This image does NOT have the basic elements covered. 
Focus – YES 

Good Composition – NO 
Correct Exposure – NO 

©  Hector Astorga 

http://santaclararanch.com/
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Creating the “Wow” Factor 

The Wow Factor is what makes us go WOW 
when we see an image for the first time.  There 
are several ways to approach this. 

 Think outside the box 

 Show the judges something they have 
never seen 

 Put yourself in the judge’s shoes 

 Use unique and unusual angles 

 Break the well-known photography rules 

It is seeing something so unusual and visually 
pleasing that creates an emotional response from 
us.  If you can get an emotional response from 
your viewers you are doing something right. 

Know Your Subjects 

 Learn and understand animal behavior 

 Study seasonal and weather influences 
on wildlife 

 Use common sense … what would you 
do?? 

 Be patient 

A must when photographing wildlife. Un-
derstanding animal behavior will make us a 
much better wildlife photographer and will take 
our images to the next level. 

 

The “Wow”Factor 

©  Hector Astorga 

Sometimes you have to get down and dirty and real 

close. Now I am not afraid of venomous snakes but I 

do highly respect them. 

I’ve handled hundreds of snakes and I know how to 

approach, when to approach and when not to  

approach, and how a snake is going to react from me 

being so close.  Look at the snakes behavior to see if it 

is safe to approach. 

©  Hector Astorga 

©  Hector Astorga 

The “Wow”Factor 

©  Hector Astorga 
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Right:  Yaaaaaaawnnnn! 

Above:  How was this image created?  By going at the correct time of year 

(spring) when male bobwhites fight as they compete for mates. Going in the 

fall to photograph quail will never get you an image like this. 

©  Hector Astorga 

Above:  Patience. Understanding the leopard’s behavior,  

I was able to capture this image.  

©  Hector Astorga 

©  Hector Astorga 

Right:  Yaaaaaaawnnnn! 

©  Hector Astorga 

Left:  Knowing that this lion 

was going to take away the kill 

from the females lions was es-

sential in us waiting for the 

right moment for this to hap-

pen. 

©  Hector Astorga 
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Don’t Take Photographs, Create Them 

How do we create photographs. 

Think of what you want to capture. Come up with a plan on how to do it. 

 

Yes you need to get close! 

©  Hector Astorga 

After carefully planning this shot,  

I was able to capture the intended behavior. 

©  Hector Astorga 

My notepad ideas for a  phototrap work (above) and 

the final result (below). 

©  Hector Astorga 

©  Hector Astorga 
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Leave Your Emotions Out Of The 

Equation 

Don’t become emotionally attached to your 
own images. 

Enter a contest with the expectation that you 
will be inspired and visually stimulated, that see-
ing the wonderful winning pictures will make you 
go out and take more photographs yourself. 

That’s the real benefit of participating in a 
contest:  sharing, inspiration, and a celebration 
of the love of photography. 

Hector Astorga 

Text and images © Hector Astorga 

(see Hector’s bio  
in the immediately preceding article) 

www.hectorastorga.com 

www.santaclararanch.com 

Sponsored by Santa Clara Ranch 

  

 

 

Above:  Why is this a bad image to enter?  

Where did I go wrong? 

Below:  Much better. 

©  Hector Astorga 

©  Hector Astorga 

http://www.hectorastorga.com
http://www.santaclararanch.com
http://santaclararanch.com/
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Expanding the Possibilities 

In the last few years, technological advance-
ments in shooting and blending multiple expo-
sures have allowed us to push the bounds of 
what’s possible to capture with a camera, giving 
us the opportunity to achieve results closer to 
how we envision them than a single exposure 
could.  We can expand exposure latitude with lay-
er and luminosity masking and by making high 
dynamic range images (HDRs).  We can expand 
coverage area and image resolution with panora-
mas, and increase depth of field through focus 
stacking.  We can even combine multiple expo-

Multiple Exposures for Exposure  

Latitude 

How do you know when to shoot multiple ex-
posures to control the contrast range in a scene?  
Answer:  When you can’t capture all the tones 
with a single exposure, as confirmed by the histo-
gram.  The histogram will show if either highlight 
or shadow pixels are pushed up against the edges, 
indicating they hold little to no detail. 

For landscapes, I typically shoot in manual 
exposure mode so I can readily see the results  of 
my input of shutter speed, aperture, and ISO.  I 

sure techniques to, for instance, create an HDR 
panorama that’s focus stacked, so that we cap-
ture a wide range of light, in a wide view, with 
everything sharp front to back! 

Multiple Exposures For Maximum Landscapes 
By Mark Bowie (MA) Sponsored by ADKPI 

HDR panorama taken at sunrise from Mt Greylock, MA. 

©  Mark Bowie 

http://www.adkpi.org/
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meter the entire scene, shoot a medium-toned 
exposure first, and check the histogram.  If pixels 
are piled up against either side I shoot a series of 
exposures in one- or two-stop increments, typi-
cally changing shutter speed or ISO, not aperture 
as it could put the images out of register.  I shoot 
enough exposures to capture detail in both high-
lights and shadows, per the histogram, to later 
blend in processing. 

Layer Masking 

I mainly use Lightroom and Photoshop CC for 
blending multiple exposures, including layer 
masks and HDRs.  Lightroom (LR) doesn’t work 
with layers; I use 
it to catalog im-
ages and send 
them to Pho-
toshop (PS) for 
layers work.  
When blending 
two or three ex-
posures to con-
trol the range of 
light, I typically 
use layer masks; 
with more, HDR 
imaging. 

the paint is black, then paint over the area of the 
top image you want to hide, thereby revealing the 
properly exposed part of the underlying layer.  
You may want to adjust the opacity of the brush 
to help blend the images seamlessly. 

HDR Imaging Field Technique 

Use a tripod when possible, but you can some-
times successfully shoot HDRs handheld. 

Set a white balance manually so it doesn’t 
change between shots. 

Turn autofocus off so it doesn’t re-engage on a 
different focus point between shots.  I use back 

button focus; the 
focus point won’t 
change until I hit 
the button again. 

Shoot in manual 
exposure or aper-
ture priority 
mode.  Changing 
the aperture be-
tween shots 
could put them 
slightly out of 
register.   

You can change 
exposure manu-
ally between 
shots or, to avoid 
camera shake, set 
the camera for 
Auto Bracketing.  
Quickly shoot a 
series of images 
in one- or two- 

Caption: Layer Masking in  

Photoshop 

The goal is to blend multiple exposures into 
a single image with appropriate exposure 
throughout.  In LR, select the images you want 
to layer mask, then go to Photo > Edit In > 
Open as Layers in PS.  It imports the images as 
separate layers.  Highlight the top layer and 
click the Layer Mask icon to add a white 
mask.  A white mask indicates the layer it’s on 
is visible.  Select the paintbrush tool, make sure 

The image at left and middle were layer masked for the final 

result at right.  Black River, Stephentown Center, NY. 

©  Mark Bowie ©  Mark Bowie ©  Mark Bowie 



Authors retain the rights to their articles which are published here with permission. 18 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

stop increments, to help the software blend mov-
ing subjects, like clouds and water, while mini-
mizing ghosting and artifacts. 

Blending HDRs in Lightroom 

To create HDRs, I predominantly use LR and 
PS’s 32-bit Merge to HDR, with realistic results. 

In LR, select the images you’d like to merge.  
Go to Photo > Photo Merge > HDR.  It opens a 
dialogue box.  Check the boxes to Auto Align and 
Auto Tone the images.  There are also choices for 
Deghosting the image; the software will try to 
eliminate ghosting and other artifacts from mov-

It opens a dialogue box.  Check the Remove 
Ghosts box to try to eliminate artifacts.  PS allows 
you to choose which of the images to use as the 
dominant one to help with that.  For instance, if 
trees were swaying in the wind, you may want to 
select the darkest exposure — the one shot at the 
fastest shutter speed — which hopefully froze the 
movement.  Click OK and save the file.  PS will 
send it to LR.  It may not look very good at that 
point, but PS has merged all that light infor-
mation into one file.  Finish processing in LR or 
PS to showcase the wide-ranging light. 

ing objects, like blowing leaves.  Try the various 
options for the best results.  Once done, click 
Merge.  It’ll send the HDR image to LR, where 
you can process it further for the final result. 

Blending HDRs with Photoshop’s 

Merge to HDR Pro 

In LR, select the images you’d like to merge.  
Go to Photo > Edit In > Merge to HDR Pro in 
PS. 

Three exposures, shot in one-stop increments and blended 

in LR, for HDR at right.  Silver Bay Association, Lake 

George, NY. 

©  Mark Bowie ©  Mark Bowie ©  Mark Bowie ©  Mark Bowie 



Authors retain the rights to their articles which are published here with permission. 19 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

Horizon Indicator.  Confirm level with the grid 
screen in LiveView or the viewfinder as you test 
pan across the scene.  I use the Virtual Horizon 
Indicator to level the camera for each segment of 
a panorama, to help the software stitch the imag-
es seamlessly. 

For interest, it’s good to have visual anchor 
points at both sides of the image.  

Expose for the most important areas of the im-
age (usually the highlights) or shoot multiple ex-
posures for each segment. 

Set white balance and exposure manually, so 
they don’t change across the panorama. 

Set a single focus point, or shoot a focus stack.  
Turn autofocus off so it doesn’t change the focus 
point between exposures.  For maximum depth of 
field, you may wish to re-focus each segment of 
the panorama, so that when the software stitches 
them, it essentially focus stacks them as well. 

Panoramas can also be shot vertically.  Water-
falls make ideal subjects. 

Shooting Panoramas 

By shooting overlapping images, either with 
the camera oriented horizontally or vertically, 
and later stitching them as panoramas, you can 
expand your field of view and expand the image 
resolution versus that of a single shot.  You can 
shoot panoramas with your full suite of lenses, 
from wide angle to telephoto and macro.  Also, 
you can crop panoramas for other nice compo-
sitions, maybe some you didn’t recognize on-
site. 

Panorama Field Technique 

Panoramas can be shot handheld, but it’s 
usually best to use a tripod. 

Level the tripod head, using the tripod’s 
built-in bubble levels, or by eyeing it as you ad-
just the legs.   

Level the camera using a specialized panora-
ma head, bubble level, or the camera’s Virtual 

 

©  Mark Bowie 

©  Mark Bowie 

©  Mark Bowie 

Handheld 3-

segment panorama 

shot from a canoe 

on South Pond, 

Adirondack Park, 

NY 
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Overlap a series of horizontal images by 1/4 to 
1/3, verticals by 1/3 to 1/2. 

Shoot quickly to minimize movement in the 
scene. 

Panoramas get wider and wider relative to 
their height with each successive shot.  You can 
help alleviate that by orienting the camera verti-
cally, or by taking fewer shots.  Two-, three-and 
four-shot panoramas can work well. 

Multi-Row Panoramas 

You can also shoot multi-row panoramas, a 
grid of overlapping images.  With these, subjects 
tend to retain a more majestic stature.  If you’ll be 
doing a lot of these, you may want to invest in a 
specialized panoramic head designed to rotate the 
lens around the nodal point to eliminate parallax 
distortion.  There are single row panorama slid-
ers, as well as multi-row “L”-shaped mounts, 
available through Really Right Stuff 
(www.reallyrightstuff.com), Sunway Foto 
(www.sunwayfoto.us), and others. 

Processing Panoramas in Lightroom 

I primarily use Lightroom and Photoshop CC 
to stitch panoramas.  I also use PT Gui 
(www.ptgui.com), which is particularly good at 
stitching HDR panoramas. 

In LR, select the images you’d like to stitch.  
Go to Photo > Photo Merge > Panorama.  It 
opens a dialogue box where you can choose the 
Projection you’d like LR to use.  Try each one to 
see what you like best.  The Boundary Warp slider 
is game changer.  Use it to magically warp pano-
ramas that were shot with the camera off-level, 

in a scene in sharp focus, from the nearest fore-
ground objects to the distant background.  To 
overcome the limitations of our optics, we can 
shoot exposures at different focus points and 
merge them in software to get everything we want 
in sharp focus. 

Focus Stacking Field Craft 

A tripod is nearly mandatory. 

You can focus manually or with autofocus, 
through the viewfinder, or in LiveView.  

Move the focus point between exposures.  The 
number of exposures needed depends on how 
much depth of field you’re getting with each, giv-
en the lens focal length, aperture and subject dis-
tance.  Grand and even intimate landscapes usu-
ally require only a few focus points — on the fore-
ground, middle ground, and background; macro 
work often requires many more.  You can choose 
any aperture you want.  You could shoot at a wide 
aperture, for instance, if you needed a fast shutter 
speed to freeze motion.  However, you’d need to 
shoot at more focus points to get the necessary 
depth of field. 

Processing Focus Stacks 

You can blend your series of images manually 
using layer masks in PS, or with automated soft-
ware such as the highly regarded Helicon Focus 
(www.heliconsoft.com) and Zerene Stacker 
(www.zerenesystems.com).  You can also do it in 
PS: 

In LR, select the images you’d like to focus 
stack.  Go to Photo > Edit In > Open as Layers in 
PS.  Select all the layers and go to Edit > Auto-

into shape, without having to crop them.  It’s 
amazingly effective; on only a few occasions 
have I noticed artifacts from the warping.  Hit 
Merge and process the image. 

Processing Panoramas in  

Photoshop 

In LR, select the images you’d like to stitch.  
Go to Photo > Edit In > Merge to Panorama in 
PS.  It opens a dialogue box with various Layout 
options.  Reposition usually does a good job; if 
it doesn’t try other options.  Check the Blend 
Images Together box. PS stitches the panora-
ma.  If the camera wasn’t perfectly level there 
may be misaligned edges.  You could crop them 
but lose some image.  Or you could use Content 
Aware Fill, but it doesn’t always work well.  You 
could also go to Edit > Warp and maneuver the 
image to eliminate the white areas.  But for 
these reasons I prefer merging panoramas in 
LR, with its magical Boundary Warp slider. 

HDR Panoramas 

When shooting panoramas, the contrast 
range across the scene can exceed the sensor’s 
capability to capture it all with one exposure 
setting.  However, you can shoot multiple expo-
sures for each segment of the panorama to cre-
ate an HDR panorama.  I usually blend the 
HDRs from each segment first, then stitch the 
resulting HDRs for the panorama. 

Focus Stacking 

Even using ultra-wide lenses and small aper-
tures, it may not be possible to get everything 

http://www.reallyrightstuff.com/
http://www.sunwayfoto.us/
http://www.ptgui.com
http://www.heliconsoft.com
http://www.zerenesystems.com
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Align Layers.  It gives you several Projection 
choices.  I usually choose Auto.  If it doesn’t work 
well, try others.  With the layers still selected, go 
to Edit > Auto Blend Layers.  Choose Stack Imag-
es and check the Seamless Tones and Colors box.  
PS attempts to seamlessly blend the images via 
layer masking so the final result is in focus 
throughout. 

Mark Bowie 

Text and images © Mark Bowie 

www.markbowie.com 

mrbowie@earthlink.net 
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Mark Bowie (MA) is a 

professional nature 

photographer, writer, teacher, 

and sought-after speaker who 

has presented programs at 

camera clubs, councils and 

conferences. He has produced 

three books on his native 

Adirondacks, two e-books on 

night photography and his work 

has been published in books and 

magazines, on calendars, posters, and in advertising 

media.  He also leads landscape photography 

workshops, including night shooting workshops.  

Sponsored by ADKPI  In addition to his camera 

college presentations, Mark is a pre-conference 

workshop presenter and is a Conference Speaker 

Image Reviewer.   

The left and middle 

images were focus 

stacked to create the 

image at right, which 

is sharp front to back.  

Windsor Brook, Berk-

shire County, MA. 
©  Mark Bowie ©  Mark Bowie ©  Mark Bowie 
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How Do Photographs Work? 

Communication Model:  P → V 

Photographer (P), sometimes called the 
Sender 

Viewer (V), sometimes called the Receiver or 
Audience 

Photograph (→) 

Use the terms in talking about your 
photographs. 

 “As the photographer, I am trying to show 
my viewers....”  

 “I want my viewers to see....” 

 “I designed this photograph so that the 
viewers’ eyes move...” 

This basic communication model can be 
adapted for many situations, such as writing:  
W → R (i.e., Writer, Text, Reader) 

What Does It Tell You?  

Your photograph has encoded in it a message. 
That is, you, the photographer (P) are sending a 
message (→) to your viewers (V). Is your image 
explaining the natural history of the subject? Is it 
documenting a conservation issue? Is it saying, 
“This subject is beautiful.” Is it doing all three? 

sensor is smaller than in actual life (as opposed to 
micro photography, where the image produced is 
larger than life). Macro is often defined in terms 
of the ratio between the image produced and the 
subject, e.g. 1:4 (a subject 4mm long appears 
1mm long on film) or 1:1 (a 4mm subject appears 
4mm long on film). Also called 
photomacrography. 

Basic Equipment 

Tripod 

I prefer the Gitzo GT2541EX, discontinued but 
still available. These tripods allow the legs to be 
positioned at any angle, from vertical to 
horizontal (i.e., full 90 degrees of positions). The 
center column extends, rotates, and articulates 
180 degrees from up to down. The carbon fiber 
reduces vibration and weighs less than aluminum 
legs. I also recommend a ball head. I use the 
Bogen/Manfrotto 468RC ProBall head with a 
quick release. Quick release plates allow for easy 
on/off, making using a tripod less difficult. 
Purchase whatever it takes so that you are not 
discouraged from using your tripod. In fact, 
spend less on lenses and more on the tripod legs/
head combination. The world’s most expensive 
glass will be wasted when shooting with no tripod 
at all. 

How Does It Tell You?  

Study the compositional elements of your 
photograph, how they convey your What. That 
is, examine the components of your photograph 
(→) that allow the message to travel from you 
(P) to your viewers (V). 

Why Does It Tell You? 

Decide the purpose for sharing your 
photograph with others, i.e., why create your 
picture and why share it. Does it make people 
happy? Does it teach them about nature? Does 
it promote recreational activities in a healthy, 
enjoyable location? Does it encourage recycling, 
preservation, or other green practices? 

Definition of Macro Photography 

Generally, close-up photography. More 
technically, the image produced on film or the 

Macro Photography FUN-damentals 
By David FitzSimmons (OH) sponsored by Sigma 

Plains Clubtail Dragonfly  

©  David FitzSimmons 

https://www.sigmaphoto.com/lenses
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 Tripod Heads with QR Plates: Wimberley, 
Really Right Stuff, Kirk, Arca-Swiss 

 Tripods: Gitzo, Bogen, Velbon, Benbo, 
Giottos 

Camera 

Use whatever you have. If you are shopping for 
one, then check out the camera’s close-focusing 
ability. Many point-and-shoot cameras have 
incredibly close-up capabilities, but sometimes 
these are only at the wide-angle end of the zoom. 

Basics of Taking Macro Photographs 

Perspective or Lens Selection 

Determine how much you want to frame in 
and how much you want to frame out. The 
latter—framing out—is crucial to the success of 
macro shots. In most cases, keep it simple: one 
subject, blurred background, and no other 
distractions. A narrower field-of-view will help 
you in eliminating distractions, but don’t forget to 
use wider views if you want to 1) include 
environment or 2) emphasize the front of the 
subject, making it pop off the page, i.e., appear 
much closer-at-hand when compared to the 
background. 

Depth of Field 

In order to see the detail on subjects, great 
depth-of-field is necessary. With macro work, the 
in-focus areas, even at f/16 or f/22 will only be a 
fraction of an inch. So focus precisely on the most 

Generally, you are better off with close-focusing 
at the telephoto end of the zoom. If you are 
getting an SLR, check out what macro lenses 
are available. I use Sigma and Nikon cameras. I 
shoot with a Sigma SD 14 (incredible color from 
the Foveon sensor and resolution comparable 
to a 10mp CMOS sensor), a Sigma DP1 (uses 
the same 14mp Foveon sensor) and a Nikon 
D2x. 

Macro Lenses 

Many lenses, both fixed-focal length and 
zoom, will focus reasonably close. To be truly 
macro, a lens should focus at least to 1:4. A 
good test is to see how well you can photograph 
a postage stamp. If a lens allows you to come 
close to filling the full frame for these subjects, 
then it will work quite well for a wide variety of 
subjects up-close. Regular zoom lenses, such as 
a  70 – 200 mm, often provide some macro 
capabilities, but a dedicated macro lens will be 
the best. Macro lenses are optimized for close 
focusing (i.e., will probably be sharper), and 
they excel at minimizing distortion. I use 
Sigma’s 70mm, 105mm, 150mm, and 180mm 
macro lenses. 

Cable Release or Remote Control 

Camera shake during close-focusing is 
accentuated. If you have an SLR, try to lock up 
the mirror first; then trigger the camera with a 
cable release or remote trigger. 

Grasshopper  

©  David FitzSimmons 

Great Spangled Fritillary 
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important part of the subject. For animals, focus 
on the eyes. For flowers, focus either on the 
closest petal or the reproductive parts. Move the 
camera into a position that maximizes subject 
sharpness, e.g., parallel to a flower or damselfly. 
Some subjects, however, are better with a shallow 
depth-of-field, especially delicate or soft-looking 
flowers. Experiment with depth of field, shooting 
at several apertures for these subjects.  Note:  I 
often find after shooting at wider apertures that I 
wished that I had used a smaller aperture with 
greater depth-of-field. 

Exposure 

Try to be right on the money. Do not rely on 
RAW files, sloppy field technique, and 
Photoshop. Remember that white subjects often 
need to be underexposed by about one stop, and 
dark subject often need to be over-exposed by 
about one stop. This preserves details. Also 
experiment with exposure and how it can create 
mood. Try lightening a subject for an airy, soft 
feel or darkening exposure for brooding, 
threatening subjects. 

Color 

Study colors—color wheels, colors in nature. 
Use bold colors to attract your viewer’s attention. 
Blend subdued colors for a softer look. Colors 
that are opposite or adjacent on a color wheel will 
work well together in a photograph. 

Symmetry 

Look for symmetry—the human mind does. It 
provides order, which often satisfies us, helps us 
feel we can recognize and order our world. 
Consider types of symmetry, e.g., radial and 

Texture 

The texture of a subject can be an interesting 
component, making a subject attractive and 
having an effect on perceived color. Use textured 
and smooth areas in proper balance. Many 
different complex textures may compete for 
attention and the image and its message 
confusing. 

Pattern 

Patterns can provide order, which our minds 
seek. Patterns may be as simple as symmetry, or 
they may be repeated subjects, colors, lines, or 
textures. 

Space 

Photographs are primarily composed by filling 
a space with a subject, but don’t forget empty 
space. A flower needs space in front both to 
suggest the flower’s unfolding and to provide a 
space where a viewer may place an imagined 
insect about to pollinate the bloom. Leave space 
in front of animals for critters to gaze into, or at 
least for viewers to look where the animal is 
looking. Even if viewers don’t see anything other 
than empty space, they will imagine what the 
animal is observing. An active imagination is 
requisite for an engaged viewer. 

Photographer’s Block:  What To Do If 

It Just Isn’t Working 

Economy 

Is the subject photo-worthy? Let’s face it, some 
subjects are incredibly interesting, beautiful, 

bilateral. Symmetry often goes hand-in-hand 
with Balance. 

Balance 

Generally, do not place your subject in the 
center. Try the rule of thirds, or fifths, or some 
other odd-numbered divisions. That is, subjects 
placed at the intersection of lines dividing the 
photograph into three sections vertically and 
three sections horizontally (like a tic-tac-toe 
board) often work well. Then provide 
something on the opposite side/paired 
intersection to offset the subject, e.g., an out-of-
focus element, something of the opposite color, 
empty space, or a leading line. 

Line 

Use lines in images to lead viewers’ eyes to 
your main subject. Curving lines are pleasant 
and often lead a viewer through much of the 
photograph, much like walking down a path. 
Vertical lines convey power and action; 
horizontal lines convey peace and rest. 

Red-Backed Salamander  

©  David FitzSimmons 
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weird, etc., but they may not have the right 
components to make photographs that work. Too 
many distracting elements often cause the demise 
of an otherwise engaging subject. 

Analyze 

What makes the subject interesting or 
meaningful? Stop to analyze exactly what it is 
that catches your attention, what makes the 
subject meaningful to you, and what would have 
the same effect on viewers. 

Convey Meaning 

How does the subject convey interest or 
meaning? Look for elements of the subject that 
convey meaning. Take, say, a frog: are the eyes 
dark and staring right at you? With a flower, are 
the curved petals quite graceful? 

 Reason for Sharing 

Why do you want to share the subject with 
others? Think about why others might care 
about your message. Do not rely only on your 
own perspective. Talk with others. Find out 
what family, friends, co-workers see in 
photographs… and not just your own. Present a 
slide show at a local nature center, and pay 
attention to the reactions. 

2D in a 3D World 

How do you take the three-dimensional 
world that you are experiencing and convey it, 
through a two-dimensional image, to your 
audience? Here’s the real challenge. Can you 
capture the 3D world in front of you, compress 
it into a 2D image, and get your viewers to 
believe it is 3D again when they view it. If so, 
you have the best chance of getting your 
message across. 

David FitzSimmons 

Text and images © David FitzSimmons 
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David FitzSimmons  (OH) is an 

award-winning free-lance 

photographer and writer who 

photographs and writes for 

various magazines, including 

Outdoor Photographer, and 

Shutterbug. With over 100 

calendar credits, he is also the 

author of several publications 

which include many Curious 

Critters titles. His books have 

won 14 national book awards 

and sold close to quarter of a million copies. One of 

nine Sigma Pros in North America, David presents 

seminars and workshops to a wide variety of 

audiences.  Sponsored by Sigma.  Along with his 

presentation, David is also conducting a hands- on 

session on Curious Critters in Photo Ops Room CC 

170 Saturday – 1 pm – 4 pm .  

Green Frog  
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What’s In My Bag   

In an age where everyone one wants to carry 
lighter and lighter camera equipment and bags, it 
is still important to carry the correct gear to cap-
ture the images you want.  From tripods to fil-
ters, these pieces of equipment are still as im-
portant today as in years past.  

Camera Bodies  

1 Full Frame 
1 Crop Sensor Camera Body 

Lenses  

APS - C Format  

Tamron 10-24mm Di II VC 
SP17-50mm Di II VC  
18-400mm Di II VC PZD 

Full Frame Format 

Tamron SP15-30mm Di VC 
SP24-70mm Di VC 
SP70-200mm Di VC  
SP90mm Di VC 1:1 Macro 

Filters 

Circular Polarizer 
Assorted Neutral Density  
Graduated Neutral Density 

Accessories 

Speed light 
Mini Reflector/Diffuser 
Tripods and Flashlight 

Camera Settings and  

Understanding Exposure 

Having a full grasp of your cameras settings is 
the first step to capturing good exposures and is 

critical to landscape and nature pho-
tography. Learning how to use the 
exposure triangle of ISO, Shutter 
Speed and Aperture all together will 
not only help with your exposure but 
also helps create more interesting 
images. 

From Your Backyard To The Grand Canyon 
By Ken Hubbard (NY) Sponsored by Tamron 

©  Ken Hubbard 

©  Ken Hubbard 
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Exposure Compensation 

Exposure Compensation s the act of incre-
mentally adjusting the camera’s exposure from 
the default reading that the meter is giving.  This 
is usually done when using Aperture Priority, 
Shutter Priority and some program modes. 

Metering Modes 

Using the correct metering mode is also crit-
ical to capturing an image with proper expo-
sure. 

Composition 

How an image is composed will determine 
how a viewer responds to it; good composition 
will hold the viewer’s interest and guide them 
through the frame to the main subject. Remem-
ber the basics and use the rule of thirds to cre-
ate a more interesting image. 

Leading Lines 

Leading lines are actual lines within the frame 
of your image that also help guide the viewer 
through your frame.  Leading lines can be any-
thing from streets to the crests of sand dunes. 

©  Ken Hubbard 
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Search Out the Good Light 

Knowing your camera’s setting and understanding good composition is just the beginning to capturing visually stunning images.  Finding (or creating) 
good light is the true key to good images.  You can have a spectacular location, but if the light is dull and flat the image will be dull and flat. 

Understanding What Focal Length To Use 

Whether to use wide angle or a telephoto lens, that is the question? Actually both have their place and depends on the image you are trying to create.  
Wide angle stretches out the subjects making the foreground large and the background small.  Telephoto lenses create a compressed look wherein all 
subjects appear to be on the same plain. 

Flat Light  >>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>  Dynamic Light  

©  Ken Hubbard ©  Ken Hubbard ©  Ken Hubbard ©  Ken Hubbard 
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Get in Close 

Don’t only concentrate on the grand landscape, look at the small world that is around you.  They make for some of the most jaw dropping images. 

Change Your Perspective 

Move around your subjects, 360 degrees if you can. The shape, light and look of the subject will change with every angle. Don’t only move around it, but 
also try to shoot from above and below as well. 

©  Ken Hubbard ©  Ken Hubbard ©  Ken Hubbard 
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Ken Hubbard 

Text and images © Ken Hubbard 

www.kenhubbardphotography.com 

Facebook: Ken Hubbard Photography 

Instagram: Ken Hubbard Photography 

Email: hubbard@tamron.com 

Sponsored by Tamron 

Locations featured in this presentation: 

Lakota Wolf Preserve, Longwood Gardens, 
Grand Canyon National Park, Grand Teton Na-
tional Park, Bryce National Park, Death Valley 
National Park, Zion National Park, Arches Na-
tional Park, Monument Valley and Jekyll Island 
Georgia      

  

Ken Hubbard (NY) is the Field 

Services Manager for Tamron 

who is responsible for the 

company’s events, including 

Tamron’s popular consumer 

workshop series. Based in New 

York, he has had nationwide 

gallery showings of his portrait 

and landscape photography and 

teaches enthusiasts how to take 

better photos at numerous 

events. His extensive background 

in the field of photography is unique and diverse 

having traveled extensively throughout the United 

States, giving him a consistent output of 

breathtaking photographs. Presentation & Raptors 

Sponsored by Tamron.  In addition to his camera 

college presentation, Ken is a pre-conference 

workshop presenter with  “Photograph Birds & 

Raptors.”  Ken is also conducting  a hands-on session 

with the Raptors in room CC 175 (lower level) Friday 

– 1:30 pm – 3 pm with Tamron loaners.   

©  Ken Hubbard 
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What Makes A Photo Of Water A 

“Good” Photo? 

Although it seems basic, it is an important step 
to define the characteristics you are trying to 
capture in your water photo.  At its heart, art is 
subjective. You may like to freeze a sharp image 
of water moving, or you may want to capture the 
long, smooth flow of it. Whichever mood you 
prefer, know what you are after so you can shoot 
with intent. 

Characteristics Specific to 

Water 

While photographing water is similar 
to shooting a dry landscape, there are 
certain characteristics that set water 
apart. Think intently about these 
characteristics and how you can make 
them stand out in your photograph: 

 It moves.  

 It’s reflective.  

 It reacts.  

 It’s ever changing. 

Capturing Reflection 

Capturing a great reflection can be difficult 
because there are many aspects out of our 
control.  

Wind 

You need to have very still water – little to no 
wind. It can vary greatly from location to location, 
but I have found that I generally find the most 
still water in the earliest hours of the morning. 

Check your weather forecast and pay 
attention to the wind. If there is just a 
little wind, you can often overcome this 
by using a long exposure time to smooth 
out any choppiness on the surface. 

Composition 

I find I often break the “rule of thirds” 
when photographing a perfect reflection. 
It is pleasing to me to often cut the image 
exactly in half – and that’s allowed! 

Capturing Movement 

Once you have defined what you want to 
capture in your water, you need to understand 
how to achieve that.  The images in the 
corresponding diagram are from Spruce Flats 
Falls. They indicate dramatically different looks 
that can be achieved simply by modifying your 
settings. 

Waterscapes: Techniques for Photographing Water 
By Mandy Lea (Nomad) Sponsored by Nikon 

©  Mandy Lea 
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Color 

Even when you don’t have a perfectly sharp 
reflection, often just having the blur of bright 
colors reflected in water can be pleasing. For 
instance, the color of spring flowers or fall colors 
could be isolated in a reflection. 

Capturing Reaction 

One of the most unique things about water in 
landscapes is that it is ever changing! How can 
you best capture the mood of water in times of 
change? 

Freezing 

When water freezes focus on capturing details 
in ice, crystals, cracks, icicles and frozen 
waterfalls can have a lot of impact. Get low, 
isolate your subject. 

priority, you may end up with an out of focus 
foreground. But that’s okay! We can do this! 

Understand your exposure triangle (see 
diagram). You have Aperture, Shutter Speed, and 
ISO. Now prioritize them. You get to choose 2, 
and the 3rd is left up to nature! 

You will prioritize different settings in 
different situations, but for water, shutter speed 
is always first (get the water how you want it). 
Next choose the appropriate aperture for your 
setting. And finally, set the ISO where it needs to 
be to give you the proper exposure. 

Equipment 

Filters 

The use of filters is essential when 
photographing water. Always have a selection of 
circular polarizers (to control light and 
reflection), neutral density (to control shutter 

Ripples 

Movement in a still lake can be dramatic! 
Watch for birds, fish and other wildlife. And if 
you have to, toss in a pebble to create that 
drama! 

Waves 

There is nothing more powerful in water 
than waves! Experiment with both slow and 
fast shutter speeds as both have very different 
yet effective outcomes. 

General Settings 

Which mode should I use? 

The only way to have complete control over 
your water is to shoot in Manual. If you use 
aperture priority, you won’t be able to control 
the flow of your water. If you use shutter ©  Mandy Lea 

©  Mandy Lea 
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speed, 3-10 stops), and even graduated neutral 
density (to compensate for bright skies). 

Tripod 

Tripods are a necessity in every landscape 
photo, but even more so when photographing 
water. Unless you are shooting fast to freeze 
motion, you will need a tripod.  

Remote/Timer 

Believe it or not, even the press of a shutter 
button can create blur in a long exposure. Invest 
in a remote/intervalometer, or simply use your 
timer (set to shortest time). 

Finding Your Shot 

First and Foremost 

Be Present. This will allow you the 
perspective you need to create an impactful 
image. 

Define Your Subject 

Before you can even think about the best 
composition or exposure, you have to know 
what you are trying to show the viewer. 

Under what condition does that subject have 
the most impact? 

 Angle 

 Composition 

 Camera Settings 

 Time of Day 

10 Tricks to Finding Your Water 

Shot 

1. Start small, isolate your scene. 

2. Look for natural patterns. 

3. Accentuate contrasting textures. 

4. Clean the scene. 

5. Don’t be afraid of rocks. 

6. Rivers are natural leading lines. 

7. Experiment during different times of day. 

8. Use natural frames. 

9. Look beneath the surface. 

10. Look for invisible flows and patterns. 

Mandy Lea 

Text and images © Mandy Lea 

www.mandyleaphoto.com 

Sponsored by Nikon 

Mandy Lea leads a nomadic life 

and has been on the road for 

nearly two years.  After 

spending years at Precision 

Camera in Austin, her 

wanderlust became 

unavoidable and she left to 

pursue freelance landscape 

photography while living out of 

her teardrop trailer. Her 

photography has been featured 

in photo and outdoor themed 

magazines, corporate advertisements, podcasts and 

television. When not on assignment she teaches in-

the-field photography workshops and speaks at 

events relating to photography and tiny living. 

Sponsored by Nikon  In addition to her camera college 

presentations, Mandy will be one of your co-hosts at 

the Panel Discussion  Saturday in Thompson 102 at 2 

PM and is a Conference Speaker Image Reviewer.  in 

addition she will have her “Teardrop” trailer outside 

the Campus Center  for you to tour Saturday 8:30 to 

11am.    
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This program is a historic and photo-
graphic review of the past 100 years of 
the National Park Service, and the role 
that photography played in its develop-
ment and continued support. With over 
400 national parks and monuments pro-
tected by the Department of Interior, 
there are a multitude of locations that are 
perfect for learning and exploring.   

Take an inspirational walk through 
some of the most iconic and beautiful 
locations to photograph in our country. 

The National Park Service has over 
22,000 employees. 

Over 221,000 volunteers help to run the 
National Parks and Monuments 

In 2016, the NPS turned 100 years old. 

Promotes recreation, conservation and 
history. 

1903 President Theodore Roosevelt vis-
ited Yellowstone National Park, 

President Woodrow Wilson signed an 
act to create the Department of the Inte-
rior to protect National Parks 

The United States is the first country to 
have national parks. 

Nearly 3,000,000 people visit our parks 
each year. 

For the benefit and enjoyment of the 
people. 

Photographing America’s National Parks 
By Jennifer King (NC) 

Grand Tetons 

©  Jennifer King Yosemite 

©  Jennifer King 

Glacier 
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Bryce Canyon 

©  Jennifer King 

Grand Canyon 

©  Jennifer King 

Yellowstone 

©  Jennifer King 

Death Valley 

©  Jennifer King 

Great Smoky Mountains 

©  Jennifer King 



Authors retain the rights to their articles which are published here with permission. 36 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

 

Find Your Park! 

Jennifer King 

Text and images © Jennifer King 

www.jenniferkingphoto.com  

www.facebook.com/jenniferkingphoto  

Instagram:  jenniferking_photographer 

 

Jennifer King (NC) is a landscape 

and wildlife photographer based 

in North Carolina with over 20 

years in the photo industry as an 

instructor and “Wildlife 

Whisperer.” Her lifetime passion 

for teaching photography, 

exploring the world and 

discovering new locations to 

photograph has gained her 

photographic acclaim.  Her 

images and articles can be found in top resources 

such as Outdoor Photographer, and she has appeared 

as speaker at events such as NANPA’s 20th 

Anniversary Summit.  Jennifer founded Photography 

for the Fight Against Breast Cancer and brings 

together photographers, sponsors, individuals and 

the industry to raise money and awareness for breast 

cancer patients and research. Jennifer will also be 

one of your co-hosts at the Panel Discussion Saturday 

in Thompson 102 at 2 PM and is a Conference 

Speaker Image Reviewer. 

Mount Rainier 

©  Jennifer King 

Canyonlands 

©  Jennifer King 
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Experts dispute the origin of the park’s name, 
“Acadia.” Some believe the word derives from the 
Arcadia region in Greece, prized for its unspoiled 
wilderness. Over time, perhaps the “r” in the ref-
erence dropped? Acadia was a colony of New 
France in northeastern North America that in-
cluded parts of eastern Quebec, the Maritime 
provinces, and modern-day Maine. 

Others attribute the label to the word 
“L’Acadie,” which potentially stems from the 
French version of a Wabanaki Indian word mean-
ing “the place.” Rumors suggest that the first Eu-
ropean settlers to Mount Desert Island may have 
also translated this term into “heaven on Earth.” 

Although I live in Arizona, through artist-in-
residencies, workshops, and personal visits, I 
have found my place in “the place” for over 400 
days since 2009. Today, I hope to share some of 
what I’ve learned in that time, to offer when, 
where, and how in hopes it inspires you to visit 
Acadia and find beauty through your own lens in 
heaven on Earth. 

Introduction 

Maine is located in the far northeastern corner 
of the United States along the Atlantic Ocean. 
Acadia National Park resides in “Downeast 
Maine,” or about mid-coast. Many from the 
northeast drive, but those coming from out of 
state typically fly into either Portland (about 3.5-

hour drive) or Ban-
gor (about 1.5-hour 
drive) 

The approximate-
ly 49,000-acre park 
spans three main 
locations (Mount 
Desert Island, 
Schoodic Peninsula, 
and Isle au Haut) 
plus properties on a 
number of outlying 
islands. Most visi-
tors base themselves 
in Bar Harbor, but 
surrounding towns 
like Northeast Har-
bor, Southwest Har-
bor, and Trenton 
offer fine lodging 
and dining options. 
The park offers four 
campgrounds, and 
many private 
campgrounds exist 
in the community. 

Because Acadia 
was created almost 
entirely from donat-
ed lands, the park 
map looks like a 

Photographing Acadia National Park 
By Colleen Miniuk-Sperry (AZ) 

http://www.cms-photo.com/
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patchwork quilt. It’s unlike most other national 
parks in that there is no single point of entry (like 
an entrance gate) that designates park land vs. 
not park land. The community and park are inter-
twined. 

People have inhabited or visited this beautiful 
place for many years. Before the arrival of French 
explorers like Samuel Champlain and Antoine de 
la Mothe Cadillac, the Wabanaki Indians made 
this area their home. In the mid-1800s, Hudson 
River School painters like Thomas Cole and Fred-
erick Church started visiting and creating artwork 
from Mount Desert Island that piqued the inter-
est of wealthy East Coast families. By the late 
1800s, the Rockefellers, Fords, Vanderbilts, As-
ters, and Carnegies began “summering” in their 

Suggested Photography Locations Include: 

 Wild Gardens of Acadia 

 The Tarn 

 Jesup Trail 

Macro opportunities are especially abundant.  

As You Find Joy in the Little Things Here, 
Remember To: 

 Define you visual message before you 
photograph 

 Go beyond the literal and use metaphors: 
“What else is it?” 

 K.I.S.S.—fill your frame with just your vis-
ual message; eliminate distractions 

“cottages” (mansions). They 
were called “rusticators.” 

Then-Harvard president 
Charles Eliot and heir to a 
textile fortune George B. 
Dorr began accepting do-
nated land from the locals 
and wealthy visitor alike for 
the newly formed Mount 
Desert Island for the Han-
cock County Trustees of 
Public Reservations to pro-
tect it. By 1916, Eliot and 
Dorr had collected almost 
6,000 acres. In 1916, Presi-
dent Woodrow Wilson ac-
cepted the land package 
and declared it the Sieur de 
Monts National Monument. 
Three years later, in 1919, 
Congress upgraded the 
monument to a national 
park and renamed it Lafa-

yette National Park. 

Sieur de Monts Area 

The Sieur de Monts area, the birthplace of 
the park, is a fitting location to start your pho-
tographic explorations of Acadia National Park. 
It offers a variety of opportunities in any light, 
especially mid-day, no matter the weather. Stop 
by the Sieur de Monts Spring, the George B. 
Dorr monument, the Nature Center, and the 
Abbe Museum to learn more about the history. 

©  Colleen Miniuk-Sperry 

©  Colleen Miniuk-Sperry 
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 Keep your lens parallel with the primary 
subject 

 Use a reflector/diffuser for managing 
harsh mid-day light 

Park Loop Road 

In 1922, construction started on the “Jordan 
Pond Road.” By 1927 the base of the Park Loop 
Road we know today was completed. The spur 
road to the top of Cadillac Mountain’s summit 
was completed in 1931.  

The entire loop is open typically from mid-
April to December. During winter, the Ocean 
Drive section and side road to Jordan Pond re-
main open; however, much of the road closes to 
motorized vehicles. 

As You Travel Inland Along the Park Loop 
Road, Additional “Must-See” Photographic 
Stops Include: 

 Jordan Pond 

 Jordan Stream 

 Bubble Rock 

 Bubble Pond 

 Cadillac Mountain 

Although the mountains here might not be as 
tall as the ones in Appalachia or the western Unit-
ed States, Acadia offers some of the most easily-
accessible breathtaking views in all the national 
parks.  

Visitors can find many of the park’s most 
iconic scenes along Park Loop Road, but plenty 
of not-yet-discovered expressive compositions 
exist as well.  

Suggested Photography Locations Along 
Ocean Drive Include: 

 Sand Beach 

 Newport Cove Overlook 

 Thunder Hole 

 Monument Cove 

 Boulder Beach 

 Otter Cliff 

 Otter Point 

 Little Hunters Beach 

When Photographing the Coast, Keep the 
Following Tips in Mind: 

 Study the scene closely—How does the 
water move? How do you wish to depict 
it? (e.g.:  incoming vs. receding? Frozen 
spray? Blurred into an ethereal fog?) 

 Use continuous drive mode to shoot 
through wave sequences 

 Leverage the granite joints to lead you 
into, not out of, the your frame 

 Use graduated neutral density filters or 
HDR to balance overly bright skies 

 Never turn your back on the ocean. 
Watch for rogue waves at ALL times 

©  Colleen Miniuk-Sperry ©  Colleen Miniuk-Sperry 
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When Creating Images From a More Aerial 
Perspective, Consider: 

 Conveying depth via lines, layers, and 
light 

 Including a sense of scale 

 Considering panoramic frames to show 
expanse 

 Watching out for distracting negative 
space and mergers 

 Using graduated neutral density filters or 
HDR to balance overly bright skies 

Carriage Roads 

One of the unique features of Acadia National 
Park is the network of carriage roads John D. 
Rockefeller Jr. constructed beginning in the 
1920s. 

A day hiking, biking, riding, snowshoeing, or 
skiing anywhere along the 50+ miles of carriage 

sert Island (all three are a part of the Mount De-
sert Land and Garden Preserve): 

 Little Long Pond 

 Asticou Azalea Garden 

 Thuya Garden 

Schoodic Peninsula 

In 1929, Dorr acquired Moore property on the 
Schoodic Peninsula (the only part of the park on 
the mainland). During negotiations, the property 
heirs requested the name of the park to be 
changed. Hence, the park came to be known after 
that timeframe as “Acadia National Park.” 

Only about 10% of the three million-plus visi-
tors ever see the park on the Schoodic Peninsula. 

roads will not disappoint. Besides the carefully-
designed scenic views intermixed with quiet 
stretches of forest, there are two majestic gate-
houses and 17 bridges to photograph, including 

 Cobblestone Bridge 

 Stanley Brook Bridge 

 Deer Brook Bridge 

 Eagle Lake Bridge 

 Duck Brook Bridge 

As You Explore the History of This Coastal 
Park: 

Learn about your subject (history) before 
you photograph it to tell a story from a variety 
of perspectives: broad, vignette, and detail. 

Respect regulations and private property. 

Southern Tip of MDI 

One of the park’s most iconic scenes resided 
about a 45-minute drive from Bar Harbor, but 
additional locations worthy of investigating, 
especially at minus-low tides for tidepooling, 
are close-by: 

 Bass Harbor Head Lighthouse 

 Ship Harbor Trail 

 Wonderland Trail 

Outside of the Park 

While not in the park, there are three loca-
tions worth visiting while staying on Mount De-

©  Colleen Miniuk-Sperry 
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Thus, it’s often referred to as “The Quiet Side of 
Acadia.” 

It’s located about an hour drive from Bar Har-
bor and services are limited to what you can find 
in Winter Harbor, Corea, and other small towns. 
Driving will provide you the most flexibility to 
chase light, but you can also take a ferry across 
Frenchman Bay and use the Island Explorer. 

Although the entire loop will provide endless 
photographic opportunities, be sure to add the 
following to your itinerary: 

 East Side of Schoodic 

 West Side of Schoodic 

 Ravens Nest 

 West Pond Cove 

perfect pre- or post-shoot snack right along the 
trail. For those into night photography, the Aca-
dia Night Sky Festival is held in September. 

The second busiest time of year for visitors is 
autumn (October and November). The  Kaleido-
scope of fall colors, which typically peaks ~mid-
October, attracts “leaf peepers” and photogra-
phers. As the season changes, the weather can’t 
often make up it’s mind so prepare for anything 
and dress in layers.  

If you wish to leave the crowds behind and see 
the park transform into a winter wonderland, vis-
it in winter (December to March) when snow, ice, 
and blizzards are possible. Not many services 
available, but adequate lodging and dining op-
tions are becoming more available with each 
passing year.  

Spring (April to June) also sees lower visita-
tion than summer or autumn. Melt-offs can make 
some locations muddy—and the perfect breeding 
grounds for biting bugs. Wildflowers often start 
to show during the long days of sun (14-17 hours). 
If you’re into bird photography, don’t miss the 
Acadia Birding Festival. 

Helpful Resources 

Photographing Acadia National Park: The 
Essential Guide to When, Where, and How by 
Colleen Miniuk-Sperry (www.photoacadia.com)  

Acadia NPS website: www.nps.gov/acad 

Acadia maps: www.npmaps.com/acadia 

Isle au Haut 

For those looking for a more backcountry 
experience in Acadia National Park, consider a 
multi-day trip to the park’s most remote prop-
erty (which was donated in 1943). 

Because of very limited lodging (Duck Har-
bor campground, Keeper’s House Inn, or vaca-
tion rentals in the community) and transporta-
tion options here (mailboat/ferry), advanced 
planning is required.  

Your reward for such effort, though, is miles 
of pristine coastline, panoramic vistas, and qui-
et forests. While there are a number of spots 
near the NPS campground, those willing to hike 
will enjoy the photographic opportunities on 
the: 

 Cliff Trail 

 Western Head Trail 

Timing Your Trip 

I’m often asked, “How long should I visit 
Acadia?” My response always is, “As long as 
you possibly can!” I visit two to three months a 
year cumulatively for the past eight years, and I 
have yet to run out of photographic ideas. 

I’m also frequently asked is “When should I 
visit?” Anytime! There’s no bad time to be in 
Acadia! Summer (July to September) sees peak 
visitation, so visit popular locations well before 
dawn. Weather can be beautiful, rainy, or foggy 
in the span of a few minutes. Wildflowers typi-
cally bloom and wild blueberries can be the 

http://www.photoacadia.com
http://www.nps.gov/acad
http://www.npmaps.com/acadia
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Acadia National Park map by National Geo-
graphic Trails Illustrated 

The Carriage Roads of Acadia National Park 
by Diana Abrell 

Mr. Rockefeller’s Roads by Ann Roberts 

Field Guide to Acadia National Park by Russell 
Butcher 

Acadia: The Complete Guide: Acadia National 
Park & Mount Desert Island by James Kaiser 

Colleen Miniuk-Sperry 

www.cms-photo.com 

Text and Images © Colleen Miniuk-Sperry/
CMS Photography 

Email:  cms@cms-photo.com 

Workshops:  
www.cms-photo.com/Workshops/

ws_schedule.html 

Sheography™ Workshops:  
www.sheography.com 

Blog:  
www.youcansleepwhenyouredead.com 

Books/eBooks:   
www.analemmapress.com 

Facebook:   
www.facebook.com/CMSPhoto 

Instagram:  
www.instagram.com/colleenminiuksperry 

 

Colleen Miniuk-Sperry (AZ) ) is 

an outdoor photographer, writ-

er, publisher, instructor and 

speaker.  Her credits include 

National Geographic calendars, 

Arizona Highways and a variety 

of other publications. She has 

served three times as an Artist-

in-Residence with Acadia Na-

tional Park and authored sever-

al award-winning books includ-

ing guidebooks. She offers workshops and Sheogra-

phy Women’s Photography Retreats through her own 

company, CMS Photography and with several other 

workshop companies. Along with her camera college 

presentations, Colleen will also be conducting an In-

teractive Session “Beyond the Snapshot” Saturday - 

Hasbrouck at 2 PM (Double Session). 
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Equip Yourself 

Macro photography is the recording of small 
subjects at close distances, typically with lenses 
with a 1:1 (life-size) or a 1:2 (half life-size) 
magnification ratio. Lenses with a magnification 
ratio of 1:4 can render "close-up's." Lenses with a 
5:1 magnification ratio allow for 
photomicroscopy. 

Additional Useful Equipment For Macro 
Photography Includes: 

 Extension tubes, bellows, or close-up 
diopters 

 Tripod, one with either no center column 
or with column that can be adjusted from 
vertical to horizontal orientation 

 Focusing rail 

 Cable release 

 Polarizer 

 Reflector/diffuser 

 Off-camera flash 

 Hoodman Hoodloupe 

 Wimberley Plamp 

 Artificial backgrounds (e.g. mat boards, 
scrap book paper) 

more deeply to identify exactly what grabbed your 
attention. Ask yourself things like "What am I 
responding to? Why? What do I wish to 
emphasize in communicating with my viewers?" 
Reframe your literal labels into metaphors for 
more expressive photographs. Use your words—
title your photograph before shooting. 

 Wind block box 

 Knee pads or gardening 
mat 

Approaching the Scene 

Stop thinking! Mindfulness 
is "a mental state achieved by 
focusing one's awareness on 
the present moment, while 
calmly acknowledging and 
accepting one's feelings, 
thoughts, and bodily 
sensations" (dictionary.com). 
Release all expectations for 
making an image. Embrace all 
light, weather, experiences 
equally. Release judgements.  

Experience   

Experience your surroundings with all of 
your senses. Follow your curiosities. Ask 
questions like "what if" about what you see as 
you wander.   

Connect With Your Perceptions 

Whenever you hear yourself say something 
like, "Look at that" or "Isn't that pretty," don't 
shoot right away. Instead, observe the scene 

Wild About Wildflower Photography 
By Colleen Miniuk-Sperry (AZ) 

©  Colleen Miniuk-Sperry 
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Visualize Your Composition 

Keep it simple silly (K.I.S.S.)! Fill your frame 
with your primary subject and surround it with 
elements that can help provide context to that 
subject. Complete a "border patrol" to identify 
(and then, remove) distracting elements like odd 
shapes, bright tones, etc. that could divert a 
viewer's eye away from the subject.   

Apply The Law Of Closure 

 Your brain perceives the whole despite the 
absence of certain parts. Deciding where to crop 
the image is subjective, but you may not need to 
show the whole object in order to convey its 
context.  

Arrange Elements Based On Desired Visual 
Force And Movement 

  Viewers will perceive your primary subject to 
be at rest and static if placed in the center of the 
frame. If positioned at the intersection of the Rule 
of Thirds tic-tac-toe grid, viewers will perceive 
visual tension and interest. If positioned near the 
edge of the frame, viewers will perceive the object 
to be traveling away from the scene and other 
visual elements within the frame. 

Consider Visual Weight And Balance 

Based on a viewer's expectation of how gravity 
works, darker and larger objects tend to feel 
heavier while lighter and smaller objects feel 
lighter. Place heavy elements at the bottom to 
create a foundation. Alternatively, create a visual 
anomaly by placing heavier objects at the top. 
Elements placed closed to each other will appear 

Layers 

To convey a sense of dimension, include a 
strong foreground, mid-ground, and background 
layer in your frame whether you are photo-
graphing broad landscape scenes or smaller 
macro set-ups. If you notice an odd two-
dimensional merger as you arrange the elements, 
reposition your camera to avoid.   

Light 

Top/front lighting render flat images. Side and 
backlight help the camera "see" shape and 
dimension. When backlighting, use a sunshade or  
"gobo" (e.g., a hat, book, clipboard) to block the 
sun from hitting the front of the lens and prevent 
lens flare. Use the Reverse Boston Salute in all 
weather conditions. Reduce contrast by using a 
reflector to add light back into the dark shadow 
areas. A diffuser held between the light source 
and your subject softens the light across a smaller 
scene. Controlling the quantity and quality of 
light originating from an off-camera flash can 
help create or fill shadows. 

as if they have an implied relationship (and vice 
versa). Vertical orientations tend to possess 
more visual tension than horizontal since the 
visual elements appear to have less space to 
work with each other in the frame. 

Create The Illusion Of Depth 

Through 

Lines 

Use lines that stay within the frame and lead 
to somewhere interesting. Turn horizontal lines 
into diagonals by using the Dutch tilt if no 
horizon is visible in your frame. 

©  Colleen Miniuk-Sperry 
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Technically Execute Your Vision 

"Set It And Forget It" 

Set your ISO to the lowest speed reasonable 
for the types of subjects you photograph (e.g., ISO 
100 for landscapes from a tripod, ISO 400 for 
moving subjects). Then, only adjust ISO if unable 
to achieve your goals through your shutter speed 
and aperture settings. 

Depict Motion By Controlling The Shutter 
Speed 

Faster shutter speeds can help freeze the 
motion of moving subjects, especially on windy 
days. Movement records with slower shutter 
speeds. If handholding, use shutter speed faster 
than "1/focal length of lens." 

Find Your Desired DOF By 
Controlling The Aperture 

To isolate and call attention to your 
subject, use a large aperture/short DOF 
where the subject is in focus and the 
background is blurred. For expansive 
views, use a small aperture/broad DOF 
to keep the entire image in focus from to 
back. Consult dofmaster.com for precise 
distances for your camera and lens. 

Understand Your Histogram 

A correctly exposed photo will have a 
balanced distribution of tones towards 
the center (JPG) or the right hand side 
of the histogram without blowing out 
the highlights (RAW). Watch out for the 

inherent to macro lenses. Keep the lens parallel to 
the subject's plane! If available, use 
LiveView with a Hoodman HoodloupeTM and 
focusing rails on tripod (turn OFF image 
stabilization/vibration reduction). Evaluate photo 
after shooting, make tiny adjustments, and 
reshoot – repeat. Use your depth of field preview 
button (if available).  

Extend The Apparent DOF With Focus 
Stacking 

By making multiple frames at differing focus 
points and blending the resulting images in 
processing, you can control and extend the 
apparent DOF for a given scene. Use a wide 
aperture (f/8 or wider) and compose wide to 
allow for cropping in processing. 

Bring Your Own Background 

Keep your background free of bright and 
distracting odd-shaped objects. Hold an 
artificial background like a black, brown, 
green, blue or other colored shirt, sheet, 
poster board, or old photograph about 8-
12 inches behind the subject with a wide 
aperture.   

Make Friends With The Wind 

Faster shutter speeds, faster ISOs, and 
rear curtain sync flash can help freeze the 
motion of moving wildflowers on windy 
days. Create a wind block with your 
backpack, jacket or even your body. 
Stabilize single blooms with devices such 
as the Wimberley "Plamp." If it's 
extremely windy, considering making 
impressionistic images by capturing the 

"blinkies" where no data has been recorded. 
Leverage the LCD to evaluate exposure and 
determine what exposure adjustments are 
needed.  

Use A Polarizer If Needed 

A polarizer can reduce the brightness of 
reflected light off of flowers, leaves, etc.  Rotate 
the polarizer on the lens to get the effect you 
wish, but don't over-polarize. If the sky looks 
too dark, rotate your polarizer to reduce the 
effect.  

Focus With Precision 

Ensure either the pistol/stamen or primary 
subject is in focus. Manual focus may be easier 
than Auto focus with small depth of fields 

©  Colleen Miniuk-Sperry 
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movement of the flowers by slowing down your 
shutter speed, moving your camera, and having 
the wind work in your favor. 

Critique Your Results 

"Did what I see come out of the camera?" 
Don't give up until you've captured exactly what 
you envisioned. Ask, "What do I like about it?" 
Keep and emphasize these elements. Ask, "What 
don't I like about it?" Eliminate or minimize these 
elements. Also, there are more than one possible 
compositions in a scene, so rather than get "THE" 
shot, aim to explore the subject/location from a 
variety of angles before moving on to a new one.   

 

Leverage Your Learnings in Your 

Next Shoot 

 By trying different techniques and 
critiquing your results, you are generating new 
ideas, which feeds the creative process for 
possible later use in future photography 
outings. 

Colleen Miniuk-Sperry 

www.cms-photo.com 

Text and Images © Colleen Miniuk-
Sperry/CMS Photography 

Email:  cms@cms-photo.com 
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an outdoor photographer, writ-

er, publisher, instructor and 

speaker.  Her credits include 

National Geographic calendars, 

Arizona Highways and a variety 

of other publications. She has 

served three times as an Artist-

in-Residence with Acadia Na-

tional Park and authored sever-

al award-winning books includ-

ing guidebooks. She offers workshops and Sheogra-

phy Women’s Photography Retreats through her own 

company, CMS Photography and with several other 

workshop companies. Along with her camera college 

presentations, Colleen will also be conducting an In-

teractive Session “Beyond the Snapshot” Saturday - 

Hasbrouck at 2 PM (Double Session). 
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What are these dancing lights?  

Always useful to have an understanding of the 
natural phenomenon we are witnessing, as it adds 
to your appreciation of what you are seeing, and 
sometimes helps you capture better images.  So 
here is an overview of the natural processes that 
create auroral displays and the factors that 
influence the colors we see. 

The name Aurora Borealis has been attributed 
to Galileo and was derived from Aurora (the 
Roman Goddess of Dawn) and Boreas (the Greek 
word for north wind). Auroras begin with the 
nuclear processes deep within the sun, that play 
out of the surface, as ejections/solar flares. The 
sun ejects huge quantities of charged particles, 
and some of these find their way to Earth and 
influence the development of auroral displays.  

The largest of ejections are known as coronal 
mass ejections (CMEs). CMEs are even more 
energetic, and can send incredibly massive 
outbursts of plasma towards Earth.  When a CME 
arrives here, the aurora can go into overdrive, 
producing highly-energetic, color displays. 

The size of these ejections can be up to two 
trillion tons, traveling 1,000,000 miles / hour . . . 
and they might be headed towards us. 

On September 1–2, 1859, one of the largest 
recorded geomagnetic storms (as recorded by 
ground-based magnetometers) occurred. Auroras 

dependent society.  The solar storm of 2012 was 
of similar magnitude, but it passed Earth's orbit 
without striking the planet. 

We would be in big trouble except for Earth 
and life on Earth is protected by the Earth’s 
magnetic field.  Our magnetic field diverts much 
of the high-entry particles from CMEs and solar 
flares, while capturing some of them.  The 
captured particles are channeled by the Earth’s 
magnetic field, and the flow towards our north 
and south magnetic poles. And when those 

were seen around the world, those in the 
northern hemisphere as far south as the 
Caribbean; those over the Rocky Mountains in 
the U.S. were so bright that the glow woke gold 
miners, who began preparing breakfast because 
they thought it was morning.  People in the 
northeastern United States could read a 
newspaper by the aurora's light. The aurora was 
visible as far from the poles as Sub-Saharan 
Africa (Senegal, Mauritania, perhaps Monrovia, 
Liberia), Monterrey and Tampico in Mexico, 
Queensland, Cuba, Hawaii, and even at lower 
latitudes very close to the 
equator, such as in 
Colombia. 

Telegraph systems all 
over Europe and North 
America failed, in some 
cases giving telegraph 
operators electric shocks.  
Telegraph pylons threw 
sparks.  Some telegraph 
operators could continue to 
send and receive messages 
despite having disconnected 
their power supplies. 

A solar storm of this 
magnitude occurring today 
would cause widespread 
disruptions and damage to a 
modern and technology-

Aurora Photography 
By Denise Silva (VA) 

©  Denise Silva 
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particles enter our atmosphere, they interact with 
oxygen and nitrogen, and an aurora is born. 

What Do We See?  

Where and when you can see auroras?  
Northern latitudes, colder months — sometimes 
this can be challenging. 

The image to the right provides some insight 
on what to expect when you go out and look for 
auroras. Often the aurora appears as dust or thin 
clouds moving in the sky. If the aurora gets more 
intense, it will appear denser and will often glow 
with green/yellow light. At its most intense, it can 
display many colors, which we will discuss next.  

Where are the Colors?    

Your first sighting of an aurora may 
not be what you expect — and you may 
not even recognize what you are seeing 
is an aurora. 

Don’t expect to see much color in a 
low-energy aurora or when you first go 
out at night.  Our eyes have diminished 
color sensitivity in the dark, and our 
overall night vision doesn’t approach 
daylight acuity. 

As your eyes adjust — and this can 
take quite a while — more details and 
more colors will become apparent. 

High-energy displays are brighter, 
allowing us to see the full range of 
colors. 

There are two types of 
photoreceptors in the human 
retina, rods and cones.  

Rods are responsible for vision at low light 
levels (scotopic vision). They do not mediate color 
vision, and have a low spatial acuity. 

Cones are active at higher light levels 
(photopic vision), are capable of color vision and 
are responsible for high spatial acuity.  

Our eyes are seeing in real time, where as our 
cameras collect light (data information) over time 
(2-8 secs). It is that light accumulation that 
results in colorful auroras in our images.  

What Causes the Colors?  

In plain language . . . Interactions between 
high-energy particles — the solar wind — and 

oxygen and nitrogen. 

    Green — By far, the predominant color 
— oxygen. 

    Red — Nitrogen and high-altitude 
oxygen. 

    Blue — Nitrogen. 

Colors are influenced by differences in 
temperature and density of the local 
atmosphere. 

These colors can appear to “mix” to form 
purple, yellow, yellow-green, pink, 
orange, orange-red — infinite variations. 

Quantum transitions in excited atoms of 
nitrogen and oxygen, influenced by 
temperature and density of the local 
atmosphere.  Ionized — loss or gain of an 
electron.  

When excited, the electrons move to 
higher-energy orbit; when the electrons 
return to lower-energy orbit, it emits a 

©  Denise Silva 

4 sec at f/1.4, ISO 1600 
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photon.  Energy of emitted photon is proportional 
to its frequency. 

When it returns to ground state, excited 
oxygen can take three-quarters of a second to 
emit green light and up to two minutes to emit 
red; during that time collisions with other atoms 
or molecules absorb the excitation energy and 
prevent emission. 

Because the highest atmosphere has a higher 
percentage of oxygen and is sparsely distributed 
such collisions are rare enough to allow time for 
oxygen to emit red.  

Collisions become more frequent progressing 
down into the atmosphere, so that red emissions 
do not have time to happen, and eventually even 
green light emissions are prevented. This is why 

630.0 nm), followed by pure red, then yellow (a 
mixture of red and green), and finally, pure blue 
(primarily 428 nm). 

Where and When to See Auroras? 

Longer days and shorter nights mask most 
auroral displays from May through September. 

Many Locations! 

Alaska – Best Location in the U.S. – Bettles 
and Chena Hot Springs 

 Canada 

 Iceland 

 Greenland 

 Norway 

 Finland 

 Sweden 

 Russia 

The Auroral Oval—Auroras vary widely.  The auroral zone 

shown here reflects typical solar activity.  At the latitudes 

shown, and typical solar activity, good displays may be 

seen from early September through early April. 

there is a color 
differential with 
altitude; at high 
altitudes oxygen red 
dominates, then oxygen 
green and nitrogen 
blue/red, then finally 
nitrogen blue/red when 
collisions prevent 
oxygen from emitting 
anything.  

Green (557.7 nm) is 
the most common color. 
Then comes pink, a 
mixture of light green 
and red (primarily 

Strong solar activity can expand the auroral band 

southwards by hundreds of miles.  The auroral zone 

shown here reflects stronger than typical activity.  

Stronger than Typical can be seen in Late Fall, Winter, 

Early Spring. 
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Aurora Photography 

Two Approaches 

Shorter exposures preserve details in the 
aurora, but at the cost of foreground detail. 

Longer exposure can reveal interesting 
foreground detail, with less detail in the aurora. 

My favorite conditions for shooting is where 
there is a half-moon providing ambient light to 
illuminate the fore and background of the image. 

Equipment – The Gear You Need to 

Capture Auroras 

Cameras are constantly improving — even 
iPhones / cell phones are capable of making 
decent images.  But if you’re after high-quality, 
high-resolution images, your choices are 
narrower. 

 ©  Denise Silva 
10 sec at f/4, ISO 3200 

3 sec at f/14, ISO 1000 

Arc/Arching  

Generally moving east to west, can stretch thousands of 

kilometers, with a fairly narrow width. These displays 

tend to be green and yellow, with distinct edges. 

©  Denise Silva 
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8 sec at f/2.8, ISO 640 

5 sec at f/4, ISO 3200 

Corona Displays  

When witnessing these displays, you feel as though the 

aurora is shooting straight out of the sky towards you. 

These displays tend to have dramatic colors as well. 

©  Denise Silva 
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4 sec at f/2.8, ISO 2000 

Undulating  

These displays stretch over a broad expanse of sky,  

no obvious pattern. 

10 sec at f/4, ISO 2500 

Radiating Fan   

Essentially composed of many arcs.  

©  Denise Silva 

©  Denise Silva 

2 sec at f/4, 

ISO 5000 

Columnar  

This aurora 

appears to 

twist on itself.  

4 sec at f/1.4, ISO 640 

Diffuse - Soft, cloud-like 

can indicate a high-energy event, but widespread and  

generally lacking clear structure. 

©  Denise Silva 
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4 sec at f/1.6, ISO 640 

1.6 sec at f/1.4, ISO 400 

Ribbon or Band  

Typically bright, rapidly moving. 

©  Denise Silva 
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Essential Equipment  

 A digital camera (any kind) that allows 
you to fully control shutter speed, ISO, 
and lens aperture. 

 Lens—Wide-angle — “Best” images are 
typically 24 mm or wider.  

 Aperture of f / 1.4 – f / 2.8. 

 Sturdy tripod and ball-head. 

 Cable release or remote (or use exposure 
delay mode). 

 Fast memory card; extra batteries; red-
light penlight / headlight; and waterproof 
dry-sacks. 

Generally it will be useful to be able to fully 
control the camera (i.e., manual mode). 

Typically, we’re using a modern DSLR or 
mirrorless camera, but some compact cameras 
may work, as long as they provide the necessary 
control over shutter speed, ISO, and lens 
aperture.  Even iPhones and other cell phones 
can make good quality images of the Northern 
Lights if you have the right app and a tripod. 

Remember: The best camera is the one you 
have with you. It’s not the gear that makes the 
photograph . . . it’s you, the photographer. 

In the Field – Preparation and  

Technique 

In the field — technique, best practices – 
There are consequences to the where and when. 

 Use Manual mode — both the camera and 
the lens. 

 Use a cable release or remote, or exposure 
delay / self timer mode. 

 Periodically check your images to 
reconfirm sharp focus.   

 Select an interesting background or 
foreground to help show scale and add 
additional interest.  

 Vary your exposures as conditions change, 
but strive to keep your shots as short as 
possible to preserve the detail of each 
display, and keep ISOs low to minimize 
noise. 

Shooting in Extreme Cold 

Special considerations for extreme 
environments – When the temperature drops 
below zero, there are risks, some of which can be 
quite serious, and you need to be well-prepared to 
deal with them.   

Recognize that you are taking your gear well 
beyond designed operating temperature range; 
e.g., Nikon operating environment temperature is 
stated as  32° to 104° F (0° to 40° C).   

Electronic components can become unstable.  
Mechanical components can malfunction, can be 
damaged. 

Batteries may not deliver rated power, may 
give out entirely. Be sure to bring multiple fully-
charged batteries into the field. 

Focus may shift as lens components contract.  
Another reason to periodically check focus.  Cable 
release cords can become stiff and brittle.  Even 
tripod components can become brittle. 

 Consider saving your images in RAW 
format. 

 If you have the option, use mirror-up 
mode. 

 Initial settings — these are starting 
points — adjust to taste 

 White balance:  Daylight  

 ISO:  ~1000–3200 (newer models:  
consider starting higher)  

 Short exposure:  ≤ 8 seconds 
(coordinate with ISO) 

 Long-exposure noise reduction: Off  

 High-ISO noise reduction: Off 

 Lens  

 Disable vibration reduction / image 
stabilization  

 Wide-open aperture (e.g., f / 1.4) 

Technique - You need to fully understand 
how to operate your camera, and if you have 
any doubt, have your manual handy. Once you 
are set up and in the field, the only settings you 
will change are ISO and shutter speed. 

 Know how to adjust aperture, ISO, and 
shutter speed in the dark, without the 
assistance of a light. 

 Focus at infinity (pinpoint stars) for best 
aurora image; don’t assume that your 
lens has a reliable “hard infinity.” 

 Use Live View when focusing — Zoom in 
on a bright star (this is best) or other 
bright distant object; focus; confirm 
sharp focus with test shots. 
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Condensation is a significant concern when 
taking extremely cold gear into a warm, humid 
environment.  Pack cameras, lenses, remotes in 
waterproof dry-sacks before taking them indoors. 

Sub-zero Concerns: Unless you are properly 
prepared, extreme cold is potentially hazardous, 
harmful, lethal.  Frostbite, hypothermia are major 
concerns.  Snow and ice add their own hazards.  
Wind makes everything worse. 

Dress in layers, wear gloves / mittens; a hat, 
hood, or balaclava; a face mask if needed; wool 
socks (with silk or merino wool sock liners for 
added comfort); bunny boots or other insulated 
boots. 

Ice cleats are strongly recommended (not just 
when traversing frozen rivers / lakes and glaciers 
— icy sidewalks, stairs, and paths can be quite 
hazardous). 

Clothing and boots should be rated for the 
environment. 

Inadequate gear quickly becomes obvious in 
the field.  If so, see if you can borrow or rent 
proper outerwear from your lodge or elsewhere. 

Hand warmers and foot warmers can help, but 
they don't always last as long as we would like, so 
carry spares.  

Don’t go out alone into extreme conditions 
without informing someone of your plans, route, 
and schedule.  And don't assume "good" weather 
won't change and turn into a serious challenge — 
be prepared for worse than you expect. 

Processing Your Images  

These are the settings I use, but clearly this is 
too taste! 

Don’t spend the entire evening looking 
through the viewfinder.  Don’t miss the show! 

Denise Silva 

Text and images © Denise Silva 

www.denisesilvaphotography.com 

www.roadrunnerphotographytours.com 

www.meetup.com/road-runner-
photography-tours 

https://www.facebook.com/
RoadRunnerPhotographyTours 

 Basic (under the most recent LR 
update):  Change from Adobe Standard 
to Camera Manufacturer Preset if 
available.  

 Lens Corrections:  

 Profile panel: Remove Chromatic 
Aberration (check box) 

 Profile panel: Enable Profile 
Corrections (check box) 

 Basic panel:  

 Exposure  +1.00 

 Contrast +12  

 Highlights -14  

 Blacks +12 

 Clarity  +39 

 Vibrance +11 

 Saturation +5  

 Selective Sharpening and Noise 
Reduction: Use the Mask feature on 
Sharpening and Color NR. 

 Crop Overlap:  Crop to taste. 

Every scene, every exposure, every image is 
unique, and your final image should reflect your 
artistic vision and interpretation. 

Wrapping Up 

Experiment — Vary your settings and find 
another right answer. 

Post-processing:  The image belongs to you.   

Denise Silva (VA) is a 

photographer, teacher, 

writer and tour leader 

who finds every aspect 

of photography 

rewarding.  She was the 

featured photographer 

in Photoshop User 

Magazine- “Who’s Who 

in the KelbyOne Community” article and has been 

recognized as one of the Top 200 Women 

Photographers Who Inspire by Nature Photo Guide.  

She leads tours through her tour company, Road 

Runner Photography Tours and looks forward to 

sharing her passion for photography with you. Denise 

will also be co-leading (with Geffrard Bourke) a hands-

on Photo Walk (pre registration is required) involving 

the use of Neutral Density Filters and is a Conference 

Speaker Image Reviewer.  
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I am John Slonina a professional nature pho-
tographer and photo workshop leader. I would 
like to give you some tips to improve your land-
scape photography. 

Landscape photography is all about drama.  A 
great photo is a combination of dramatic fore-
ground and backgrounds composed along with 
great light. A good photographer plans and does a 
lot of research to be in the best place at the best 
time. It is important to be prepared and have the 
right equipment.  

Useful Programs 

There are several great programs available on 
your computer and cell phone, which are incredi-
bly useful.  

Photo Pills 

PhotoPills is your personal assistant in all pho-
tographic matters. It helps planning and shooting 
your creative ideas.  

My favorite feature is the augmented reality. It 
helps visualize the paths of the sun, moon, and 
Milky Way. You look thru your cell phone live and 
it superimposes the paths above the picture. It 
helps you see exactly where everything will rise or 
set. 

Sunrise and Sunset times shows the times in-
cluding blue hour.  

It shows Moon phases, rise and set times, su-
per moon dates, calendar.  

Depth Of Field Calculator 

Here are some of my favorite websites and 
apps. 

Space Weather 

Gives you an Aurora Forecast, Meter Shower 
info and general info on special events going on 
in outer space.  I also pay $5 month for Aurora 
Alerts which are text messaged to my phone.  
www.spaceweather.com 

Solar Ham 

Gives you info on the Aurora and Sun Activi-
ty.  www.solarham.net/ 

Tide Charts 

There are several tide charts. 

Weather 

There are several weather apps 
(Wunderground, Weather.com, Accuweather) 

Photographer’s Ephemeris 

It is a map-centric sun, moon and Milky 
Way calculator: see how the light will fall on the 
land, day or night, for any location on earth. 
This program is also available as an app.  
www.photoephemeris.com/ 

Unlease Your Landscape Photography 
By John Slonina (MA) 

©  John Slonina 
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Star Trails Simulator shows simulations of star 
trails. Preview how stars rotate and the angle they 
describe in a given exposure time. 

FOV Calculator  helps determine what lens you 
need to achieve a particular field of view.  

Depth Of Field Augmented Reality view of our 
DoF calculator will allow you to see where to fo-
cus to get the sharpness you want.  

Hyperfocal Table shows the relations among 
aperture, focal length and hyperfocal distance.  

Focal Length Match Calculator computes the 
equivalent lens focal length and aperture to pro-
duce the same field of view and depth of field be-
tween two cameras with different sensor sizes.  

Time Lapse Interval Table helps you calculate 
how many photos to take and how much time in 
between photos (intervals).  

Composition Tips 

 Rule of Thirds 

 Dead Space 

Split Neutral Density Filter (not screw it type) 

Polarizer Filters  

The polarizer filter has many great functions. 
It darkens the sky, reduces haze and cuts back 
reflections.  

My favorite use of this filter is to cut back glare 
from vegetation.  

Be careful, do not over polarize.  

Live View is a wonderful tool for the landscape 
photographer. The ability to zoom and pan 
around an image in Live View really helps when 
you are trying to find the correct hyper focal point 
to balance focus between near and far elements in 
a scene. It helps with critical focus. I use it exclu-
sively for focusing at night when the light is low. 

For macro photography it helps with critical 
depth of field and detects movement. Sometimes 
you think the wind is not moving your subject but 
you may be in for a surprise. I also like the expo-

 Avoid Clutter, Merges, Crooked Hori-
zons 

 Strong foreground 

 Strong Background 

 Leading Lines 

 Use both Horizontal and Vertical 

 Control Depth of Field 

 Framing with natural lead in 

 S Curve 

Shoot a wide variety of landscapes. Grand 
Landscape, Interior Forest and Close Ups. Use 
a wide variety of focal lengths. Get out of your 
comfort zone. 

Filters 

UV and Skylight Filter (Skip) 

Neutral Density Filter (great for water and 
special effects)  

©  John Slonina 
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sure simulation and grid overlay. The only nega-
tive is it drains the battery quicker. 

Contrast is a big problem for an outdoor pho-
tographer. Let’s say you are photographing a 
Mountain Range with a field of wildflowers in the 
foreground. If you expose for the Mountains and 
Sky the field will be too dark. If you expose for the 
wildflowers the sky will be washed out. There are 
several ways to deal with this issue. 

Change Composition  

 Use a Split ND Filter 

 HDR  

 Take two separate pictures and combine 
them using Masking and Photoshop 

 Use the Graduated Filter in Lightroom 
or Photoshop 

Special Situations 

Take advantage of the weather 

 Sunny  

 Cloudy  

 Time of Day  

 Side Lighting 

 Front Lighting 

 Back Lighting  

 Storms 

John Slonina (MA) Slonina is a 

professional nature photographer, 

with a passion for wildlife, wild 

places and teaching who has been 

photographing nature for over 30 

years. His work has been published 

in calendars, books, and magazines 

and has also been displayed in 

several galleries. A popular speaker,  

he has presented for camera clubs, 

nature groups, and photo 

conferences throughout the USA. 

Through his photo tour company Slonina Photography he 

leads tours and photo workshops across North America.  

In addition to his camera college presentations, 

John  is a member of the Digital Image judging 

panel and is a Conference Speaker Image 

Reviewer.  

 Fog  

 Silhouette  

 Moving Water: Streams, Rivers, and Wa-
terfalls 

Timelapse is still photography compiled into a 
video.  You need a great subject that is effective 
with a time element (change over time).  

John Slonina 

Text and images © John Slonina 

www.sphotography.com  
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ENVISION:  The Art of Seeing Creatively 
By Mark Bowie Sponsored by ADKPI 

Personal Vision 

What distinguishes one photographer’s work 
from another?  It often starts with their photo-
graphic vision.  Learning to see creatively is a life-
long endeavor; the opportunity for discovery is 
one of the main reasons I photograph. 

With so much beautiful landscape photog-
raphy out there, we need to command viewers’ 
attention and make them think over our images.  I 
believe we need to go beyond the familiar, show 
them something new or unexpected, or show fa-
miliar subjects from a different perspective.  My 
goal is to go beyond what we already know.  Then 
— this is important — I’ll prominently compose 
the features that make my subjects distinctive.  
Look Deeper… Go Deeper. 

The Art of Seeing is 
as much about see-
ing with the mind’s 
eye as it is with 
your own eyes — to 
envision what the 
components of a 
scene can create for 
you.  Try to visual-
ize subjects not for 
literally what they 
are, but as graphic 
shapes, textures 
and colors.  How 
will a subject ap-
pear under- or 
overexposed, with 
increased contrast, 
by its placement in 
the frame, by 
zooming in tight or 

presenting it in a wide view, or rendered with 
long exposure or other expressionistic tech-
niques? 

Attributes of Special Landscape  

Images 

I’ve found that special images are usually the 
result of several attributes coalescing at once.  So, 
in the field, I’m specifically looking for:  

Beautiful Light, often the r esult of in-
clement weather.  It also varies by time of day and 
the seasons. 

Interesting, Meaningful Subjects tha t 
tell a visual story, and, for their distinctiveness, 
imparting a sense of place. 

©  Mark Bowie 
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Moody and Atmospheric Scenes.  I 
want to feel them, and want viewers to feel what 
it’s like to be there. 

Complementary Colors and Tones, the 
color and tonal palettes. 

Interesting Forms, Lines, Patterns, and 
Textures.  I’ll accentuate them in my composi-
tions. 

Commanding Foregrounds and Majes-
tic Backgrounds, for  v isua l la y er ing . 

Intriguing Vantage Points tha t pr ovide 
a physical viewpoint, and a narrative. 

The Element of Time to be convey ed 
through shutter speed — long or short — and 
through time-lapse sequences.  Beauty often 
moves. 

Special Moments w hen something  ma g -
ical happens. 

Unique Conditions and Seasonal Varia-
tions tha t impa r t a n element of w onder .  

That’s quite a list!  Ultimately, I’m instinctively 
looking for Uncommon Beauty, guided by the ele-
ments above. 

Research and Pre-Planning 

To play the percentages and position myself 
for compelling subject matter in beautiful light, I 
do research in advance.  I prefer to shoot into or 
toward the sun because that’s often where the 
great light is.  So, I generally search for east-
facing scenes at sunrise and west-facing scenes 
for sunset. 

I monitor weather forecasts and get live satel-
lite radar on accuweather.com, weather.com, and 

will immediately set up the tripod, at chest 
height, and start shooting.  In that way, they’re 
preferentially determining their vantage point 
and not searching for the best one, nor letting the 
subject dictate it. 

Composition is paramount to successful imag-
es.  Refining our compositional skills is one of the 
single-most important things we can do to im-
prove our imagery.  Make test compositions in-
camera, learn from them, and refine them, espe-
cially for moving subjects, like water and 
clouds.  Once you make a shot, check the histo-
gram for exposure and zoom in on the LCD to 
check focus and composition. 

One of the most productive ways of learning to 
see better, and create better imagery, is by doing 
your own projects.  Pick a subject you really love 
and explore it deeply; your images will likely be 
stronger than those shot by someone who only 
treats the subject on the surface. 

wunderground.com.  The hourly forecast is of 
particular interest; I target periods of transi-
tioning weather, which often result in dramatic 
light.  When at the coast I check tide tables at 
tides.net, saltwatertides.com, and ushar-
bors.com.  

I often consult The Photographer’s Ephem-
eris, Goggle Maps and Google Earth.  Amongst 
other features, they have timelines you can put 
in motion to see how shadows fall across the 
landscape throughout the day.  They can also 
help you align interesting landscape features 
with the sun and moon, for your location, and 
into the future.  

Pre-Shot Routine 

Once on-site, slow down.  The art of seeing 
is about the power of observation.  When you 
slow down and try to tune in to what’s going on 
around you, you begin to notice details origi-
nally glossed over. 

Scout first, shoot later.  Search for composi-
tions without the tripod.  Many photographers 

©  Mark Bowie 
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Light – From Dawn to Deep Night 

There are three primary types of lighting con-
ditions.  Front lighting brings out colors and de-
tails.  Back lighting de-emphasizes detail, but 
highlights graphic shapes and form.  It can pro-
vide strong silhouettes and rim-lighting.  Side 
lighting emphasizes textures and details.  So, 
when you’re presented with a certain type of 
lighting, search out subjects that will be show-
cased by it. 

Time of day has a major effect on the light.  Be 
up early, stay out late used to be the nature pho-
tographer’s mantra, because that’s often when 
there’s magical light.  I’ll argue every time:  
throughout the day offers special qualities of light 
not available at other times. 

Both pre-dawn and evening twilight offer con-
sistently moody and atmospheric light.  The sky 
turns rich luminous blue, whether it’s clear or 
cloudy.  Maybe the best thing about evening twi-
light is that it slides directly into night light, when 
light builds up cumulatively during our long ex-
posures, rendering colors rich and intense. 

Storytelling 

I look to shoot images that tell a story, create a 
sense of place, or symbolize a concept.  When the 
image tells a story, viewers are encouraged to lin-
ger over it and ponder its meaning.  Now the im-
age is elevated to something special, not simply 
glossed over as familiar. 

Photo opportunities are presented in all types 
of weather, many exclusive to certain types.  Go 
out in all kinds, in each season, to produce dis-
tinctive imagery.  I particularly seek out weather 
and lighting conditions that exude a feel: won-
drous, ominous, mysterious, calming — some-
thing that’ll evoke an inner response in myself 

Most nature photographers know that some 
of the most dramatic, saturated light occurs 
around sunrise and sunset.  However, there're 
often two beautiful surges of light early in the 
morning; the most colorful is often a full hour 
before sunrise, the second as the sun nears the 
horizon.  It pays to be up very early. 

I’ve found that even in harsh midday light 
specific opportunities present themselves that 
otherwise don’t happen.  For example, in 
stream and waterfall corridors, as sunlight hits 
the far shore, colorful foliage is reflected in the 
water.  This doesn't happen in often-preferred 
overcast weather. 

Sunset light 
can bathe the 
landscape and 
sky with warm, 
intense colors.  
And when 
there’s a break 
in the clouds on 
the horizon at 
sunset, the light 
can be especially 
dramatic. 

©  Mark Bowie 
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and the viewer.  This often happens during in-
clement weather. 

One of the best ways to make unique land-
scape images is by shooting from unusual and 
compelling vantage points — the physical points 
of view from which we’re trying to provide a nar-
rative.  Showing viewers rare perspectives piques 
their curiosity. 

tonal palettes, and repeating patterns and tex-
tures.  

Slow down and observe.  For if there’s one 
thing that can most improve our photography 
and enhance the joy of discovery of Nature’s infi-
nite beauty, it’s to look deeper. 

Mark Bowie 

www.markbowie.com 

mrbowie@earthlink.net 

Text and images © Mark Bowie 
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See closer, get closer.  Look for dominant 
subjects and compose them so there’s no ambi-
guity as to the main subject.  A compelling fore-
ground establishes a contextual relationship 
between the bottom of the image, the middle 
ground and top, and ideally, helps lead the 
viewer through the scene.  I also use the princi-
ples of visual flow to align elements within the 
frame and generate a visual path, including the 
use of leading lines, light and shadow, color and 

Mark Bowie (MA) is a 

professional nature 

photographer, writer, teacher, 

and sought-after speaker who 

has presented programs at 

camera clubs, councils and 

conferences. He has produced 

three books on his native 

Adirondacks, two e-books on 

night photography and his work 

has been published in books and 

magazines, on calendars, posters, and in advertising 

media.  He also leads landscape photography 

workshops, including night shooting workshops.  

Sponsored by ADKPI  In addition to his camera 

college presentations, Mark is a pre-conference 

workshop presenter and is a Conference Speaker 

Image Reviewer.   
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Gear 

Straight Lenses 

Canon 180mm f/3.5 lens 

Tamron 180mm f/3.5 lens 

Why I like the 180mm 

 Working distance 

 Compression 

 Background blur 

 No light interference 

 Max detail/texture 

Lensbabies: A Lens System and More 

Why I love them 

 Rarely need post processing 

 Allow me to capture what I see in a new 
way 

 Background blur and distortion right in 
camera 

 Can easily draw the eye to just one area 

 Make me slow down, really look, study my 
subject, compose carefully 

Other Lenses 

Use what you have!  Learn 
your gear, you need to know:  

 Minimum focus distance 

 Compression? 

 Bokeh? Blur? 

Getting Closer 

 Extension Tubes 

 Macro Diopters 

Other Accessories 

Plant Clamp (holds diffuser, reflector or back-
ground) 

Lighting 

Light needs to be the first thing you think 
about  

Best Light for Flowers: 

 Clouds 

Favorite Lensbaby Optics for  

Flowers 

 Soft Focus 

 Sweet 50 

 Twist 60 

Lensbaby Straight Lenses 

Velvet 56 

Velvet 85 

The Art of Flower Photography  
By Kathleen Clemons (ME) Sponsored by Lensbaby 

https://lensbaby.com/
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 Open shade 

 Diffused 

Bad Light Causes: 

 a loss of texture 

 loss of color 

 added lines 

 added contrast 

Adding light: reflector 

Shooting in bright light 

Composition—Guidelines for Subject 

Placement 

Centering: Look for strong symmetry or strong 
visual weight 

Generally slightly off center 

Rule of Thirds 

Vertical or Horizontal? 

Backgrounds 

The background is as important as your sub-
ject! 

Messy backgrounds: move in closer, blur the 
background, try a different angle, substitute. 

All About Depth of 

Field, 4 factors 

 Aperture Choice 

 Distance to subject 

 Distance from subject to 
background 

 Focal length of lens 

Using Selective  

Focus 

 How much needs to be 
in focus?  

 Enough to tell the story you want to tell. 

 Enough to hold the viewer’s attention as 
a focal point. 

 As much as you, the artist wants. 

The Balance 

How much needs to be in 
focus? 

How much blur is ac-
ceptable? 

Remember- best light 
and best focus need to be on 
the same area. 
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Choosing a Subject 

 Condition 

 Personality 

 Conceptual 

 Life stages 

 The dance 

Kathleen Clemons 
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Painterly Style - What Do You Like? 

Who Are Your Favorite Painters?  -Look at 
how they depict light, tones, colors, brushstrokes, 
subject matter 

 Style- representational, abstract? 
Somewhere in between? 

 Start thinking and visualizing beyond 
documentary images, more about what 
you see and feel 

 Make a list of what you like as a painting 
style 

In Camera Techniques 

Finding painterly subjects, learning to see 

My favorite technique- Selective Focus: Using 
shallow depth of field to draw attention to one 
part of the photo, blurring the rest of the image 
and simplifying the subject or scene. 

Using a Lensbaby: Selective focus optics for an 
in camera painterly effect 

My favorite Lensbabies for a painterly look 
right in camera: 

 Lensbaby Composer Pro 2 with Sweet 50 
optic 

 Lensbaby Composer Pro 2 with Sweet 35 
optic 

 Not just water, look for window 
reflections, old glass, distortions 

Double Exposures 

One in focus image combined with an out of 
focus version of the same subject, creates a soft, 
painterly look 

Multiple Exposures 

Set camera to Multiple Mode, 5-11 exposures, 
tilting the camera with each exposure in a circular 
motion, keeping focus on same area with each 
exposure. Look for colorful subjects. For an even 
softer look, try making the last exposure totally 
out of focus for a veil of color overlay. 

 Lensbaby Composer Pro 2 with Soft 
Focus Optic (discontinued but can be 
found on e-bay often) 

 Lensbaby Twist 60 

 Lensbaby Velvet 56 

 Lensbaby Velvet 85 (same effect, longer 
focal length, great if including a 
background) 

Shooting Through 

 Goal is a veil of color in the foreground 

 No shaped blur 

 Use large aperture, long lens very close 
to foreground foliage or flower 

 Can also shoot through fabric, panty 
hose, vaseline on filter, textured glass 

Reflections 

 Can also get an in-camera painterly look 
with reflections. 

 Wonderful distortions and blur 

 Flip upside down so it’s not as obviously 
a reflection 

 Include only the reflection 

The Painterly Photograph 
By Kathleen Clemons (ME) Sponsored by Lensbaby 

https://lensbaby.com/
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Slow Shutter Speeds: Beyond Moving 
Water- Embrace The Blur! 

If the subject is moving, camera remains 
still. Your slow shutter speed will depend on 
how fast the subject is moving- experiment, no 
2 pics alike.  

Panning moving subjects 

 Follow subject’s movement with your 
camera. 

 Vertical or Horizontal Panning for 
stationary subjects (trees, tall plants and 
flowers etc):  

 Use fluid movement, not choppy  

 Not too fast (loss of detail) 

 Not too slow (not enough effect) 

 Start with 1/15, speed will depend on your 
motion speed. 

 Use a polarizer  or neutral density filter 
if you cannot get a slow shutter speed. 

 Try a wiggle or a nudge, not just straight 
movements. 

Post Processing Painterly 

Techniques 

Photoshop’s Oil Paint Filter 

Find it here: Filter->Stylize->Oil Paint 

Topaz Impression 

http://topazlabs.com Always make a new 
layer first and go easy on the sliders!.  Use my 
15% discount by using the code kclemons15 

Photoshop Panning with Motion Blur Filter 

Filter->Blur->Motion Blur.  Make a new 
layer, set blur direction, move slider until the 
amount of blur suits you. 

Adding Texture Layers 

 Can add interest to an otherwise empty 
background 

 Can change the mood or tone of a photo 

 Can create a painterly feel 

 Need layers friendly software 
(Photoshop or PS Elements) 

 Mask (remove) texture from main 
subject area in focus. 

Finding Textures 

Look for: fabric, tile, stone, textured glass, 
frost, rust, rough papers, painted surfaces, soap 
bubbles, ice, sand, gravel, cracked surfaces, 
bark, cement, leaves, hay, straw and clouds. 
Textures are everywhere. Shoot textures at f/8-
f/11, keep lens parallel to textured surface. 

http://topazlabs.com
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Purchasing Textures 

Kathleen’s Textures and Book  http://
kathleenclemonsphotography.com/texture-store/  
25% discount code on anything in her Texture 
Store: allabouttextures  

Flypaper Textures  http://
flypapertextures.com 15% student discount code: 
Kath  

French Kiss Textures https://
www.frenchkisscollections.com 25% discount 
code: clemons25 

Topaz Labs www.topazlabs.com  15% 
discount kclemons15 on any products. Their 
Impression and Texture Effects software is 
wonderful! 

Also search for free textures on the 

web: 

ShadowHouse Creations http://
shadowhousecreations.blogspot.com/search/
label/Free 

Free Stock Textures https://
freestocktextures.com 

WildTextures http://
www.wildtextures.com 

Texturelib http://texturelib.com 

Texturemate http://
www.texturemate.com 

Flickr- Search for “free textures” and 
“free overlays” https://www.flickr.com 
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It’s Not Just Flowers 

My passion for photography covers a wide 
range of topics.  I’m known internationally for my 
aquatic photography.  That is, photographing 
tropical fish.  My aquatic work has been pub-
lished in National Geographic, Tropical Fish 
Magazine, Amazonas, Nature and several other 
hobby based magazines.  I quickly realized that 
the common denominator of my work is water.  
At 82 degrees it’s fish.  At 32 degrees it’s flowers. 

It’s a two step process.  The first step is actual-
ly creating the ice.  All of the photos are done by 
freezing or partially freezing flowers in blocks of 
ice. It sounds simple, but the actual science be-
hind the freezing is both interesting and beautiful 
in its simplicity.  Most importantly, it gives the ice 
a unique and beautiful background for the flower 
inside. 

Over the past three years I have taken over 
three thousand published photos of my Frozen 
Flowers.  Through trial and error…and a lot of ice 
and flowers…I’ve been able to develop my freez-
ing method to get a variety of effects.  But as in 
most things with nature and science, beauty often 
comes unexpectedly.  

I always hope that my art moves the viewer on 
the inside.  I hope that each and every one sees 
something different…feels something different.  

ing what’s inside (oxygen and liquid) to come to 
the surface of the plant.  At about 39 degrees, the 
water is as dense as it’s going to be without being 
a solid.   

From thirty-nine degrees to freezing, the prop-
erties of ice reverse direction and begin expand-
ing.  As the ice continues to freeze solid, it drags 
the bubbles from the surface and outward, creat-
ing the beautiful crystal trailers and bubbles.   

And most importantly I 
hope looking at them gives 
them as much joy as it does 
me when I photograph 
them. 

Frozen Flower  

Overview 

I originally intended on 
freezing a watch in ice.  At 
the time, I had some roses 
that I had given my wife.  I 
had an extra vase, so chose 
one of them.  I like the re-
sults of that better than the 
watch.  Since then I have 
frozen and photographed 
over three thousand flow-
ers. 

The Process 

When organic material is placed in the liquid 
at room temperature, it begins to cool.  As it 
does, the molecules in the water begin to slow 
down making the water increasingly dense.  The 
organic material in the liquid is squeezed caus-

Frozen Flowers - H2Mo – An Ongoing Guide to Going Creatively Crazy 
By Mo Devlin (PA) 
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Controlling the Process 

Some flowers freeze better than others.  Flow-
ers high in sugar and/or liquid don’t freeze as 
well.  This includes most of the cactus, poinsetti-
as, begonias, etc.  The dry stem flowers, flowers 
with a low liquid base freeze the best.  My favorite 
are roses, daisies, alstroemeri, etc. 

experimented extensively with the containers, 
trying everything from plastic bags to Chinese 
food and take out containers.  Each gives a differ-
ent look and effect. 

Containers 

Different containers provide different results.  
Since the formation of the bubble relies on the 
laws of physics, as the air freezes coming off the 
organic material, it take the shape of the contain-
er.  Round bowls will create, as you would expect, 
a curved bubble trail.  Flat containers create more 
of a pebbled finish. 

Size Matters 

Larger containers of water take much longer to 
freeze, producing more intricate designs.  Smaller 
containers freeze quicker, and don’t give the bub-
bles much chance to get further in the water be-
fore frozen.  I use containers that range from an 
ounce to five gallons.  Each provides unique op-
portunity to create different ice. 

Getting Creative 

With The Containers 

I originally started freez-
ing the flowers in glass vas-
es.  I quickly realized that 
one of the properties of ice 
made that difficult.  Ice 
eventually expands and will 
break the glass.  I moved on 
to Pyrex-like containers that 
would hold up to freezing.  
In addition to this I’ve used 
both metal and plastic con-
tainers to freeze them.  I’ve 

Chinese food container 
Containers and tools of the trade 

©  Mo Devlin 

©  Mo Devlin 
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Separating Ice from Container 

One of the trickiest parts of the process is re-
moving the ice from the container.  If you want 
ice to have a more natural look, you need to time 
it’s “partial melting” so that it comes cleanly out 
of the ice.  Something as simple as handling the 
container with warm hands is enough to begin 
shattering and cracking the ice.  The delicate use 
of either cool water on the container or a heat 
gun, can sometimes speed the process.  But noth-
ing beats letting nature take its course until the 
container lets go of the ice. 

Photographing the Ice 

Light is the key.  You don’t want to work with a 
shallow depth of field.  The only way around this 

Equipment 

 Container 

 Flower of your choice 

 Water  

 Freezer 

is to add a lot of light to the subject.  This will 
allow you to choose a tighter aperture and lower 
ISO to reduce noise. 

How you angle the light will affect how the 
flower is illuminated in the ice.  Picture what 
each of the individual ice trailers look like.  
They are basically hollow tubes.  Any light that 
is head-on will make the image look like simple 
points.  By angling the light it will add depth to 
the trailers. 

Macro vs. Full Flower 

There are several types of photos I’ve gotten 
from the ice.  Some that are obviously a flower, 
showing the full bloom.  But often looking for 
some of the hidden macro opportunities pro-
duce the best results. 

Work Flow 

It’s ice.  It melts.  Be sure to 
have your entire photo area 
set up well in advance.  Once 
the ice comes out of the 
freezer, it starts to melt and 
the clock starts ticking.   

Flat container 
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Camera equipment:  I shoot with a 60mm 
macro lens almost exclusively, but have experi-
mented with other lens to include 105mm and a 
10mm fisheye. 

Speedlights: I use up to five or six speedlights 
to illuminate the ice.  The majority are Nikon SB-
910 and Nikon SB-200’s.  Any speedlight will 
work.  I have not had much success with fixed 
lights. 

Mo Devlin 

Text and images © Mo Devlin 

http://modevlin.zenfolio.com/ 

www.aquamojo.com 

 

 

Large container 

Morrell Devlin (PA) started 

his photography journey 

through the armed forces  

working in the American 

Forces Radio and Television 

division. His other passion is 

keeping and photographing 

tropical fish. He is known 

internationally for aquatic 

photography which is published regularly in National 

Geographic and in several hobby magazines both in 

the USA and internationally.  A fan of all photography, 

he continues to experiment and push his creative 

core. For the past three years, his latest obsession 

his been to produce photos of frozen flowers. Mo is 

also conducting a “hands on” session;  frozen flowers 

in Photo Ops room CC 168 (lower level) on Sunday -9-

11 am. 

http://modevlin.zenfolio.com/
http://www.aquamojo.com
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Photo composition begins with an understand-
ing of how our visual responses connect to an im-
age. With foundations rooted in fine art, photog-
raphy is a medium that connects technology and 
science with the visual arts.  

Aesthetics 

Design principles like the Rule of Thirds and 
the Golden Ratio have long been used to create 
some of the most notable and beautiful fine art, 

architecture and photography. Under-
standing where these principles originated 
and how they are used can help us to make 
choices that improve the overall composi-
tion and beauty of our photographs. 

Leading, Dominant and Horizon 

Lines 

Using a leading line in your photo can 
help to draw the viewer's eye into your 

photograph, or in 
same cases away from it. 
Our eyes instinctively like 
to follow lines. Whenever 
possible, look for a line 
that will help the view-
er find their way into 
your image. 

Foreground  

Details 

Using foreground de-
tails are an excellent 
way to increase depth 
and dimension in your 
photograph, and is es-
pecially helpful with 
landscape photog-

Photo Composition: Fundamental Design Principles   
By Jennifer King (NC) 

©  Jennifer King 

©  Jennifer King 

©  Jennifer King 
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raphy. Using a foreground element in your photo-
graph can help you to manipulate spacial rela-
tionships in the landscape to create added dra-
ma.  

Framing 

Framing your subject is a 2-part process. It is 
an important part of photography both behind 
the camera and during processing. Be sure to take 
the time to see if the composition is good when 
you are behind your camera. It is equally im-
portant to study your photo during the processing 
stage for visual balance and distracting elements.  

Emphasize Your Hero 

Does the “hero” of your photograph stand out 
in the photo? Using techniques like shallow depth 

of field, or special processing techniques can help 
your subject pop off the background.  

Human Element 

Using a person in your landscape photo can 
help to tell a story. It communicates size and per-
spective. A redwood tree looks a lot bigger when 
there is a person standing next to it. A person in 
your photo can also help the viewer feel connect-
ed to the photograph. After all, if you can climb 
that mountain, then so can they. 

©  Jennifer King 

©  Jennifer King 
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The “IT" Factor 

Every person, place or thing has an “IT”  
Factor. It is the one thing that makes it unique in 
the world. Knowing what that “IT” Factor is be-
fore going out to photograph can prepare you to 
look for and capture what is unique about your 
subject. 

Perspective 

Each location or subject that we photograph, 
has the opportunity to be photographed in differ-
ent ways. A lens change, a position change or 
even a height change can dramatically alter the 

look of your photograph. Move around and try to 
capture very different photos out of the same sub-
ject. 

Visual and Emotional Connection 

There are elements that our eyes and emotions 
will connect to. Lines and patterns in your photo-
graphs are a great way to catch the viewers atten-
tion. Texture is an element that stimulates emo-
tion as we like to touch and feel connected to 
things. Using simple lines and textures helps to 
create both interest in the image while stimulat-
ing our senses. 

©  Jennifer King 

©  Jennifer King 
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Simplify 

The most beautiful things in life are often the most simple. This is also true 
for photography. Not every photo has to be a grand landscape or a story. A sim-
ple subject can say more than the tallest mountain range in the world.  

Jennifer King 

Text and images © Jennifer King 

www.jenniferkingphoto.com  

www.facebook.com/jenniferkingphoto  

Instagram:  jenniferking_photographer 

Jennifer King (NC) is a landscape 

and wildlife photographer based 

in North Carolina with over 20 

years in the photo industry as an 

instructor and “Wildlife 

Whisperer.” Her lifetime passion 

for teaching photography, 

exploring the world and 

discovering new locations to 

photograph has gained her 

photographic acclaim.  Her 

images and articles can be found 

in top resources such as Outdoor Photographer, and 

she has appeared as speaker at events such as 

NANPA’s 20th Anniversary Summit.  Jennifer founded 

Photography for the Fight Against Breast Cancer and 

brings together photographers, sponsors, individuals 

and the industry to raise money and awareness for 

breast cancer patients and research. Jennifer will 

also be one of your co-hosts at the Panel Discussion 

Saturday in Tom 102 at 2 PM and is a Conference 

Speaker Image Reviewer. 

©  Jennifer King 

©  Jennifer King 

http://www.jenniferkingphoto.com
http://www.facebook.com/jenniferkingphoto
https://www.instagram.com/jenniferking_photographer
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The world we live in is not simply the world as 
we see it. There are hidden patterns in flowers 
that only pollinating insects can see, pushed into 
the ultraviolet spectrum and invisible to us. While 
discovering these patterns can be a worthwhile 
experience, things get even more interesting 
when we make the world around us fluoresce. A 
rarely explored genre of photography, it’s not dif-
ficult to begin your own explorations. 

There are two distinct areas of ultraviolet pho-
tography: UV reflectance and UV fluorescence. 
Much of my work has been in UV fluorescence, 
and since it’s the easier and more beautiful of the 
two, is the primary focus of this presentation. 
Let’s start with the more “natural” UV reflec-
tance, however. 

Ultraviolet Reflectance 

This is the world that insects can see. Honey-
bees and other pollinators see light differently 
than us – one assumes that they can see a large 
portion of the visible spectrum but they aren’t 
limited to just that. Many flowers have a bulls-eye 
or “landing strip” pattern to guide an insect to the 
pollen, and we can photograph this with a spe-
cially modified camera. 

All cameras come with a filter placed in front 
of the camera sensor that blocks both infrared 
and ultraviolet light. CMOS sensors are normally 
sensitive beyond the visible light spectrum that 

www.ebay.com/itm/273112274099 - a Kyoei Ku-
ribayashi T-Mount lens that you can adapt to 
most lens mounts for $99.  

Natural sunlight might have enough light to 
use at higher ISO settings as well as wider aper-
tures, but you would benefit from having specially
-crafted ultraviolet flashes… which are also re-
quired for UV fluorescence! 

humans can see, and we need to narrow down 
the spectrum to match human perception. Want 
to push beyond that? Many companies can 
modify your camera for infrared, ultraviolet, or 
“full spectrum” photography. You NEED a mod-
ified camera for this to work, as well as a com-
patible lens. 

I recommend using a “full spectrum” conver-
sion, since the filters that companies place in 
front of the sensor to allow only UV light to 
pass, also bleed a portion of infrared light. The 
best solution is to place filters over your lens to 
properly narrow down the spectrum to be ex-
clusively ultraviolet. The best combination of 
filters to use can be purchased from max-
max.com – XNite 330C + XNite BP1. Both of 
these filters, stacked together, are by far the 
best way to get ONLY UV light to enter into 
your lens. The lens, however, is another prob-
lem. 

Many lens coatings, as well as the “glue” that 
holds complex lens element clusters together, 
will block UV transmission. If no ultraviolet 
light can make it through to your sensor, you’re 
in trouble! A few companies make UV lenses 
with quartz glass, but the price tag is over 
$8000 or higher. Yikes! Thankfully there are 
alternatives, but you can’t just use any lens.  

Some lenses with fewer elements will work 
better than more expensive lenses, but one eBay 
seller has a cheap solution: https://

Unseen World: Ultraviolet Photography 
By Don Komarechka (Ontario, Canada) 

A sunflower that normally appears completely yellow 

has a black bullseye in the middle to attract insects.  

©  Don Komarechka 
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UV Fluorescence 

This is where things get magical, and you don’t 
need a specially modified camera or lens. Your 
regular photographic tools will work just fine – 
it’s the lighting you need to pay special attention 
to. 

Many things in nature fluoresce. You might 
have heard of scorpions or certain millipedes 
glowing under ultraviolet light, but this attribute 
extends to many insects, plants and flowers as 
well. The challenge is hitting the subject with 
massive amounts of ultraviolet light and then col-
lecting the visible light that bounces back to the 

flectance notes. This less expensive combination 
bleeds infrared light, but that’s irrelevant to this 
type of photography. I tape these filters on the 
flash head with Gaffer’s tape and trigger them 
with a simple manual wireless flash trigger (Vello 
Freewave LR). 

I often use more than one flash, positioned at 
point-blank range, at maximum output. That’s a 
lot of light! Even still for a single exposure I 
might be using sensitivities as high as ISO 5000. 
If you have a static subject you can get away with 
lower ISO settings and a longer exposure in com-
plete darkness. You’ll just need to manually fire 
the flashes multiple times during the exposure 
(the flash trigger can be fired manually while off 
the camera). 

The “inverse square law” is important to con-
sider here. You really want the flashes as close as 
possible to the subject, even inside the frame can 
be helpful so long as it doesn’t block the subject 
and can be edited out easily. A half an inch closer 
can make a bigger difference than you’d expect. 

I have four flashes currently modified and 
when shooting with small apertures and lower 
ISO settings (200), I can get a decent image when 
firing them multiple times. 

Hunting down your subjects can be another 
challenge. While some flowers glow brilliantly, 
others are extremely disappointing. The wings of 
a cicada will glow a science-fiction shade of blue, 
but very few other insects will have fluorescing 
wings. A fun project would be to take an LED 
flashlight (the NiteCore SRT7GT has a UV mode) 
and walk around your garden at night to see what 
fluoresces. I do this weekly when there are new 
blooms arriving and sometimes I am pleasantly 
surprised by the new discoveries. 

camera. First, we need a clean, “pure” UV light 
source. 

Most ultraviolet LED lights, especially the 
inexpensive ones, tend to bleed a lot into the 
visible spectrum. This greatly “contaminates” 
the image with either red or blue, more com-
monly blue. The resulting image might show-
case some level of fluorescence but it’ll be mired 
in an unwanted colour cast. To get rid of this, 
you either need to filter down your existing 
lights or build one yourself. 

There are commercially available UV flashes 
priced at around $1000, but you can create your 
own for about half that price. A Yongnuo 
YN685 flash works as a great starting point – 
inexpensive and powerful. You’ll need to take 
the flash head apart (two screws and some 
clamps under the rubber circles on either side) 
and remove the two pieces of plastic designed to 
focus and/or diffuse the light. 

WARNING: Flashes use high voltage capaci-
tors. BE CAREFUL. If you don’t know how to 
handle high-voltage electronics, get someone 
else to do this for you. I use flashes that are tak-
en out of the box without ever having batteries 
placed inside, but there are still always risks. 

These pieces of plastic block or otherwise 
absorb UV light. Removing them converts the 
flash to “full spectrum,” at which point we need 
to filter it back down to remove all of the visible 
spectrum (infrared doesn’t matter as our cam-
eras already filter that out). To do this, a combi-
nation of two filters works best: Hoya U-340 
(commonly found on eBay) and MidOpt BP365 
(can be ordered through one of their distribu-
tors). This combination of filters in a 77mm size 
covers the entire flash head, and it’s cheaper 
than the XNite filters referenced in the UV Re-©  Don Komarechka 
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Ultraviolet fluorescence can be quite trans-
formative. In a recent image of a South African 
succulent (above), the off-white throats of the 
flowers glow a shade of green I’ve only ever seen 
in auroras. Irises tend to do the same, with green 
leaves becoming deep orange. Some flowers like 
Forsythia were complete duds – the bark of the 
tree glowed more than the blossoms. There isn’t a 
database out there that defines flowers based on 
how much they fluoresce, so the adventure is 
yours: are you ready to go down this rabbit hole? 

Don Komarechka  

Text and images © Don Komarechka 

www.donkom.ca  

 

 

Don Komarechka traveled from 

Canada to be here with us this 

weekend. From auroras to 

pollen, insects to infrared, much 

of Don’s photographic 

adventures reveal a deeper 

understanding of how the 

universe works. Exploring the 

world that we cannot see with our own eyes has been 

a common thread in Don’s career as a professional 

photographer.  Don is also conducting a “hands on” 

session to go with his presentation on photographing 

frozen snowflakes in Photo Ops room CC 168 (lower 

level) on Saturday 8:30-11:30am.  

©  Don Komarechka ©  Don Komarechka 

http://www.donkom.ca
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(Editor’s Note:  Please see Denise’s images 
which follow on the pages after this article.) 

Why Use Long Exposure 

 Alternative way to express one’s vision 

 Gives the feeling of motion in the image 

 Demonstrates the elapse of time 

 Captures mood 

What Time of Day is Best 

 Sunrise or Sunset 

 Twilight 

 Overcast 

 Middle of the Day! 

Techniques 

Hand-held Techniques 

 Panning - Capture the motion of the sub-
ject, while maintaining the subject in fo-
cus or render the entire image as a blur 

 Swipes - Intentional camera movement 
(horizontal or  vertical) 

 Taking Advantage of the Time of Day 
(Early Morning, Late Evening, Night) 

 Image Stacking 

 Create Motion 

 Manipulating the Lens 

 In Photoshop  

Gear and Settings 

Gear 

 Sturdy Tripod 

 Remote Shutter Release/Self-Timer 

 Filters:  

 ND Filters 

 Graduated ND Filters 

 Polarizer 

Camera Settings 

 JPG or RAW - shoot RAW 

 Provides more pixel data with which 
to work 

 Provides highlight and shadow detail 

 Adjust white balance in post 

 Camera Movement 

Tripod Techniques 

 Taking Advantage of the Time of Day 
(Early Morning, Late Evening, Night)  

 Gear & Settings 

 Using Filters  

 Manipulating the Lens 

 In Photoshop 

Hand-held Techniques  

Set the camera to manual and determine the 
proper exposure to get blur, (e.g., 1/15, 1/30, 
etc.) depending on the scene. 

Either pan with the subject or swipe 
(horizontal or vertical) the camera to achieve 
the desired effect. 

Practice makes perfect! 

Tripod Techniques 

 Capture Motion  

 Using Filters 

Long Exposure Creativity 
By Denise Silva (VA) 
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 Can expose to the right to reduce noise 

 Shutter Speed 

 Most DSLR max out at 30 sec, if you 
want longer shutter speeds, use Bulb 
feature 

 Will need a cable release with a lock-
ing feature when in Bulb mode 

 Mirror Lock-up (when not shooting with a 
mirror-less camera) to reduce camera 
movement  

 Turn off Noise Reduction feature in cam-
era 

 Low ISO 

How to… 

 Determine your exposure mode: 

 Shutter Priority 

 Aperture Priority 

 Manual 

 Determine your composition  

 Determine focal length to achieve the de-
sired depth of field (f/stop is generally set 
between f/8 to f/16) 

 Focus 

 If possible, use auto focus to get fo-
cused, then switch to manual focus - if 
your camera has an electronic view-
finder, this should be possible with the 
filter on 

 If you must focus manually, use focus 
peeking if you have it - focus first then 

 First determine what your shutter 
speed would be without the filter 

 Calculate the appropriate shutter 
speed with the filter - easiest way… 
download the app for that or carry a 
cheat-sheet 

 Trial and error 

Denise Silva 

(look for examples of  
Denise’s work on the following pages) 

Text and images © Denise Silva 

www.roadrunnerphotographytours.com 

www.meetup.com/road-runner-
photography-tours 

https://www.facebook.com/
RoadRunnerPhotographyTours 

carefully screw on the filter without 
changing the focal length  

 For stars you might consider setting 
to infinity and then back off slightly - 
each lens has its sweet spot.  Mount 
the camera on a sturdy tripod 

 Slow the Shutter Speed 

 Use filters to block light, forcing the 
shutter to remain open longer 

 Filters 

 ND Filters (3, 4, 6, 9, 10, or 15-stop) 
- buy 77mm and then get stepping 
rings 

 Graduated ND Filters - can be used 
to slow the shutter on a portion of 
the image 

 Polarizer - to remove glare in water 
or on rocks, also can be used to slow 
shutter by 1 or 2-stops 

 Hoya Red Intensifier Filter for night 
and star photography 

 Determine the correct exposure 

 Obtain an exposure reading without 
the filter (as above, with an electron-
ic viewfinder, this can often be done 
with the filter in place) 

 If this step is done without the filter, 
you will need to calculate the shutter 
speed 

 Adjust shutter speed as ambient 
light changes 

 Shutter speed when using a filter 

Denise Silva (VA) is a 

photographer, teacher, 

writer and tour leader 

who finds every aspect 

of photography 

rewarding.  She was the 

featured photographer 

in Photoshop User 

Magazine- “Who’s Who 

in the KelbyOne Community” article and has been 

recognized as one of the Top 200 Women 

Photographers Who Inspire by Nature Photo Guide.  

She leads tours through her tour company, Road 

Runner Photography Tours and looks forward to 

sharing her passion for photography with you. Denise 

will also be co-leading (with Geffrard Bourke) a hands-

on Photo Walk (pre registration is required) involving 

the use of Neutral Density Filters and is a Conference 

Speaker Image Reviewer.  

http://www.roadrunnerphotographytours.com
http://www.meetup.com/road-runner-photography-tours
http://www.meetup.com/road-runner-photography-tours
https://www.facebook.com/RoadRunnerPhotographyTours
https://www.facebook.com/RoadRunnerPhotographyTours
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Horizontal Swipes Examples:  Vertical Swipes Examples:  

1/30 sec at f/8, ISO 50 

1/30 sec at f/18, ISO 200 
1/15 sec at F/13, ISO 200 

Panning Examples:  

©  Denise Silva 

©  Denise Silva 

©  Denise Silva 

1/7 sec at f/11, ISO 200 

©  Denise Silva 

1/200 sec at f/6.3, ISO 500 

©  Denise Silva 

1 sec at f/8, ISO 200 

©  Denise Silva 

1/8 sec at f/6.4, ISO 200 

©  Denise Silva 
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Camera Movement Examples:  Long Exposure App and Cheat Sheet:  Using Filters Examples:  

1/4 sec at f/14, ISO 200 

©  Denise Silva 

127 sec at f/9.5, ISO 50 

©  Denise Silva 

1/8 sec at f/9, ISO 200 

©  Denise Silva 

1/4 sec at f/11, ISO 200 

©  Denise Silva 
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Taking Advantage of the Time of Day 

Examples:  

Night Photography Examples:  Image Stacking Examples:  

1/17 sec at f/2.2, ISO 800 

©  Denise Silva 

26 sec at f/22, ISO 200 

©  Denise Silva 

8.5 sec at f/22, ISO 200 

©  Denise Silva 

25 sec at f/7.1, ISO 400 

©  Denise Silva 

100 stacked images, each 4 

minutes exposures at f/4, ISO 

1250 

©  Denise Silva 

400 stacked images, each 10 

sec at f/4, ISO 2500 

©  Denise Silva 
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Create Motion – Lens Manipulation 

Examples:  

1/2 sec at f/9.5, ISO 320 

1/20 sec at f/11, ISO 250 

Photoshop Examples:  

Use Motion Blur and Layers/

Masks to blend 

©  Denise Silva ©  Denise Silva 

©  Denise Silva 
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Learn how to use your camera and shooting 
apps on your smartphone.  This informative ses-
sion covers how to use your native camera app to 
its fullest potential, various accessories that will 
enhance your phone photography, and five useful 
shooting apps.  Both iPhone and Android users 
will benefit from attending this presentation.   

you can join in the photograph when shooting on 
a tripod and/or reduce camera motion. 

Video modes for capturing live action video.  

A camera symbol with circular arrows will al-
low you to use either camera the front facing or 
screen-facing camera (used more for selfies). 

Native Camera 

Get to know your native 
camera functions. 

Treat your camera with 
the same care you treat your 
DSLR and lenses. Don’t just 
throw it in your purse, 
pocket, or camera bag, but 
have a case to protect it. 

Most smartphones have 
one lens, while newer iPh-
one models have two lenses 
allowing for shallow depth-
of-field and better low-light 
functions. 

A lightning symbol will 
allow you to add a flash to 
your photography. There 
are usually three modes: 
Auto, On and Off. 

You might find a built-in High Dynamic 
Range photography mode (or HDR), which al-
lows the user to extend tonal range within a 
scene.  For even more refined shadow and high-
light control, I recommend using a specific 
HDR shooting app discussed below. 

A self-timer (typically a circle with a clock 
face) allows you to delay the shutter release, so 

Capturing Photographs With Your Phone 
By Melissa M. Fraser (MA) 

Black and white camera mode 

©  Melissa Fraser 

HDR—High Dynamic Range 

©  Melissa Fraser 
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Some phones have a built-in panoramic func-
tion. A panoramic app will give you more flexibil-
ity in taking panoramic photographs (discussed 
below). 

 iPhone Specific Functions  

 Live Photo (three concentric circles on the top 
middle) which allows you to record 2 seconds of 
video before a still image is captured.  There are 
three creative post-editing functions: Loop, 
Bounce or Long Exposure.  

Video capabilities include regular mode, Time-
Lapse, and Slow-Mo. 

Portrait shooting mode allows you to utilize 
both cameras to create portrait or intimate land-
scape images with blurred backgrounds. 

Lenses 

There are many lenses on the market now, 
ranging from $9.99 to $249.00.  I would suggest 
starting with some of the cheaper ones before 
spending a lot of money, as I have had good re-
sults with some of the $9.99 lens options.  

The Ollo Clip is a mid-range priced all-in-one 
lens system.  For around $100.00, you can get a 
Fisheye, Super-Wide Angle, and a 15X Macro lens 
in one device that fits a specific model phone. The 
problem is you cannot have a case on the phone 
to fit the lenses, and if you change phone models, 
you might need to purchase a new Ollo Clip, as 
they are designed to fit snuggly on specific model 
phones. 

Lensbaby now sells a kit containing a wide an-
gle, fisheye, and macro lens for around $100.00. 

Camera Accessories 

Multiple camera accessories can aid in your 
smartphone photography: 

Tripod Mounts 

Gorillapod grips makes a small tripod that 
comes with an attachment mount for the 
smartphone allowing you to basically place 
your phone in any position to capture a stable 
image.  MeFOTO Sidekick 360 or Sidekick 
360Plus smartphone adapters (about $30.00) 
allow you to use your tripod with an Arca-Swiss 
style mount. There are also cheaper smaller tri-
pods you can find at local discount stores like 5 
and Below that give you a wide range of stabi-
lizing options.  Use a tripod with your 
smartphone in low light conditions and/or 
when photographing waterfalls. 

Panoramic 

©  Melissa Fraser 



Authors retain the rights to their articles which are published here with permission. 86 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

Moment lenses has created a system where 
you can invest in the lens series, sold separately 
for about $100.00 each for a Super Fisheye lens, 
Wide Angle lens, Tele portrait lens, and/or a 
Macro lens. These lenses fit into a specific case 
that you also purchase from Moment. The cases 
run $23.00-$99.00 (the $99.00 case is a battery 
back up case) and can be purchased each time 
you upgrade or change phone models. The ad-
vantage is that you can keep the lenses you in-
vested in and change out the case alone. 

My current favorite lens kit is a clip on, so it 
will fit multiple phone models with or without a 
case attached. Its called APEXEL 10-in-1 combo 
lens pack. You can swap out 10 lenses including a 
radial flow filter, flow filter, kaleidoscope 3 or 6, 
star filter, 0.63x wide angle, 15x macro, 198  
fisheye, 2x telephoto, and a CPL (circular polariz-
er) lens. I have found them listed for anywhere 
between $20-$65 online. 

Camera + 

Camera + is a $2.99 app available for iPad/
iPhone/Android smartphones that allows your 
camera to function more like your DSLR.  When 
you open the interface, there are two rows of con-
trols. The top row starts with the flash option, 
which can be on, off, or you can have a flashlight 
mode.  The flower symbol (2nd from the left on 
top) will allow you to have a zoom macro without 
losing pixels.  This is a great alternative if you 
want to shoot macro with your smartphone with-
out purchasing a separate macro lens.  If you have 
an iPhone with two lenses, a portrait mode is the 

Five Useful Apps 

DMD Panorama 

DMD Panorama is a free app for iPad/
iPhone/Android smartphones that allows you 
to take panoramic images, including a full 360  
pano. After you open the app, hold your camera 
vertically, the app will alert you if you are not 
vertical. It’s easy to start taking the image, 
simply tap anywhere to start. As you pan your 
phone to the left or right (pick one direction), 
the yin/yang symbols will come together as 
your image is stitched together. If you reach the 
desired length prior to the full 360  simply tap 
the screen to finish. If you go a full 360 , the 
app will stop the image for you.  

Once you’ve captured your image, it appears 
on your screen instantly as a full stitched pano-
ramic image. Tap anywhere on the image to 
view the menu bar at the bottom. Tap the cam-
era symbol at the far left to return to the shoot-
ing mode which also saves the image to your 
camera roll.  The trash can symbol will delete 
the image and send you back to the shooting 
mode. The rectangle with the upward facing 
arrow symbol will lead you to the app camera 
roll were you can email or make a movie of your 
image.  

Back in the camera shooting mode,  you can 
upgrade to high dynamic range panoramic 
($1.99) on the left hand side. You can turn the 
flash on or off (lightning symbol). The auto sun 
symbol will allow you to have the exposure on 
auto, locked or locked to begin with, which 
gives you greater control in your image making. 

Macro  lens 
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next symbol on the top (a bust icon).  The rectan-
gle symbol (2nd from the right on top) is for 
changing the format of the image capture from 
rectangle to square to panoramic. Finally, on the 
top right you can toggle between the forward and 
back facing cameras with the camera and circular 
arrow symbol.   

Slow Shutter Cam 

Slow Shutter Cam is a $1.99 app available for 
iPad/iPhone/Android smartphones that will ena-
ble you to adjust the shutter speed for low light 
and creative blur type images.  

When you open the app, you will see six func-
tions at the top of the screen. The far left symbol 
is for turning on or off the flash.  The next sym-
bol, an eye, is to give you a viewing window of the 
image to aid when using long exposures.  The 
next two symbols, AE and AF, are for auto expo-
sure and auto focus, which you can lock by tap-
ping each icon. The second from the right symbol 
will be present if you have two cameras and will 
show a W (for wide angle) or T (for telephoto).   

The top right allows you to toggle from the 
front to rear facing camera. To adjust your cap-
ture mode, tap the wheel on the bottom left of the 
screen. This will bring up the capture modes of 
Motion Blur, Light Trail, or Low Light where you 

On the right side of the image capture 
screen, you will see the zoom slider, which will 
result in lost pixels if you zoom in.  There is also 
the auto exposure button just below the zoom 
slider.  To have more control over exposure and 
focus, tap on the image capture screen, and you 
will see a purple box with a plus in the upper 
right corner. This will allow you to focus the 
image, and you can toggle the brightness with 
the EV (exposure value) tick marks at the bot-
tom of the image.  

To play with both focus and brightness, sim-
ultaneously tap two fingers anywhere on the 
screen and two types of adjustments will ap-
pear: one for exposure (orange) and one for 
focus (purple). You will also now see three 
symbols below the image. The left square sym-
bol allows you to manually control the focus. 
The center aperture symbol allows you to ad-
just the shutter speed. To the far right, you’ll 
find the white balance, which you can alter de-
pending on your photographic situation.  
Leave it on auto, or switch to cloudy, daylight, 
fluorescent etc.  

The shutter release is the round button at 
the very bottom center of the screen.  Tap the 
plus to the right of the shutter release to reveal 
several shooting modes such as timer, stabi-
lizer, normal, burst or smile (for portraits). 
You will also find a RAW shooting mode here. 
The flower symbol to the far left at the bottom 
is the app camera roll. This app will automati-
cally save your images within the app and not 
to your native camera roll. To enable saving to 
the phone’s camera roll, tap on the three bullet 
lines at the bottom far right of the interface. 
Scroll down to general settings and find save. 
Click on save to enter the screen and enable 
saving the images to your camera roll.  

Portait Mode 

©  Melissa Fraser 

Slow Shutter App 

©  Melissa Fraser 



Authors retain the rights to their articles which are published here with permission. 88 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

can alter things like shutter speed, ISO, Blur 
Strength (Motion Blur), Light Sensitivity (Light 
Trail), and Noise Reduction (Low Light).  Tap the 
numbers again to go back into shooting mode.  

The shutter is located at the bottom of the 
screen in the center. The three bullet point icon 
on the far right bottom of the screen allows you to 
access a self timer, intervalometer, adjust the im-
age resolution, format size, auto lock features, 
and shutter volume. Once you have taken an im-
age, three options will appear: clear, edit , and 
save. Clearing the image will return you to the 
shooting mode and delete the image. Edit will 
open several editing tabs including exposure, 
brightness, contrast, saturation, and hue. To exit 
without saving edits, click done at the top left or 
save edits by tapping the top right save.  If you 
want to save an image without doing any edits in 
the app, tap save, which will save the image to the 
camera roll.  

Open the app to see the shooting interface.  At 
the top you will see four symbols.  The far left is 
to turn on, off, or have a constant flash (torch). 
The second Symbol is to have a manual or auto 
HDR function. Auto HDR will assess the scene 
and make its own decisions about the light levels. 
Manual HDR will put three boxes on the screen, 
which you will move to three different light 

Average Camera Pro and Superburst 

Average Camera Pro is a $0.99 app available 
for iPad/iPhone, while Superburst is an An-
droid equivalent selling for $1.99. These two 
apps are for taking multiple images that you 
can overlay to create impressionistic images. 
When you launch the app, the shooting inter-
face appears and the controls are on the bottom 
of the screen. The far left allows you to lock in 
the exposure, focus, and 
white balance for the image 
you are shooting. Tap to 
turn on and off.  

The camera symbol is 
your shutter release for tak-
ing the image. To the right 
of the camera symbol is a 
number that looks like a 
date.  Tap to reveal the 
number of pictures, shoot-
ing interval between photos, 
and the pre-start timer.  Tap 
the three numbers at the 
bottom to return to the 
shooting mode. The far 
right settings will open the 
app settings. 

Pro HDR X 

Pro HDR X is a $1.99 
app available for iPad/
iPhone/Android 
smartphones and is dedicat-
ed to taking high dynamic 
range images. This is useful 
in situations where you have 
a wide range of lighting in 
one composition.  

Multiple Exposure App 
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sources on the scene. The third from the left is the 
grid, which will allow you to see a grid on your 
image to work with composition of your photo-
graph.  The far left top symbol is a camera with 
circular arrows allowing you to toggle between 
the front and back camera.  

The bottom of the app interface has three sym-
bols.  The middle circle is the shutter release, and 
you use this to take your image. Once you take the 
image using a tripod or holding as still as you can, 
the interface will come up where you can adjust 
the HDR, brightness, or contrast (the sun symbol 
to the left).  Color, hue, and saturation can be ad-
justed with the three-circle symbol in the middle. 
Cropping, adding a filter, frame, or text can be 
done clicking on the plus symbol to the far left. 
Once you are satisfied with your image, tap the 
floppy disk image or the square with the upward 
arrow. Both will allow you to save to the camera 
roll. The camera symbol will take you back to 
shooting mode.  
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Melissa Fraser (MA) started her 

adventures in photography at the 

age of 11 when a walk through a 

photography gallery inspired her 

to take the family camera and try 

capturing images like the ones 

displayed. Upon seeing the 

developed film, her camera 

became a constant in her life, 

photographing everything at 

every opportunity.  Her new 

passion with Smartphone 

photography has led her to teaching workshops. 

Melissa will also be co-leading (with Charles Needle) 

a hands-on Smartphone Photo Walk (pre registration 

is required.)  
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During this session, we will explore editing 
apps for your phone.  While I’m an iPhone 7Plus 
user, I will discuss apps that are universal to all 
smartphones, with the exception of Distressed FX 
(but I will recommend an alternative for Android 
users).  

AppCrawlr.com is a great resource to find 
apps, read reviews on apps, and find equivalent 
apps for iPhone and Android phones. 

Typically, all editing apps will ask you if you 
want to use the native camera or choose from 
your camera roll when loading an image. I always 
choose the latter option and load an image from 
my camera roll. I recommend first, you capture 
images with either your native camera or one of 
the specialized shooting apps I discuss in my 
other NECCC presentation entitled Capturing 
Photographs with your Phone and then load the 
images into one (or a combination of) editing  
app(s) discussed below. 

Tips for Getting Started 

There are tons of apps available! Choosing 
which one to use can be a bit overwhelming. I 
suggest picking one or two apps, then learn how 
to use them and decide how you feel before 
buying or downloading multiple apps.  

original image. If an app is altering the original 
image, a second window will pop up as a safety to 
ask you if you really want to alter the original. 
Your original images are safe and preserved on 
your camera roll, so let your creativity flow. 

Read Reviews 

These are helpful for deciding if you want to 
check out an app.  People are generally not shy 
if they hate something or love something. 
Reviews can be found where you download 
apps, appcrawlr.com, and, of course, our good 
friend, Google.  

Start With A Free App 

If you hate it, delete it!  

Attend a Workshop 

Creative smartphone 
workshops are a great place 
to learn in a more hands-on 
environment. You will learn 
about using your 
smartphone for 
photography while 
sharpening your eye for all 
photography at the same 
time.  And there’s the added 
benefit of learning about 
new apps from other 
participants. 

Don’t Be Afraid To Play 

Most apps are not going 
to damage or alter your 

Editing Apps for Your Phone 
By Melissa Fraser (MA) 
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Try Multiple Apps 

You can make some amazing artistic photos by 
combining multiple post-capture editing apps in 
a single image. 

Snapseed 

Snapseed is a free editing app for iPad/
iPhone/Android smartphones. It is an essential 
tool and gives you the power of Photoshop-like 
editing at the tip of your fingers. Open the app to 
the interface and you can tap anywhere to add a 
photo or tap the word Open at the top left of the 
screen.  You can open an image from the device 
(camera roll), open the last image, or paste an 
image (if you have one copied on the clipboard).  

you to the starting interface where you can 
choose another tool.  

The various tools are listed below: 

Tune Image: Adjust br ightness, 
saturation, contrast, etc.  

Details: Adjust structure and details 
(for a sharpening effect) 

Curves: Similar  to curves in Photoshop 

White Balance: Adjust w hite balance 

Crop: Free crop or  constrain im age 

Rotate: Rotate im age 

Perspective: Adjust im age angle to 
correct keystone 

Expand: Expand image edge w ith 
content aware fill 

Selective: Selectively adjust brightness, 
contrast, and saturation 

Brush: Selectively adjust exposure, 
temperature, and saturation 

Healing: Selectively rem ove spots, 
unwanted items 

HDR Scape: Add HDR look 

Glamour Glow: Add a glow  effect to 
your image 

Tonal Contrast: Adjust tonal contrast 

Drama: Filters to m ake your  im age look 
more dramatic 

Vintage: Filters to give your  im age an 
old film style look 

Grainy Film: Filters that alter  the grain 
strengths in your image 

The top right hand side has three dots, by 
tapping this icon, you can access Snapseed 
tutorials, which contains a wealth of 
information on how to use the tools within 
Snapseed. 

Once you have your chosen image opened, 
there are three main tabs at the bottom of the 
screen: Looks, Tools, and Export. Looks opens 
automatically and you can scroll to the right 
choosing a preset look.  When you click on a 
look, an X and a  will appear. Tap the X to 
remove the effect or look and return to the 
original image, or the  if you would like to 
keep the look applied to your photo. If you have 
made edits in the tools section (next tab) a + 
symbol will appear at the end of the looks. By 
tapping the + , you can save all of your current 
edits as a new preset look to the bar.   

The middle tab on the bottom of the 
interface is the Tools tab. Tap Tools to reveal 
the Snapseed tool bar which has a list of 28 
tools used to work with your photo. Tap on 
each tool to make adjustments to your image. 
Each tool will add a new layer to the image 
building on each other as you save the changes. 
When you open a tool, the X will allow you to 
leave that tool interface deleting any changes 
you saw in that tool, the sliders allows you to 
see what adjustments are available in that tool 
(you can also move your finger up and down to 
reveal the tools’ various adjustments).  Once in 
a particular adjustment, which will show at the 
very top of the image, slide you finger left to 
right to alter the effect. The small square at the 
top right hand of the photo shows you before 
and after your current adjustment.  The check 
mark to the far right of the bottom of the image 
will save the current adjustments and return 

Snapseed 
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Retrolux: Filters to give your  im age old 
film style look 

Grunge: Preset Filters that give your  
image a weathered look 

Black and White: Change im age to black 
and white 

Noir: Convert image to a high-contrast 
black and white (can mimic the look of infrared) 

Portrait: Enhance people im ages 

Head Pose: Adjust the head angle, sm ile 
of portrait 

Lens Blur: Add lens blur  to im age 

Vignette: Add dark or  light vignette to 
image 

Double Exposure: Creative im age 
blending 

Text: Add text to image 

Frames: Add a frame or  border  to im age  

To see the layers of your work, in the main 
interface (where you can see looks, tools, and 
export) tap the two squares with the arrow on top 
icon and then tap view edits.  The list of edited 
layers (or each tool you used) will pop up here. By 
tapping on the layer twice you will see a trash can 
symbol (to remove that layer only), a paintbrush 
symbol (which allows you to mask parts of the 
image to give you greater control over where that 
particular tool/effect is present), and the slider 
icon (to be able to go back into that layer and 
make further adjustments).  The backward arrow 
at the top left will take you back to the home 
interface. 

Once you’re satisfied with your image, tap the 
export icon on the far bottom right. Simply saving 

the editing mode with a preloaded image of a 
barn.   

Click the top left camera icon to load image 
from your camera roll and constrain (crop image) 
to the desired size.  The teardrop icon in the lower 
left of the image allows you to add a radial blur to 
the image.  The middle bird icon allows you to 
add in a variety of birds (some free, some for in-
app purchase) and you can adjust the opacity of 
the birds with the sliders. You can move the birds 
around on the image and adjust the size a limited 
amount by pinching two fingers together or apart 
on the screen to adjust. The three-slider icon on 
the bottom right of the image allows you to alter 
brightness, contrast and saturation of the image.   

the image will make permanent “baked-in” 
changes to your original image (the app will ask 
you again if you are sure you want to do this), 
save a copy will save a copy of your image with 
all the data on the various layers intact. Export 
will save a new image, the original image will 
remain preserved, but it will flatten the layers 
and you will lose the layer data.  I don’t 
recommend you choose the first Save option, 
unless you don’t want to preserve your original. 

Distressed FX 

Distressed FX is a $0.99 editing app for iPad 
and iPhone.  Afterlight, also $0.99, is an 
alternative for Android users.  The app opens to 

Distressed FX 
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At the bottom of the image, there are two rows 
of image overlays. You can add one for either row 
or two (one from each row) to your image. This 
part is trial and error, and coming up with your 
own workflow is key. I usually start with the top 
row until I find one pleasing addition and then I 
add in the second row to see if the second filter 
enhances my image.   

The toolbox icon allows you to see other sets of 
filters. Several are free, and some are in-app 
purchases. The last icon on the bottom row of 
filters allows you to overlay a second image, 
essentially allowing you to make a custom filter.  
You will only be allowed to overlay the image; you 
cannot adjust the new image at all. The square 
with the upward arrow icon in the top right 
allows you to save the image to the camera roll. 

#sunsetoncapecod #beachsunset.  You can use 
any combination you want; however, the more 
obscure and less common, the lower the chances 
it will be found. You can even start your own hash 
tag like #melissamfraserphotography.  There are 
no limits to the hash tag world!  

Once you are satisfied with your photo and 
your caption/#hashtags, tap the share button (in 
the upper right corner) to publish your photo. 

Glaze 

Glaze is a free painterly effect-editing app for 
iPad and iPhone.  Photo painter (also free) is an 
Android alternative to Glaze. Opening the app 
launches the interface.  

This adds a new image to the camera roll, 
preserving the original image.  

Instagram 

Instagram is a popular free shooting and 
editing app that allows you to publish and 
promote photography.  It is available for iPad/
iPhone/other smartphones, such as the 
Android and Samsung models. This app allows 
you to both edit your photos and publish them.  
You can think of it as Facebook for your photos, 
and much like Facebook, you have a profile, 
followers (people who see your images) and 
those whom you are following (you see their 
published images on your home scroll wall).  

First, download the free app and create your 
account.  I suggest you leave it on a public 
setting so that your photographs can be viewed 
by anyone, this will allow you to be discovered.  

When you open the app you will load a 
photograph first by clicking the + tab in the 
middle bottom of the screen. You can either 
leave the photograph unedited (perhaps you 
edited it a different app and it needs no further 
adjustments), or you can use the presets filters 
(on the left bottom) to enhance your photos 
and/or edit specific aspects of your photo using 
the edit function (on the right bottom).  Once 
you are satisfied with the photo and are ready 
to publish, hit next (upper right corner) and 
write your caption.   

This is also the place where you would put in 
your #hashtags.  Hash tags are a way of getting 
your photo categorized on Instagram and a way 
for people to find your photo without knowing 
who you are. For instance, for a sunset on Cape 
Cod, you could use the hash tag #sunset 

Instagram 
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To open an image, tap the mountain photo 
icon on the bottom left corner. Once an image is 
open, you tap the painterly effects on the bottom 
row (Scroll right for more effects. Some are in app 
purchases.).  The ? tab gives you a review of what 
the icons are in case you forgot, The star icon *  
(third icon from left) shows you and lets you buy 
app add-ons.  You will notice they are not all 
available until you purchase the upgrade.   

The rectangle with the arrow is for saving your 
image.  I use the highest resolution for saving. It 
might give you a warning that the app will crash, 
but I have never had it crash to date. The gallery 
save option is saving the image to your camera 
roll, and the original image is preserved and will 
not be altered. The hammer and wrench icon 
allows you to combine painterly effects to create a 
completely new look. 

Return to the house icon the far left (near the 
bottom) to save the image to the camera roll.  

Waterlogue 

Waterlogue is a $2.99 app available for iPad/
iPhone/Android smartphones.  It is an app that 
makes a watercolor image from your photograph. 
When you open the app, tap the camera symbol 
on the bottom left to open your camera roll and 
load an image.   

Once the desired photo is loaded, tap the icons 
on the bottom of the interface to choose which 
watercolor effect you prefer. As you scroll to the 
right, you will find the gradient adjustment tool 
to change the brush strokes of your painting.  Tap 

Impresso 

Impresso is a $2.99 app available for iPad/
iPhone/Android smartphones. It is an app that 
allows you to add a painterly effect to your 
photograph. When you open the app, you will 
see a grey interface with 6 icons located near 
the bottom. The house icon (lower left) will 
allow you to load an image (get photo). This is 
also the icon that will allow you to crop (both 
before you add effects and after) as well as save 
the image to the camera roll, again preserving 
the original image.  

Once you load an image, tap the star icon 
(next to the house icon).  This will take you to 
two levels of painting effects. You tap the 
various paint effects in either the All Prima or 
En Plein Air tabs (located above the painterly 
effects).  To get a completely different look by 
mixing styles you tap the two dice icon in the 
upper right hand corner, this will mix and 
match styles randomly.  

The paintbrush icon (3rd from left near the 
bottom) allows you to adjust the paintbrush 
size, color enhancing, and painted edge 
(border) using the sliders beside each. The 
frame icon (4th from the left near the bottom) 
allows you to switch between canvas or linen 
style paintings as well as the strength of the 
effect that is shown on your image.  The paper 
pad icon (2nd from the right near the bottom) 
allows you to alter the artistic finish on your 
image using a slider to vary the effect. And the 
oval icon to the far right (near the bottom) 
allows you to adjust the details by altering the 
brush size in selected areas.  

Impresso 
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the auto adjustment symbol to reveal brightness 
adjustments for your painting.  

Finally, add a border with the border icon to 
the far right. The rectangle with the upward 
arrow to the far right allows you to save the 
watercolor image (save to photos) as a new image 
in your camera roll, preserving your original in 
the camera roll.  

Color Splash 

Color Splash is a $0.99 app available for iPad/
iPhone/Android smartphones.  This app will 
remove all the color from your photograph and 
allow you to selectively paint back color in desired 
places.  

The app opens to a load image page.  You have 
several options: resume last session, load a saved 
session, or load a photo (will take you to your 
camera roll) are the ones I most frequently use. 

Saving the image option will save a new image to 
your camera roll, preserving the original image.  

Saving a session will save where you are within 
the app (no image will be added to your camera 
roll), so you can return at a later date and finish 
your edits. You can also invert what you have 
done with the invert color/grey tab.   

The ? icon (second from left at top) will lead 
you to the tutorial section of the app. The red 
headshot icon (top 3rd from left) will allow you to 
see the area you have selected in a bold red color 
(like viewing selective areas on a layer mask in 
Photoshop).  The three bars with sliders icon (top 
4th from left) gives you options for adjusting 
various aspects of the image, from brightness and 
contrast to color hue.  The paintbrush icon (top 
2nd from the right) allows you to control the 
strength of the color that you are painting with 4 
level of opacity (large circles) and the size of your 
brush (slider bar).  The backward circle icon (top 
far right) allows you to remove the last brush 
stroke you made.  

Melissa Fraser 

Text and images © Melissa Fraser 

(see Melissa’s bio at the end of the  
immediately preceding article) 

www.Melissamfraserphotography.com 

frasermm42@verizon.net 

https://www.facebook.com/
HiddenHeartMessages/ 

https://www.instagram.com/frasermm42/ 

 

Choose the option that best suits your needs.  
The image will be loaded into the app interface 
and all the color will be removed. The 
pan+zoom icon on the bottom left will allow 
you to magnify the image (using the two finger 
pinch) and navigate around the photo. This is 
an important tool for detailed work.   

The color icon (middle) will add back the 
color to wherever you place your finger or 
stylus.  The grey icon (bottom right) will 
remove color in areas where you accidentally 
added color. The top row of icons are for 
saving, fine tuning your image. The three-bullet 
point icon (top left) takes you back to load a 
new image, save an image or save a session.  
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One of the great things about Lightroom is 
that you can also use Lightroom on your mobile 
devices such as an iPhone, iPad (or Android 
phone or tablet).  Editing is surprisingly easy and 
many of the edits that you are accustomed to us-
ing already in Lightroom on your desktop com-
puter are found in Lightroom Mobile although 
the layout may be a bit different than what you 
are used to.  I particularly like the fact that when 
using Lightroom Mobile you can sync images in 
your collections from your Lightroom desktop 
app on your computer with the Lightroom app on 
your mobile device.  It’s easy to keep it updated 
with new images and I often use it to show clients 
and friends my images instead of directing them 
to my website. 

Lightroom Mobile makes it easy to share im-
ages on social media. You can even do further ed-
iting on your images by saving them to your cam-
era roll which I often do as I love using Google’s 
Snapseed and other creative editing apps on my 
iPhone. You can even do a slideshow right from 
your mobile device. If you have Apple TV, it 
works with that, too. 

Summary of Things You Can Do with 

Lightroom Mobile 

 Capture photos using the Lightroom cam-
era app (which is excellent!) 

puter and either a trial membership or paid sub-
scription with Adobe for the Creative Cloud.  
Lightroom works with either Lightroom Classic 
or the cloud-based version of the software.   

Set Up Your Mobile Device (Phone or  
Tablet) 

You will also need to download Lightroom CC 
on your mobile device (phone or tablet) as indi-
cated below. This is a free app. 

 App store (Apple) for iPad 

 App store (Apple) for iPhone 

 Android App on Google play 

Once you download and install the app on 
your device, you will need to open the app and 
sign into your Adobe account with your user 
name and password.  You will also need to make 
sure you are signed into your account in Light-
room on your desktop computer (see below). 

On Your Desktop Computer 

Launch Lightroom and make sure you have an 
internet connection. 

If you are not already signed in, you will need 
to click on Help>Sign in>Sign in now> and then 
enter your Adobe ID and password or you can 
click “Get Started with Lightroom CC” which is 
found in the upper left hand corner of Lightroom 

 Upload images to social media such as 
Instagram, Facebook, etc directly from 
Lightroom Mobile 

 Edit and sync edits with the images on 
your desktop computer 

 Review and sort images on your device 
“on the go” by using star ratings, etc. 

 Convenience of having your images with 
you on your phone similar to a website 
that you would show clients and friends 

 Can do slideshows right from your de-
vice 

 Works with Apple TV where you can 
view images and videos - great for fami-
ly gatherings and other events 

 Saving images from Lightroom Mobile 
to your camera roll allows you to do fur-
ther editing with your favorite apps on 
your mobile phone (such as Snapseed!). 

Getting Started 

Important note: In order  to sync your  
collections with images with Lightroom for the 
desktop and CC (web) you will need an Adobe 
Creative Cloud membership subscription.  

To get started, you will need a recent version 
of Lightroom installed on your desktop com-

Introduction to Using Lightroom Mobile  
By Betty Wiley (MA) 
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and then sign in with your Adobe 
User ID and password from 
there. 

After signing in, click on your 
user name which should now be 
visible in the upper left hand cor-
ner and make sure that “Syncing 
with Lightroom CC” is turned on. 

Next, you will determine 
which collections you want to 
sync by clicking to highlight the 
collection name and right clicking 
to select the option “Sync with 
Lightroom CC”. You will notice a 
sync symbol (looks almost like a 
double sided arrow icon) next to 
the collection once you’ve done 
this step. 

It’s important to note that you 
determine what collections you 
sync with your mobile device 
from your desktop.  Images must 
FIRST be in a placed in a collec-
tion on your desktop computer 
and then you select the individual 
collections that you want to sync 
with Lightroom Mobile on your 
device. 

To place images inside a col-
lection in Lightroom on your desktop computer, 
you can simply drag and drop images from the 
Lightroom filmstrip at the bottom into the de-
sired collection. 

Note: You can only sync images with one cata-
log and therefore, if you work with more than one 
catalog (generally not recommended), you will 

need to determine which catalog 
you want to sync. 

Lightroom Mobile  

Interface 

Next to “All Photos” and the al-
bum names you will see three 
dots. If you tap on the dots, you 
have a number of options includ-
ing the ability to add photos, de-
lete photos, move to, delete, etc.  
As you can see, you can add pho-
tos to a particular album, rename 
an album, move or delete an al-
bum.  If you select “Present” 
shown at the bottom of the list, 
you can do a slideshow style 
presentation which you can show 
to clients, family and friends.  
Pretty cool!  I will often take an 
image using my iPhone and then I 
will add that image to an album 
using the “add photos” option 
from the list. 

Capturing Images from 

Lightroom Mobile Using 

the Camera App 

Lightroom has a built-in camera feature which 
is surprisingly good.  At the bottom of these notes 
where I have provided links, I’ve included a link 
which details how to set this up for easy and 
quick access without having to launch the app on 
your phone.  

At the top left, you will see “LR” which stands for Lightroom. 

If you tap on the “LR,”  you can access your settings and ac-

count information.  On the top right, you will also see a cloud 

icon which shows the sync status.  Below that, you will see 

“All Photos” which are all the photos in Lightroom Mobile. 

Note that “All Photos” shows all of your images and does not 

separate photos according to the collections/albums they are 

in.  Albums (note that collections are referred to as albums in 

Lightroom Mobile) are listed individually below “All Photos.”  
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under Preferences>Lightroom Mobile>Location.  
If you take an image with your iPhone’s native 
camera instead of the Lightroom camera, you 
need to manually add this image to Lightroom 
Mobile for the image to be placed in the location 
on your desktop computer that you designated 
under Preferences>Lightroom Mobile>location.  

To add photos to Lightroom (from your cam-
era roll for instance) in Lightroom Mobile, click 
on the three dots next to  “All Photos” or next to 
the album you want to add the images to and se-
lect “Add Photos” and then navigate to the loca-

Features of the Lightroom Mobile Camera 
App 

In the camera app, you can choose to take 
images using the HDR  (High Dynamic Range) 
feature, or the pro setting or simply use Auto.  

One of the features that I really appreciate is 
the ability to use the built-in level to ensure 
that my horizons aren’t crooked.  You can also 
select a grid overlay to help with composing 
your image. 

You also have the ability to select a wide-
angle or telephoto lens.   

You can chose to shoot in jpeg or DNG raw 
format. 

You can select a variety of filters to be ap-
plied to your images during capture. 

There is a built-in timer and you can even 
geo-tag your photos. You can change/chose the 
aspect ratio if desired to square or use other 
aspect ratios that you prefer. 

Working between Lightroom Mobile 

and Lightroom on your Desktop 

Photos and collections that you add from 
Lightroom Mobile are automatically added to 
Lightroom on your desktop. However, you will 
first need to designate the desired location on 
your desktop by going to Prefer-
ences>Lightroom Mobile>Location in Light-
room Desktop on your computer.  This means 
that if you take an image with your iPhone and 
add it to Lightroom, in addition to the image 
being on your camera roll on your mobile de-
vice, this image will also be added/stored on 
your desktop in the location that you specified 

Adding photos to either All Photos or 

to an album in Lightroom Mobile. 

©  Betty Wiley 
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you want and then tap on the check mark to ac-
cept or the “x” to cancel.  You can continue edit-
ing if you wish.  Note that presets are arranged in 
categories, a feature that is often overlooked by 
many.  In addition to “color,” you can also select 
“creative” for some unique looks, or various black 
and white options.  To access the various other 
preset options, click on the downward facing ar-

tion where the image is located (in this case, 
I’ve chosen to add an image from my camera 
roll on my iPhone).   Once the photo is selected 
you will see a check mark as shown in the 
screenshot. Then tap on “Add 1 Photo” at the 
bottom to finish.  You can add one photo or 
multiple photos by just tapping the image(s) to 
select them. 

Editing Images in Lightroom Mobile 

Note that all edits/changes you make to your 
images are synced with the images in Light-
room on the desktop computer.  Similarly, 
changes you make to images from your desktop 
are reflected on the image on your 
mobile device. 

To edit images, in the upper left 
hand corner of the app you should 
see the word “edit.” If you don’t 
see the word “edit,” tap on the 
downward facing triangle to select 
“edit” from the available options. 

At the bottom, you can select 
the type of edits you want to apply 
to the image.  For instance, you 
can apply selective edits, crop, ad-
just the lightness or darkness or 
an image (i.e., exposure), affect 
white balance, etc. just by tapping 
to select the option you want and 
then by moving the sliders.  One of 
the features I like to experiment 
with are the various presets. By 
tapping on “Presets” at the bot-
tom, a variety of looks, or presets 
are shown.  You click on the one 
that gets you closest to the look 

Tap or click on a photo to open it and then select the type 

of edit you want to apply from the menu choices at the 

bottom.  You can crop, adjust exposure, add contrast or 

apply presets and then move the sliders back and forth to 

get the look you want. 
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row next to the word “color” to reveal the other 
choices that are available. 

At the time that these notes were being pre-
pared, Adobe just released an update to Light-
room Mobile adding some great new editing fea-
tures such as the ability to select a particular cam-
era profile, along with a new feature called 
“geometry” for correcting perspective. These are 
found at the bottom of the editing screen along 
with the other editing features. 

Reviewing, Keywording and Sorting 

Images  

You can rate images using star ratings by se-
lecting “rate and review” from the downward fac-
ing carrot using the drop down menu next to the 
word “Edit” in the upper left hand corner.  You 
can also flag or reject images by tapping on the 
appropriate flag on the right hand side (Stars for 
rating is on the left) above the filmstrip. Ratings 
and attributes that you assign are then synced 
with the image on your desktop computer. 

In addition, you can add keywords, however at 
the time these notes were written, keywords that 
are added from within Lightroom Mobile are 
NOT synced with the desktop version of Light-
room if you are using Lightroom Classic. 

Sharing Images and Saving Images to 

Camera Roll 

Tap the share icon as shown in the screenshot 
to the right.  You can then select the various op-
tions available on your mobile device. 

©  Betty Wiley 

©  Betty Wiley 
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If you wish to save an image to your device’s 
camera roll, simply click on the share icon and 
chose “save to camera roll.”  I often do this with 
an image that I’ve edited using Lightroom and if I 
want to do further editing on my iPhone using 
one of my favorite apps such as Snapseed by 
Google.  One cautionary note however is that a 
full-sized image is not saved to your device – 
however, for most purposes, the size is suitable 
for emailing and sharing on social media, etc. 

Betty Wiley 

Text and images © Betty Wiley 

www.bettywileyphotography.com 

 Useful links: 

https://helpx.adobe.com/lightroom-
cc/how-to/lightroom-mobile.html 

https://helpx.adobe.com/mobile-
apps/help/lightroom-mobile-faq.html 

https://blogs.adobe.com/jkost/
lightroom-mobile-video-tutorials 

https://helpx.adobe.com/lightroom/
how-to/sync-photos-lightroom-
mobile.html 

Below is a very helpful link describing 
how to quickly access the Lightroom 
camera feature in Lightroom Mobile 
WITHOUT having to launch the app: 

http://blogs.adobe.com/
jkost/2016/11/quick-access-to-the-
lightroom-mobile-camera-on-ios.html 
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Layers 

One of the intermediate functions that you can 
perform in Photoshop involves making part or 
much of a layer transparent.  

This is quintessential Photoshop: those 
collages that have several elements fading into 
each another, or have a subject fading into the 
background. We’ve all seen them, and lusted after 
the ability to do that ourselves. Fortunately, it’s 
easy once you know how. 

Layer Masks 

Layer Masks allow you to control the opacity 
of each layer and each pixel in that layer 
separately, with up to 256 levels of transparency. 
That means you can fade one layer into another 
in your final image very easily. 

By default, your Layer Mask appears in all 
white meaning the layer will be completely visible 
as though you’ve done nothing. If you want to just 
see a small part of the layer, you may want to hold 
down the alt or option key when you click on the 
new Layer Mask icon and then your Layer Mask 
will be filled with black making your entire layer 
completely transparent. 

Using Layer Masks is a non-destructive way to 
(temporarily) erase part of your layer. To make 
part of your layer transparent, simply paint the 

Layer Mask with black. To restore any part of 
your layer’s visibility, simply paint the Layer 
Mask with white. 

The Gradient tool is very useful for making 
smooth transitions between transparency and 
opaque in a layer mask. (You can see the gradient 
in the Layer Mask at left.) Simply use a black to 
white gradient and run it any distance. The black 
edge will be completely transparent and the white 
edge will be opaque with a smooth increase along 
the gradient. 

Okay, so enough theory.  

How Do You Use Layer Masks? 

First make one. Choose a layer that has lots on 
it. (This will make the effect easier to see.)  Also 
make sure you aren’t trying to put a Layer Mask 
on a Background layer. Remember, you cannot 
have transparent pixels on a Background layer, 
and the whole point of a Layer Mask is to make 
pixels on the layer you choose transparent 
according to your orders. 

Go to the layers palette and look down at the 
bottom. Next to the new layer icon, on its left, is a 
little square icon with a circular pattern in the 
middle. This is the icon for making a new Layer 
Mask. With your target layer active, click on the 
Add Layer Mask icon. You will see a new little 
thumbnail next to the layer’s thumbnail, and they 

Getting Acquainted with the Power of Layers  
By Ella Carlson (MA) 

On the bottom of the layers palette, you will find a small 

icon that’s a square with a circle in the center.  

It’s between the FX for Layer Styles and the diagonally split 

circle for Adjustment Layers. While on a layer that’s not a 

background layer, you’ll be able to click on the icon and add 

an extra thumbnail to your current layer.  

You can add a Layer Mask using the  

Layers pulldown menu as well.  
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will be connected by that 
little chain again. This means 
they are linked. Generally 
that’s what you want 99 per 
cent of the time. 

Okay, now click on the 
Layer Mask thumbnail again, 
so that you are painting on 
the Layer Mask, not the layer 
itself. 

You will notice that your 
foreground and background 
color swatches are now in 
black and white, or shades of 
gray. Hit the letter “D” to get 
your default colors (black 
and white). “X” switches the 
foreground and background 
colors. 

The most common way to 
use a Layer Mask is to use a 
Gradient.  After creating a 
Layer Mask: 

1) Double click on your 
Gradient tool to get its 
options. 

2) Make sure it’s set to 100 percent opacity, 
foreground to background, Normal blending 
mode. Dither should also be checked. (This keeps 
your gradients from banding during the printing 
process, so it’s a good box to keep checked.) 

3) Make sure that black is your foreground 
color and white is your background color. 

4) Now drag a gradient from the top to the 
bottom of your Layer Mask, or left to right, or 
right to left. 

Apply makes the changes permanent. 
Transparent pixels will be erased. 

Cancel lets you delay the decision.  

Discard gets rid of the layer mask 
without any affect on the original 
layer. 

Don’t forget you can then apply 
another Layer Mask to the same layer 
if you like. Also, don’t forget that the 
Gradient tool is just one of the 
painting tools at your disposal. You 
can also use the airbrush, paint 
brush, etc. 

Layer Styles 

Layer Styles give you an easy way to 
add drop shadows, outer glows, 
beveling and embossing or change 
the color or texture of a layer as well 
as putting a stroke around whatever 

is in the layer. 

Layer Styles are fun and if you find 
you like a particular style or will be 
using it over and over, you can save 
it in your layer styles palette. Just 

click the New Style button to save any style you’ve 
made. 

You must click on the layer style’s Name to 
have the options for that Layer Style available. 
You can add default Layer Styles by just clicking 
on the box in front of the name. 

And just because a Layer Style says Outer 
Glow, that doesn’t mean you can’t make it an 
Outer Shadow. You just have to adjust the 

You’ll notice that where your Layer Mask is 
painted black, your layer has now disappeared. 
Where the layer mask is white, your image is 
still opaque. 

Now to make the change in opacity 
permanent, drag the Layer Mask thumbnail 
into the layers palette trash can. You will get a 
dialog box asking if you want to Apply, Cancel, 
or Discard. 

You have to be careful to note whether you are working on the layer or working on the Layer Mask.   

Whichever one you are working on will have the second border around it. Just click on the thumbnail of 

the layer or the Layer Mask to change the one you’re working on. 
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options. That particular change involves 
changing Screen to Multiply. 

Using More Than One Layer 

Style 

Once you apply any layer effect, you 
have a little “f” in a circle on the layer to 
indicate the effect’s presence. To add more 
layer effects, or change the one(s) that are 
there, simply click on this “f” to get the 
layer effects dialog box. 

You can then use the drop-down menu 
(now showing “Drop Shadow”) to choose 
any other layer effect to add. You can also 
delete any layer effect by simply 
unchecking the box next to the drop-down 
menu. 

Global Effects 

The “Use Global Angle” command in 
the layer effects means that the layer 
effects will be consistently applied throughout the 
layers. What does this mean? Think of layers 
using global effects as a bunch separate objects all 
photographed from the same angle. The sun is to 
the left, and up 45 degrees for example as you 
photograph the first item, and each item 
thereafter.  If you re-photograph any item from a 
different angle, then all the items are 
automatically re-photographed so that the angle 
of the light matches throughout your 
photographs.  That’s with Use Global Angle 
checked. However, if you uncheck Use Global 
Angle, you are suddenly able to photograph each 
item from a different angle, without all the other 

Create Layers Command 

Suppose you want to remove the drop 
shadow from the layer to work with it 
separately.  (I do this often to skew a 
drop shadow, make it fade as it goes 
away from the object, or make it look 
like it running up a wall, for instance.) 
You can do this easily by going to the 
Layer menu > Effects > Create Layer. 
This will separate any and all effects 
from the layer to which they are 
applied. 

Copy Effects 

Suppose you have twenty-three layers 
and you have applied a couple of effects 
to one of the layers. You are so in love 
with the result that you want to apply 
the same exact effects to twelve of the 
other layers.   Easy.  With your favorite 
effects layer active, go to Layer > 
Effects > Copy Effects. This will copy 

all your effects settings for this layer, and now 
you can go back and Paste Effects to any other 
layer, except the background layer.  But you want 
to apply the effects to 12 layers.  Go to each layer 
to which you would like to apply the layer effects, 
and just click the little square to the left of the 
layer thumbnail. 

This little chain that appears means the layers 
are linked. If you move something in one of the 
linked layers, everything in the other linked 
layers moves together with it. But you can also 
Paste To Linked under the layer effects to 
shortcut the process of applying effects to many 
layers. 

pictures automatically adjusting to the same 
lighting angle. 

Well it’s the same for layer effects. If you 
check Global Angle, and change the direction of 
the Drop Shadow, then Photoshop will 
automatically change the Bevel & Emboss angle 
to match. You have the choice of whether you 
want them to match or not, but only if you 
realize you control that consistency with the 
little check mark next to Use Global Angle. 
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You can also drag and drop a layer effect from 
one layer to another, but if you have many layers, 
linking temporarily is faster by far. 

Hide All Effects 

Under Layer > Effects, you also have the 
option of hiding your layer effects without 
deleting them in case you want to see your 
composition “before & after.” 

What Else Can You Do With Linked 

Layers? 

Remember you can also merge linked layers, 
in case you’d like to merge some but not all of 
your layers. You can then un-link your layers by 
clicking a second time on the chain to make it 
disappear. 

Under the Layer menu, you also have Aligned 
Linked and Distribute Linked commands. These 
are great for arranging things between layers in a 
very precise manner. I find it particularly useful 
for centering things, or for lining up a row of 
elements so that they are in a perfect row or 
column. 

“Paste Into” Command 

Okay, why am I bringing in the Paste Into 
command into a discussion about layer masking? 
Because it really IS using layer masking if you use 
Paste Into.  What happens is this:  make a 
selection. Have your active selection or marching 
ants working. Now either open another file and 
copy it, or have one already copied into your 

RAM. Now use Paste Into with the marching ants 
active and watch what happens. 

The image you have copied into RAM will be 
pasted into a new layer, but the ONLY part of the 
image that shows is the area that was selected. In 
the layers palette you will see two thumbnails for 
the layer, indicating that the layer has a layer 
mask. 

And NOTE:  this new layer doesn’t have to be a 
plain old Normal layer. You can change the 
Blending Mode and you can also play with the 
opacity to get just the effect you want.  And as 
with all layer masks, you can click off the linkage 
between the layer and its mask, and move them 
separately. 

Clipping Masks 

Grouping layers gives you a way to use one 
layer as a mask for another layer. In other words, 
you can take the placement of pixels on one layer 
and use that as a way to say “let’s see pixels on a 
second layer only where there are already pixels 
on the first.” 

You will need two layers, neither of them a 
background layer. Now make sure you have 
transparent areas in the lower of the two layers. 
Let’s use the infamous Rubber Ducky for our 
lower layer. Use the magic wand tool on the white 
background and delete it. (Remember you might 
have to change the name of the layer by double 
clicking on it, to change it from a background 
layer to a regular layer. Now with the background 
deleted so that you have a transparent area all 
around the ducky, go to the layer above it --- or 
make a new layer above the ducky layer. Fill this 
layer with a pattern. Edit > Fill > Pattern. Now to 
Clip or Group the two layers, you can hit control 
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G, OR go to the Layers pulldown menu and use 
Create Clipping Mask when you have the top 
layer active, or you can hold down the ALT / 
OPTion key on your keyboard and run the mouse 
between the two layers until the cursor changes to 
symbol with a square and down arrow, then click. 
You will see the top layer bump over to the right a 
bit and an arrow will appear pointing at the lower 
layer. An underline also appears beneath the 
lower layer’s name. 

One very cool thing to use as the base of a 
clipping group is a text layer. This lets you fill text 
with any picture or texture and plus you can still 
use Layer Styles on the text layer. 

 

Layer Sets (Groups) 

Use Layer Sets to organize your various 
layers. You can make a Layer Set by clicking the 
icon at the bottom of the layer’s palette that 
looks like a folder. You can also make a Layer 
Set from Linked Layers.  

And lastly you can make a Layer Set and put 
new layers into it as you make the layers. In any 
case, it makes sense to stay organized if you 
have a complex image and Layer Sets help you 
organize.  

Use the triangle on the layer to open up or 
collapse the layers in the group. Collapsing the 
group makes it easier to see the other layers in 
your image. 

NOTE: you can change the name and the 
color of the Layer Set by using the flyout menu 
in the layer’s palette, and/or by right clicking on 
the Layer Set’s name. 

Ella Carlson 
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Why? 

A few years ago, after seeing an exhibit of the 
Dutch Masters at the Boston Museum of Fine 
Arts, I was inspired by the way the masters han-
dled light in the chiaroscuro style: deep shadows, 
strong highlights and warm tones.  I set out to try 
to reproduce the same effect with a camera.  It 
has been my goal and inspiration ever since. 

Lighting Style 

I found that the Dutch Masters’ effect could 
not be reproduced with conventional photograph-
ic lighting equipment. The mood would be lost. 
After playing around with various light sources, I 
found that using an ordinary flashlight gave me 
the desired effect. 

Concept For Still Life Scenes 

My inspiration comes from many different 
places; it could come from a trip to the supermar-
ket in the produce aisle where a fruit, vegetable or 
a particular flower will catch my eye.  I start to see 
the composition in my head, imagining what af-
fect it will produce. Oftentimes it is an object that 
has character that will start the process. I have 
been known to “shop” at home and have even 
gone on a spree to the local thrift store. 

Set-Up And Composition 

I decide how I want the set-up to look and start 
moving items around to different positions until I 
feel the scene has a nice flow to it.  Before I start 
the process, I must see the image in my head. Get-
ting the items needed for the set-up is the most 
time consuming part of the light painting.  The 
actual photography piece takes less than 30 
minutes. 

Tools 

My tools are simple for my lights. I use vari-
ous ordinary flashlights, such an incandescent 

Light Painting 
By Jose Leiva (ME) 

©  Jose Leiva 

©  Jose Leiva 
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Maglite or an LED of different lumens from 
strong to weak outputs. Some of my favorite 
flashlights are those found at the local dollar 
store for $1 and they work well for a small set up. 
Every time I see a flashlight at a hardware store, I 
feel I have to buy it because someday they will no 
longer be available. I typically use a Nikon D3 or 
a Canon 5DMKII. 

Photographing The Scene 

The scene is shot in sections, working on one 
section at a time until the particular area is at the 
point desired. The image is “assembled” in post-
production using Photoshop, at times using six or 

more frames to arrive at the final composition. 
Often I select from as many as 60 frames that I 
have shot during the process. 

Post-Production 

The post-production is perhaps 80% of the 
work, because it is where the image takes a life 
of its own. You can make or break the results in 
the post-production phase. And most im-
portantly, this is where your personality comes 
through, feeling your way through the process 
and seeing where you want to take the image to 
its final look. 

Quote 

My thought is that you cannot look at how 
your item or model appears under normal light; 
you have to see it, conceive it, and execute it. 

Jose Leiva 
Text and images © Jose Leiva 

www.joseleivaphotography.com  

Jose Leiva (ME) took his first 

photograph at 13 years of age. 

After working  at the FBI and IBM,  

he pursued a career as a self-

taught freelance photographer 

and photojournalist which has 

spanned 24 years. His motto is 

that of Michelangelo, "Ancora 

imparo, I am still learning."  

Masters such as Rembrandt have 

inspired his recent work in light 

paintings, capturing what he feels 

is classic and timeless, yet contemporary.   Jose's 

versatility is seen as a portrait artist, illustrator, 

commercial photographer and a creator of fine art. In 

addition to his camera college presentation, Jose is a 

pre-conference workshop presenter.  He will also be 

conducting a Demonstration on Light Painting a Car 

(Friday 8:30 PM- See packet insert for full info. and 

location) and then edit the image in his second 

presentation on Saturday in Thompson 104 at 11:30 

am.  

©  Jose Leiva 
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Concert and Performance Photography is 
FUN!! 

Unique Atmosphere…  

 but it’s also CHALLENGING! 

 Low light environment 

 Changing lighting conditions 

 Fast-moving, backlit subjects 

 Poor vantage points, unflattering angles 

 Obstacles (equipment, stage, barriers, 
etc.) 

 Automatic camera settings just don't 
work! 

Keys to Success 

 Fast glass (1.2 to 2.8)  

 Fast shutter; 1/250 for most, lower 
slightly to show motion 

 High ISO 1600 or higher 

 Shoot in RAW (for later white balance 
adjustments) 

 No flash! 

 Spot-metering 

 High speed burst mode 

 Know your camera's buffer size 

More Keys To Success 

The Essentials 

 The right lenses 

 Hand-strap, sliding camera strap, or 
belt holster 

 Spare batteries 

 Spare memory cards, high speed 

 More memory cards ;-) 

The Boy Scout Motto:  Be Prepared 

At Home 

 Charge batteries 

 Clear memory cards 

 Clean sensor and lenses 

 Check your camera settings 

 No tripods, monopods, bulky 
accessories, big camera bags 

From Clubs to Concerts -  
Shooting Live Performances 
By Cusi Taylor, Lumix Ambassador (AZ) Sponsored by Panasonic/Lumix  

Dead Eyes Of London 

©  Cusi Taylor 

Dead West 

©  Cusi Taylor 
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 Wear close-toed shoes, pants you can 
crouch in 

 Earplugs.  

 Carry what you need: 1 setup and 1 
alternate lens, - or two bodies on a double 
camera strap. 

 Everything else goes in geek-vest 
pockets / waist-pack 

At the Show 

 Test settings in the venue before the 
performance starts 

 Shoot test shots during the warm-up 
bands 

Composition 

 Focus on the eyes  (this applies to all 
animals - even humans) 

or - 

 Focus on the details (fingers on keys/
strings, sticks hitting skins, the setlist, 
hands in the air, etc.) 

 Show motion or Emotion 

 Don't always keep it straight and level 

 Avoid fuchsia/red gels (or underexpose 
them) 

 Never open your shutter when stage 
lighting lasers are pointed toward your 
lens 

 Look for foreground, midground, 
background 

 Leading lines, rule of thirds, etc  

 Avoid too busy or distracting 
backgrounds when possible 

 Close-ups vs. full stage shots 

 Change it up; shoot the singer when 
they’re NOT singing 

 Include the crowd 

 Show atmosphere/mood/energy/emotion 

 Use the lighting - sidelighting, 
silhouetting to advantage 

 Above all, … Tell the story 

Dead West 

Dead West 

Hunter Hayes 

©  Cusi Taylor 
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Don't Be "THAT Guy" 

 Even if you’re “with the band,”  don’t let it 
go to your head 

 Don’t expect any special privileges OR 
access 

 Don't set your gear down and leave it 
anywhere - ESPECIALLY on stage  

 Don't stand on furniture, speakers or 
other objects that could put the venue at 
risk if you fell 

 Don't shoot tired, hungry, angry or 
otherwise compromised – take a break 

 NEVER interfere with the performance or 
cause altercations with fans 

Gaining Better Club Access 

 Network with other concert 
photographers  

 Get to know club management/owners; 
thank them 

 Give your card to band members or 
their reps at shows 

 Have your card ready, be brief, they’re 
busy working  

 Offer some of your photos to the band 
and the club promoter 

 Get to know the lighting/soundboard 
crew 

 Tag and promote everyone, venue/band/
fans/bartender in social media 

 Network, network, network  

The Right Connections 

 Exclusive access to shoot particular shows 
or events 

 Better lighting setups or sequences 

 Permission to shoot from prime vantage 
points. 

 Advance notice about who the club is 
booking next 

 Introductions to other bands, club 
managers, venue owners 

LOTW Acrobats 

©  Cusi Taylor 

Robert Clyne 

©  Cusi Taylor 

Metalhead 

©  Cusi Taylor 
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Next Steps 

 Post consistently on your branded social 
media pages 

 Tag and Submit photos to local music and 
arts/culture publications 

 Offer to write reviews – publishers need 
content 

 Get a press pass 

Once You Have Built Relationships 

 Ask artists and venue management to 
shoot bigger events 

 Ask publishers to send you to cover 
bigger local events 

BIG Shows 

 Arrive on time, where instructed 

 Have credentials ready 

 Bring all forms printed, signed, in hand 

 Never "just show up" and expect to get in 

 Be familiar with all the terms and 
limitations of the agreement, and follow 
them 

Concert Pit Rules And Etiquette... 

 NO flash.  Ever. 

 Don't camp out in any one spot 

 Be courteous to and mindful of the other 
pit photographers 

 Your head will be at their feet-level.  
Shoot across vs up. 

 Shoot only the first 3 songs (sometimes 2, 
or only 1), and then exit the pit. 

 Shoot the crowd, distance shots and BTS 
if permitted by your photo pass 

Do Your Homework, and Pay 

Attention 

 Find out the most likely opening songs 
and know where to be 

 Is the vocalist left or right handed? 

 What habits or traditions do they always 
incorporate? 

 Is this the guitar solo?  Why are you still 
shooting the bass player? 

Tips for Post Processing 

 You just shot 3000 photos; Lightroom is 
your friend. 

ZZTop 

©  Cusi Taylor 
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 Color correction; don't over-think it 

 Desaturate or de-vibrance to combat 
fuchsia/red-gelled faces 

 Straightening; don't over-think that either 

 Reduce highlights, raise shadows 

 Crop out clutter 

 Reduce noise 

 Targeted sharpening (mask) 

Above all;  HAVE FUN!! 

 It will come across in your images. 

Cusi Taylor 

Text and images © Cusi Taylor 

http://cusitaylor.com 

Sponsored by Panasonic/Lumix 

Cusi Taylor (AZ) is a techno-

geek whose career began in 

technology, and after climbing 

the corporate ladder, she 
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What is Perspective? 

General definition: A particular angle or way 
of viewing or considering something. 

Simplest form:  A point of view. 

How Does Perspective Differ From 

Composition? 

Often, we can tend to focus most heavily on 
image composition, but choosing a point of view 
occurs before framing or finalizing the 
composition. 

Framing includes or excludes components to 
more clearly tell the story; cropping in to limit 
content vs. shooting wide to include as much as 
possible.  Composition consists of arranging 
components in the scene to lead the viewer’s 
attention into, and around the image. 

Rule of thirds, golden spiral, diagonals, 
leading lines, symmetry, etc. 

Choices in framing and composing certainly 
enhance perspective, but the photographer first 
chooses a general point of view. 

Let’s explore some ideas.  Why is the 
viewpoint of an image important?  What happens 
when we change perspectives?  How can we 
purposefully use angles, tools, and even our 

personal opinions to influence perspective and 
noticeably affect the stories our images tell? 

Ansel Adams famously said:  “There are at 
least two people in every photograph. The 
photographer, and the viewer.” 

Each person approaches an image from a 
unique personal perspective.  An image can 
also change one’s perspective. 

Why is Perspective Important? 

Literal Perspectives 

Literal perspectives 
influence the way subjects 
visually appear to us. 

Angle, focal length, 
depth of field, saturation 
and light vs dark 
(illumination and 
definition – it’s one reason 
we like golden hour), 
distance, height, breadth, 
scale/proportion, 
prominence/significance, 
clarity, movement, and 
much more. 

Forced perspective 

Some things trick the eye. 

Figurative Perspective 

Figurative Perspective is just as important. 

Power vs. weakness, femininity vs masculinity 
- - this can even be conveyed by camera height 
(chin height vs above eye level, etc.) 

Tone:  Positive, Neutral, Negative 

A Photographer’s Perspective 
By Cusi Taylor (AZ) Sponsored by Panasonic/Lumix 

©  Cusi Taylor 

©  Cusi Taylor 

http://shop.panasonic.com/cameras-and-camcorders/cameras


Authors retain the rights to their articles which are published here with permission. 115 Articles may not be copied or distributed without prior permission from authors. 

  N E C C C  2 0 1 8  

Winners and Losers 

It’s easy to celebrate a winning team, what is 
the losing team doing? 

Observers and Participants 

Retrospective vs. forward/future oriented 
(figurative distance, depth, breadth, etc.) 

Changing Our Perspectives 

Influencing how or what we photograph. 

Influencing the messages we convey. 

Influencing thoughts and feelings of the 
viewer. 

Perspective Can Be Very Powerful 

Do you feel more empathy for another person 
or an animal after viewing the world through 
their eyes? 

Quality Time 

©  Cusi Taylor ©  Cusi Taylor 

©  Cusi Taylor 
©  Cusi Taylor 

Not winning 

©  Cusi Taylor 
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Has a photo ever caused you to call someone 
just to say “I love you”, or “I’m sorry?” 

Have photographs ever compelled you to join 
a group, study a subject, buy tickets to an event, 
take up a hobby, go on a vacation, or fight for an 
important cause? 

How do you want your viewer to feel?  What 
action do you want them to take?  

Let this drive the message you send, so you’ll 
know which story to tell. 

Cusi Taylor 

(see prior article for Cusi’s bio) 

Text and images © Cusi Taylor 
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Today’s class will focus on sensor cleaning, 
both DSLRs and Mirrorless cameras.  

 Types of debris that might end up on your 
camera.  

 How to avoid unnecessary ‘stuff’ on your 
sensor  

 Benefits of Cleaning your own Sensor 

 Benefits of getting your sensor cleaned in 
store 

 When to send it to the manufacturer  

 Steps to a clean sensor by using our  
Delkin Sensor Scope Travel Kit 

 Patented Sensor Scope 

 Blower & what types of dry debris 

 Wands & Solution (wet/dry) 

 Cleaning Cloth 

*Note, we will not be cleaning sensors in class, 
however you can take a look! We will be offering 
free cleanings Friday & Saturday from 10am-2pm 
(with a short lunch break) 

Jenn Sherry 

https://www.delkindevices.com/
sensorscope/  

https://www.youtube.com/watch?
v=orn5Ifbzto4 

https://www.facebook.com/delkin.social  

https://www.instagram.com/
delkin.devices/ 

Sponsored by Delkin 

 

Sensor Cleaning 101 
By Jenn Sherry (MA) Sponsored by Delkin Devices 

Jenn Sherry (MA) is the Sales & 
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for 10 years in various roles and 

enjoys travel and street 

photography, but is currently 

focused on shooting images of 

her two young boys. Her vendor 

table with the cleaning kits for 

purchase can be found as part 

of Hunts Photo & Video vendor 

display (lower Level). Sponsored 

by Delkin.     
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Leverage The Power of  

Wacom Tablets 

Learn how to leverage the power of Wacom 
tablets, including the Intuos Pro and the Mo-
bileStudio Pro, to improve your post processing 
workflow from start to finish. The Intuos Pro is a 
multi-touch pen tablet for both Windows and 
Mac, while the MobileStudio Pro combines all the 
benefits of a touch sensitive tablet with a power-
ful Windows 10 tablet computer.  

In this session Rob will demonstrate how both 
can be used with Lightroom and Photoshop to 
give photographers an efficient platform for 
working in the field, editing on the go, and bring-
ing it all back home. With Wacom tablets you’ll 
be able to leverage the efficiencies that come with 
customizable buttons, pressure sensitive pen in-
put, and touch screen gestures to quickly edit a 
shoot, batch process the keepers, seamlessly 
move between Lightroom and Photoshop, and 
deliver the final images.  

You’ll leave with a better understanding of 
how to take advantage of Wacom technologies to 
create, manage, and share your photography. 
This program is for anyone looking to get the 
most out of their Wacom tablet, for people just 
wondering what benefits a tablet can bring to 
your photography workflow, and for people that 
just want to learn about an efficient Lightroom 
workflow. 

Lightroom 

I often get asked about the benefit of using 
Lightroom over a Bridge, Camera Raw, and 
Photoshop workflow, and the answer really 
boils down to efficiency. I want to focus in on 
some of the most important ways to maximize 
those efficiencies to make your workflow more 
satisfying and productive. Over time you will 
constantly find new ways, both large and small, 
that just make your overall experience faster 
and more productive. 

Note: One of the biggest impacts on Light-
room performance will always be your hard-
ware. Adobe released an excellent document 
on optimizing Lightroom performance that 
covers hardware and key Lightroom settings 
that is well worth a look: http://adobe.ly/
SBRML3  

During Import 

One of the biggest places to maximize your 
gains is in the import process. If you are some-
one who often returns from a session with mul-
tiple memory cards of photos and a card reader 
with slots for multiple memory cards you may 
not be aware that you can import from multiple 
cards at once from the Lightroom Import dia-
log box. I don’t blame you if you missed this 
fact because it is not particularly intuitive to 

discover. Memory cards are first listed under De-
vices in the Source panel and you can only select 
one device at a time. However, if you look further 
down in the Source panel, along with all your 
hard drives, you will see those same memory 
cards listed as unique drives, and this is where 
the trick lies.  

To import photos from multiple cards at once 
you need to expand the contents of each memory 
card and select the folder containing the photos 

Improve Your Lightroom (Classic and LR6) & 
Photoshop Workflow with Wacom Tablets 
By Rob Sylvan (NH) Sponsored by Wacom  

http://adobe.ly/SBRML3
http://adobe.ly/SBRML3
https://www.wacom.com/en-us
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on the card, then hold the CMD 
key (PC: Ctrl) and select the fold-
er containing the photos on the 
second card (and so on if you 
have more than two slots on your 
card reader) so that now all pho-
tos on both cards are selected for 
import. Make sure Include Sub-
folders is checked to ensure all 
photos on the card are included. 
You can confirm the number of 
photos selected for import in the 
lower left corner of the Import 
dialog box. Now it is as if you are 
importing from multiple drives 
(which you are) instead of from 
separate devices and it saves you 
from having to import each card 
one at a time.  

The next big efficiency gain is the setting that 
you choose in the File Handling panel. I think the 
most underrated new feature of Lightroom Clas-
sic is the improvement to importing photos by 
using the embedded previews extracted from the 
photos themselves. By using the embedded pre-
views, you can begin the process of separating the 
wheat from the chaff as soon as you see photos 
start appearing in the Library. To utilize this fea-
ture, select Embedded & Sidecar from the Build 
Previews drop-down menu in the File Handling 
panel of the Import dialog. 

Photos using these previews will display an 
Embedded Preview label in the lower-right corner 
in Loupe view, and with a new icon on thumb-
nails in Grid view (after import). 

Because we’re not waiting for Lightroom to 
render previews from scratch or fighting against it 
while it renders them in the background, the en-

tire process of identifying your selects is much 
faster. This is a workflow people have been re-
questing for years. Lightroom will render a new 
preview when adjustments are made, or if you 
manually choose the rendering of previews via 
the Library>Preview menu. There’s also a new 

preference (Lightroom > Prefer-
ences [PC: Edit > Preferences]) in 
the General tab labeled Replace 
Embedded Previews with Stand-
ard Previews During Idle Time, 
which when checked, will auto-
mate the process of replacing em-
bedded previews (it’s off by de-
fault). 

In general, Lightroom Classic in-
cludes improvements in preview 
rendering, switching between Li-
brary and Develop, the speed in 
which Develop sliders become ac-

tive, moving from image to image in Develop, and 
when using the Adjustment Brush and Spot Re-
moval brush in Develop. As with earlier versions 
of Lightroom, your mileage will vary based on 
your hardware, but Classic should be taking bet-
ter advantage of more robust hardware configura-
tions than previous versions. 

OK, let’s look at some after import tips. 

Making Selects 

One of the best-kept secrets for improving 
speed in the process of separating the wheat from 
the chaff is the Auto Advance option under the 
Photo menu in the Library module. Give this a 
try, go to the Photo menu and check Auto Ad-
vance, press the G key to jump to Grid view (if 
you are not there already), select a photo and ap-
ply a rating, a flag, or a color label to that photo. 
As soon as any one of those is applied (whether by 
keyboard shortcut or button click) Lightroom au-
tomatically advances focus to the next photo. This 
is a huge time saver! The most efficient way to 
utilize this is with keyboard shortcuts, and my 
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favorites are P for pick, X for reject, and U for un-
flag. With Auto Advance enabled and those three 
keys I can very quickly move through a large vol-
ume of photos and end up identifying the ones I 
want to keep and the ones that will be deleted. If I 
come to a photo that I am on the fence about I use 
the U key, which doesn’t apply a flag but it will 
trigger Auto Advance to move me on to the next 
photo (think of it as a skip key). 

Targeting a Collection 

This is something I use all of the time and I 
absolutely don’t know how I did things before I 
learned this trick. By default Lightroom desig-
nates the Quick Collection inside the Catalog pan-
el as the Target Collection. This means that if you 
select a photo (or multiple photos) and press the 
B key the selected photos are added to the Quick 
Collection. That’s fine, and can be helpful, but I 
prefer to create custom collections in the Collec-
tions panel that fit the project I am working on 
and I rarely use the Quick Collection.  

What I prefer to do is to designate the collec-
tion I am working on as the Target Collection in-
stead, so that I can select photos and press the B 
key to add them to my working collection as I go. 
All you need to do is ctrl-click (PC: right-click) 
your regular collection (this doesn’t work with 
smart collections) and choose Set as Target Col-
lection. You’ll see that the Target Collection gets a 
small + sign at the end of its name to denote its 
status. You can also designate a regular collection 
as the Target collection by checking the relevant 
box in the Create Collection dialog when you first 
create the collection. 

If you are a fan of the Painter Tool you’ll be 
glad to know that the Target Collection is one of 

the items you can load into the Painter, and 
then quickly add photos to your collection by 
clicking and dragging the Painter Tool over the 
desired photos. 

Create a Custom Camera Raw  

Default 

OK, all those tips were focused on library 
management, so here’s a Develop tip that will 
really speed up your workflow. Lightroom has a 
set of default processing settings that are ap-
plied to all raw photos after import. Did you 
know that you can customize those settings to 
start your raw photos down the processing pipe-

line using your preferred choices? I’m not talking 
about a preset selected on the Import screen, but 
rather the built-in default settings. Save your im-
port presets for something creative and customize 
the baseline settings. 

Let’s go through the steps to customize the de-
fault settings to include two of the most common 
adjustments people ask me about, lens correc-
tions and camera profiles, but feel free to add any 
other settings you want to customize your process 
(or not include these if you’d rather not). 

 Select a raw photo that has not been pro-
cessed at all beyond the default settings 
and press D to jump to Develop. Click the 
Reset button for good measure to ensure it 
has no other settings applied because eve-
ry adjustment (even set to 0) is included 
in the default settings. 

 Expand the Lens Corrections panel, click 
the Profile tab if not active already, and 
check Remove Chromatic Aberration and 
Enable Profile Corrections. 

Note: Including profile corrections can be re-
source intensive, so exclude this from your de-
faults if performance is degraded. 

 (Optional) Expand the Profile Browser in 
the Basic panel, choose the camera profile 
you prefer to be the starting point. 

Note: The list of camera profiles varies with 
the camera model used to create the selected 
photo. 

 Go to Develop > Set Default Settings to 
open the Set Default Develop Settings dia-
log box. Default settings are specific to 
each camera model, in this case a Nikon 
D850, so if you are using multiple camera 
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models you will need to update the de-
faults for each model separately. 

Tip: You can also hold the Option (PC: Alt) 
key and watch the Reset button change to Set 
Default and click that button to open the Set De-
fault Develop Settings dialog box. 

 Click Update to Current Settings to cus-
tomize the default settings to include the 
changes you made. 

Note: While it states the changes are not un-
doable, this just means that you can’t revert back 
to the Adobe defaults via the Edit > Undo menu. 
You can always open this dialog box and click 
Restore Adobe Default Settings if you want to go 
back to the original settings. 

This will only affect raw photos from that spe-
cific camera model as they are imported in the 
future, and if you hit the Reset button on a previ-
ously imported raw photo from that specific cam-
era model. You must repeat that process to set 
defaults for any other camera models you are us-
ing. This does not change the settings on any pre-
viously imported photos. 

Crop Faster 

Cropping a large number of photos can be a 
tedious task. I often hear from people who are 
looking for a way to set a default crop ratio, so 
that when they enter the Crop Tool their photos 
are already cropped to a given aspect ratio. Unfor-
tunately, that is not possible, as Lightroom has to 
start by showing you the current aspect ratio of 
the active photo in question. However, there is a 
really easy way to apply a crop ratio to any num-
ber of photos at once, so that when you next move 

 

to the Crop Tool those photos are already set to 
the desired aspect ratio. Here’s how it works: 

STEP ONE: Starting in Grid view, select all of 
the photos you want to crop to a new aspect ratio 
by pressing CMD+A (PC: Ctrl+A). For this exam-
ple, let’s assume you want to crop them all to a 5 x 
7 aspect ratio, but it can be whatever aspect ratio 
you wish. 
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STEP TWO: Expand the Quick Develop panel, 
then make sure the small (and hard to see) trian-
gle button to the right of Saved Preset is facing 
downward to expand that section of the panel.  

STEP THREE: Click the Crop Ratio drop-down 
menu and choose the 5 x 7 preset (or whichever 
crop ratio you desire). All selected photos will 
then be set to that aspect ratio. 

STEP FOUR: Click the frame surrounding the 
thumbnail of the first photo in the sequence to 
deselect all of the photos but that one (just to 
avoid inadvertently applying unwanted settings to 
other photos) and then press R to jump right to 
the Crop Tool. 

Now when you enter the crop tool the selected 
photo is already set to the desired aspect ratio and 
you can just focus on tweaking the crop rectangle 
for best composition. You can then move through 
the rest of the photos from the shoot much more 
quickly. 

Disable Lens Profile Corrections 

I love Lightroom’s ability to correct lens distor-
tions and vignettes through the use of lens pro-
files. However, it is important to realize that ena-
bling these profiles does require Lightroom to 
work a bit harder. This can be most noticeable 
when attempting to use the Spot Removal Tool 
when lens profile corrections are enabled. If you 
ever notice Lightroom seems sluggish when using 
that tool just expand the Lens Corrections panel 
and uncheck Enable Profile Corrections and see if 
that speeds things up. If so, great, just remember 
to re-enable the profile corrections when you are 
finished working. To make this easier I created 
one preset that simply enables profile corrections 
and another that simply disables profile correc-

tions. In a typical workflow I wait to enable pro-
file corrections until after I have dealt with any 
spot removal issues but having the presets 
handy makes it easy to toggle that setting on 
and off as needed. 

Auto Sync 

The last speed tip I want to leave you with is 
called Auto Sync. When Auto Sync is enabled 
you can work on multiple selected photos at 
once in the Develop module. To enable Auto 
Sync, you first need to select multiple photos in 
the Filmstrip that you want to all have the same 
settings. As soon as more than one photo is se-
lected the Previous button changes to Sync and 
a little toggle switch appears to the left of the 
Sync button. Click the toggle switch to the up 
position to enable Auto 
Sync. Now everything I do to 
the active photo will be 
equally applied to all the 
other selected photos in the Filmstrip. This does 
include cropping and spot removal, as well as all 
of the global adjustments Lightroom can do, but 
it does not include adjustments made with the 
Graduated Filter, Radial Filter, or Adjustment 
Brush. When you want to synchronize any of 
those local adjustments you can flip the switch 
to revert back to Sync mode and use the Syn-
chronize Settings dialog box instead. I do highly 
suggest getting into the habit of always disabling 
Auto Sync when you are done to avoid using it 
by accident as it stays enabled until you manual-
ly turn it off. 

OK, now that we’ve fine-tuned your Light-
room Classic machine, let’s take about using 
Lightroom and Photoshop together for maxi-
mum effect. 

Using Lightroom and  

Photoshop Together 

Lightroom and Photoshop are a powerful edit-
ing team and are designed to work well together 
in a variety of ways. As more people sign on to the 
Creative Cloud Photography Plan to primarily use 
Lightroom, I often encounter questions about 
how to use Lightroom and Photoshop together, or 
even the need for using Photoshop at all. It is a 
testament to how far Lightroom has come that the 
mother of all image editing programs has taken a 
back seat for so many new users. While I have 
certainly seen a decrease in the amount I use Pho-
toshop (thanks to Lightroom), I still use it every 
day, and couldn’t imagine not having it as part of 
my workflow. As much as I love Lightroom, 
you’re missing out on some real image editing 
power if you’ve written off Photoshop from your 
workflow. Lightroom was designed to be a front 
end to Photoshop, so let’s look at some of the 
ways you can leverage it for your benefit.  

External Editing Preferences 

In Lightroom, go to Lightroom > Preferences > 
External Editing (PC: Edit > Preferences > Exter-
nal Editing), and you will find the default prefer-
ences for copies created when being sent from 
Lightroom to Photoshop. The typical Lightroom 
to Photoshop workflow starts in Lightroom, 
where you use the Develop module to its fullest, 
and then, if needed, you send a copy with Light-
room adjustments to Photoshop. It is at this point 
(and only this point) that these external editing 
settings come into play. I find the default settings 
are perfect for my workflow, but you have the op-
tion of changing the file format from TIF to PSD 
(though they both work fine, PSD files do tend to 
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result in smaller file sizes with multi-layer imag-
es), color space, bit depth, and resolution. 16 bit 
ProPhoto RGB is intended to preserve as much of 
the data in the image as possible when sending 
the copy to Photoshop. This does result in a larger 
file, so if file size is a concern you can choose 8 bit 
Adobe RGB as a good alternative (note, you can 
always convert to 8 bit Adobe RGB in Photoshop 
after editing to retain the data while editing and 
reduce file size at the end of the session). 

Another alternative to consider is setting up an 
Additional External Editor preset for Photoshop 
with the 8 bit Adobe RGB settings if you want to 
be able to choose either option from the outset. 
Here’s how to do this: 

STEP ONE: In the middle section of the Exter-
nal Editing preferences, click the Choose button 
next to Application and navigate to the Photoshop 
executable file. This is found in the Applications 

folder (PC: Program Files). Once selected, 
you will see a prompt informing you that 
Lightroom has already chosen Photoshop as 
an editor, but click Use Anyway to override.  

STEP TWO: Configure file format, color 
space, bit depth, and resolution as desired. 

STEP THREE: Click the Preset drop-down 
menu and choose Save Current Settings as 
New Preset and give it a meaningful name 
(i.e. Photoshop 8 bit Adobe RGB) when 
prompted.  

STEP FOUR: Close the preferences to return 
to Lightroom. 

Edit In 

If you go to the Photo > Edit In menu you 
will see the top option is Edit in Photoshop 

CC, and below that will be the program you’ve 
selected under the Addition-
al External Editor prefer-
ence. Each of these options 
has keyboard shortcuts asso-
ciated with them, and these 
are shortcuts you should 
learn. The preset you creat-
ed will appear further down 
the menu list, along with 
any other third-party exter-
nal editors you may have 
installed (and I have a few). 
Aside from the Photo menu, 
you can also ctrl-click (PC: 
right-click) a photo to access 
the same Edit In menu op-
tions.  

Depending on the file type you have selected in 
Lightroom there are 2 behaviors that can occur 
when sending a photo to be edited in Photoshop. 
The first behavior is if you have a raw photo se-
lected in Lightroom and use the Edit In > Edit in 
Photoshop CC 2018 option (or its shortcut), then 
a copy of the photo (based on your primary exter-
nal editor settings) is sent to Photoshop. For ex-
ample, here’s a raw photo that I’ve done every-
thing I can do in Lightroom, and now I want to 
send to Photoshop to use the Content Aware tech-
nology to remove the guy in the back.  

When it first appears in Photoshop, I’ll still see 
the original raw file extension because this photo 
has not yet been saved to my hard drive. It only 
exists in memory until I use the File > Save com-
mand in Photoshop. Once saved, the file exten-
sion will change to the file type I have designated 
on my external editing preferences, and the copy 
will be automatically added to my catalog and ap-
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pear in the same folder as the source photo. Once 
my edits are done in Photoshop, I’ll save the pho-
to again, and then close it, and return to Light-
room.  

The second behavior is if you have a non-raw 
photo (JPG, PSD, TIF, PNG) selected and use the 
Edit In > Edit in Photoshop CC 2018 (or its 
shortcut) option. In this case, Lightroom has to 
ask you a question before it can proceed. When 
you start with a raw photo (my previous exam-
ple), the only thing Lightroom can do is send a 
copy with Lightroom adjustments because Pho-
toshop cannot open a raw photo. However, with a 
non-raw photo selected Lightroom needs to know 
if you want to edit a copy with Lightroom adjust-
ments, edit a copy, or edit original. Your choice 
depends entirely on your reason for heading to 
Photoshop.  

If you have a non-raw photo selected that 
you’ve just edited in the Develop module, and you 
want to apply those edits to a copy, and then edit 
the copy in Photoshop, you’d choose the first op-
tion. Note if you have a layered file selected, the 
copy sent to Photoshop will be flattened first be-

fore the Lightroom edits can 
be applied (the original is 
untouched).  

If you have a non-raw 
photo selected, and you 
want to duplicate it, and edit 
the duplicate copy (think 
alternative version), then 
you would choose the sec-
ond option. This will dupli-
cate the selected photo 
(without applying any Light-
room edits) and open the 
copy in Photoshop.  Layers 
are preserved. I don’t use 
this option often, but it is 
handy when you want to du-
plicate the original and edit 
from there in Photoshop. 

If you have a non-raw photo selected, and 
you just want to open it back into Photoshop 
(without applying any additional Lightroom ed-
its), then you would choose the third option. 
This is just like using the File > Open menu in 
Photoshop. This is the option I use when I need 
to re-open a layered photo back into Photoshop 
to continue editing with layers intact. 

Side note, there is not a Photoshop com-
mand to switch back to viewing Lightroom. 
However, both operating systems have 
shortcuts for switching between open pro-
grams that you can utilize. On Mac, hold the 
CMD key and press Tab to switch between pro-
grams. On Windows, hold the Alt key and press 
Tab to do the same. 

Using the Edit In > Edit in Photoshop com-
mand is the most common Lightroom to Pho-
toshop workflow, but there are other options at 

the bottom of that Edit In menu that are incredi-
bly useful for other situations. Two of those op-
tions, Merge to Panorama in Photoshop and 
Merge to HDR Pro in Photoshop have become 
much less useful since Lightroom gained the Pho-
to Merge options for both Panoramas and HDR 
but keep these Photoshop options in mind for 
cases where Lightroom’s results aren’t as good as 
you need and give Photoshop a try. That said, 
Open as Smart Object and Open as Layers still 
have their places.  

Open as Smart Object in Photoshop 

If you have a need to maintain maximum flexi-
bility in your editing, then consider the open as 
smart object workflow. When you open as a smart 
object a full resolution copy of the selected photo 
is embedded in a special layer called a smart ob-
ject. This gives you a protected version of the pho-

©  Rob Sylvan 
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to that you can always go back to and re-edit, and 
if you start with a raw photo in Lightroom, you 
have the full raw original embedded in that smart 
object layer. For example, at the last Photoshop 
World I snapped a photo of a model on the Expo 
floor as I rushed to a class. Due to my haste, the 
photo was a bit soft. Previously I would have 
simply deleted it, but then I remembered the 
Shake Reduction filter in Photoshop and won-
dered if it could save my mistake.  

By opening as a smart object (note the special 
icon it has on the thumbnail in the Layers panel) 
into Photoshop I keep all the data of my raw orig-
inal plus all the edits applied in Lightroom. At any 
point in my editing session, I can double-click the 
smart object icon and open the raw copy into the 
Camera Raw plug-in and further tweak the edits I 
made in Lightroom. Right down to re-cropping, 
changing the camera profile, or whatever setting I 
choose. Note, this is a separate copy from the 

original, so nothing I do here affects the original 
raw photo back in Lightroom.  

More importantly, I can apply filters to my 
smart object, which become smart filters. Why 
smart? Filters applied to a smart object are re-
editable. Meaning I can apply a filter, then later 
on re-edit that filter’s settings by double-
clicking the smart filter in the Layers panel to 
open the image back into that filter. And this is 
all non-destructive since my photo is embedded 
in the smart object. This gives you a lot of free-
dom to experiment, try different levels of adjust-
ment, and then refine those adjustments later. 
Smart filters also come with a mask, which 
means that you get even more control over the 
final results of the filter by painting on the mask 
to reduce or even remove the effect from regions 
of the photo. In my example I ended up using 
the Shake Reduction to reduce the blur and face
-aware Liquify to enhance her expression. I 
painted on the mask to bring back the original 
blur in the out of focus areas behind the model.  

While it would have been 
preferable to nail the focus 
correctly (obviously), I was 
impressed by how much I 
could to do correct my mis-
take in Photoshop. I can im-
agine I’m not the only one to 
have made such a blunder. 
Once all my edits are com-
plete, I save and close, just 
as before, to return to Light-
room where both the origi-
nal and the edited copy are 
found.  

Open as Layers in Photoshop 

A more common use for Photoshop is to create 
a composite image from two or more photo-
graphs. If you have all the photographic elements 
together in Lightroom, you can save yourself 
some time by selecting them all in Grid view, then 
use the Edit In > Open as Layers in Photoshop 
menu (this menu will be disabled if only one pho-
to is selected). Each selected photo is then ren-
dered (with Lightroom adjustments) and added to 
individual layers within a single file. Here’s a sim-
ple example of two photos that I want to combine 
the best elements in each into a composite. The 
first is of a model that was illuminated by flash-
light while standing on the beach. The second is a 
longer exposure of the stormy sky behind her tak-
en a moment later.  

With the two layers open in Photoshop I can 
simply apply a linear gradient from black to white 
on a layer mask to blend the two together for a 
much more compelling photo. While in Pho-
toshop, I can also take advantage of the retouch-
ing tools to remove distractions and otherwise 
improve the image.  

Just as before, save and close from Photoshop 
to save the copy to the same folder as the source 
photo and add the copy to the catalog. There’s so 
much more you can do with the dynamic duo of 
Lightroom and Photoshop, but I hope this gives 
you a taste of what’s possible and inspires you to 
try it yourself.  

©  Rob Sylvan ©  Rob Sylvan 
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I've never met a Lightroom user who didn't 
have questions, so bring yours and get the an-
swers you need to get your workflow on track. 
Questions on Lightroom Classic, Lightroom 
CC, or older versions of Lightroom are wel-
come. The session will start with a presenta-
tion on the most common questions and an-
swers, which are intended to help every Light-
room user. You're sure to learn something 
new, and your question might just help some-
one else! 

Top 10 Things to Know 

Here are the top 10 things every Lightroom 
user should know: 

1. Set Your Default Catalog 

The most important thing every Lightroom 
user needs to know is where your Lightroom cata-
log is located on your system. Even if you think 
you know, it’s worth taking a moment to make 
sure (you’d be surprised how many people find it 
is not where they expect). With Lightroom open, 
go to Lightroom > Catalog Settings > General 
(PC: Edit > Catalog Settings > General), and note 
the name of the catalog and the path to where it is 
located.  

Is it where you expected? If so, great! If 
not, here’s how you can move it to a new 
location: 

 Click the Show button on the Gen-
eral tab of the Catalog Settings to 
open the folder containing your 
catalog in your file browser. 

 Quit Lightroom. If prompted to 
backup, click skip for now. 

 Copy the folder containing the Light-
room catalog (.LRCAT) and its associat-
ed preview caches to the location you 

want it to be stored (pick a locally con-
nected internal or external drive). 

 Once the copy operation is complete, 
double-click the catalog file to open it 
back into Lightroom. This way you can 
make sure all is working fine, and the 
new location will be included in the pref-
erences. 

Now, whether you moved your catalog or not, 
this next step is important. I highly recommend 
that you manually configure this catalog to be the 
Default catalog (in other words, don’t use Load 
most recent catalog). To do this, go to Lightroom 
> Preferences > General (PC: Edit > Preferences 
> General), and set the When starting up use this 

catalog option to the specific catalog you just 
opened. 

Remember, if you moved your catalog to a new 
location, don’t forget to go back and remove the 
original folder containing your old catalog. Hav-

All Your Lightroom Questions Answered 
By Rob Sylvan (NH) Sponsored by Wacom 
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ing a good backup in place is good idea too 
(which I’ll cover in a bit). 

2. Know Where Your Photos are  

Located 

It is equally important for all Lightroom us-
ers to know how to find exactly where a given 
folder or photo resides on your drive from in-
side Lightroom. There are a few ways to identify 
where your folders and photos exist on your 
drive. The easiest is the good old right-click con-
textual menu. Go ahead and right-click any folder 
in the Folders panel and choose the Show in Find-
er (PC: Show in Explorer) menu. This will open 
your file browser right to that folder and show 
you where it exists on your drive. 

Similarly, you can right-click any photo and 
access that same Show in menu to take you right 
to that photo in your file browser. You don’t have 
to go that far to find that information though. If 
you just hover your cursor over a folder you 
should see its path revealed in a tooltip popup. So 
take a moment to make sure you know exactly 
where all of your photos are located on your drive. 

If they’re not where you want them, then let’s 
look at how to move them. 

3. Know How to Use Lightroom to 

Move Photos and Folders 

Now that you know where your photos are 
located, it is in your best interest to use Light-
room to move them if you need to put them 
somewhere else (with one exception that I’ll 
cover in tip 5). Moving photos between folders 
or moving entire folders is as easy as drag and 
drop. By using Lightroom to do the moving it 
not only moves the photos to the new location, 
but it also keeps the catalog up to date with 
where the photos can be found. You see, Light-
room stores the complete path to each photo in 
the catalog, and if anything in that path changes 
outside of Lightroom you end up with a 

situation where Lightroom tells you that 
your photos are offline or missing (here’s 
a link to an article I wrote on how to re-
connect missing photos). This is easily 
avoided by doing the moving inside of 
Lightroom. 

So to move a group of photos (or even 
just a single photo) from one folder to an-
other try this: 

 In the Folders panel, select the folder 
containing the photos you want to move. 

 Press G to jump to Grid view. 

 Select the photo(s) you want to move and 
drag/drop them on the folder you want 
them to be moved into. The destination 
folder will highlight in blue to signal it is 
the target of the drop. 

Lightroom will then do the moving and update 
the catalog accordingly. You do need to have a 
destination folder already showing in the Folders 
panel to complete the move, so let’s look at how to 
add a folder next. 

4. Keep All Photo Folders Within a 

Single Parent Folder 

I have found it incredibly useful to always keep 
all my photo folders within a single parent folder 
on each drive I use to store photos. The reason is 
that it makes my life so much simpler if I ever 
need to move the entire photo library on that 
drive, or if I need to reconnect the catalog to the 
photo library in the case of a primary drive fail-

http://www.peachpit.com/articles/article.aspx?p=2422808
http://www.peachpit.com/articles/article.aspx?p=2422808
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ure/loss. In typical Lightroom fashion there are a 
couple of ways to create new folders. To start, you 
can go to the Library menu and choose New Fold-
er, or click the plus sign at the top of the Folders 
panel and choose Add Folder to launch the 
Choose or Create New Folder dialog. From here 
you can either choose an existing folder you may 
have created in your file browser or you can cre-
ate a brand-new folder. For example, let’s say I 
want to add a new drive to my catalog and want to 
select/create a folder on it: 

 Connect drive. 

 Go to Library > New Folder, to open the 
dialog for finding and creating a new 
folder at the location of your choosing. 

 Create a new folder or select an exist-
ing folder. In my case, I had previous-
ly created a folder on this drive in 
Finder. 

Note, my screen capture shows the dialog 
on a Mac, but on Windows you’d get a Win-
dows dialog. This is one of the few visual dif-
ferences in Lightroom due to the operating 
systems. 

That drive and folder will now appear in my 
Folders panel. I can drag and drop photos or 

folders into that folder from anywhere 
else in my catalog. 

Another common scenario is the need 
to create sub-folders within existing 
folders to help with your organization-
al needs. This process works in a simi-
lar fashion, but you start by selecting 
the parent folder you want to create 
the subfolder within. 

 Select the folder you want to create 
the subfolder within. 

 Right-click to open the contextual 
menu and choose Create Folder 
Inside “foldername.” This opens a 
smaller Create Folder dialog box 
where you can give the subfolder a 
name and click Create to complete 
the process. The subfolder will then ap-
pear in the Folders panel. These folders 
are ready for me to add photos, and 
even new folders as my organizational 
needs demand. 

Now that I have a parent folder, and a subfold-
er within it, I can move folders from another drive 
into this drive by dragging and dropping on my 
new folder. 

5. Know How to Move Your Photo  

Library to a New Drive 

This is useful if you are wanting to move your 
entire photo Library from an internal drive to an 
external drive, or if you are running out of space 
on one drive and want to move to a new larger 
drive. Now, you could use Lightroom to move the 
folders as I just did in the previous tip, but I don’t 
recommend doing that when your entire library is 
at stake. Using a move command is risky, because 
if anything goes wrong in the middle of the trans-
fer you could lose data. I prefer a technique that 
involves copying the folders to the new drive out-
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side of Lightroom, updating Lightroom to this 
change, and then later manually deleting the files 
from the original location. Here’s how: 

 Open Finder (PC: Explorer). 

 Copy the entire folder structure (as-is 
without changing the structure) to the 
other drive. 

 Open Lightroom. 

 Once the copy operation is complete, 
ctrl-click/right-click the top-most-level 
folder in the Folders panel and choose 
Update Folder Location. 

 In the resulting dialog box, navigate to 
and select that same top-most-level 
folder in the new drive (the one you 
just copied over there). 

Lightroom will update the catalog to 
point to the folder in the new location 
(and everything inside of that folder). 
If you have all your folders/photos in 
a single parent folder then you are 
done, but if there are additional fold-
ers at the same level as that top folder 
you just need to repeat steps 4 and 5 
with those folders. Give it a test run 
to make sure everything is as it 
should be before removing the origi-
nals. Again, having a good backup in 
place before you do this is always a good 
idea. 

6. Know How to Back Up Your 

Catalog 

On the subject of backing up, there is a lot to 
say about backup strategies in general, but in 
the context of Lightroom catalogs I simply want 

to address the built-in functionality Lightroom 
provides. On the Catalog Settings dialog (see first 
tip) there is a place at the bottom where you can 
configure Lightroom to create a duplicate copy of 
the catalog at some interval of time. This is a set-
it-and forget-it type of feature, and its sole pur-
pose is to create an exact duplicate of your work-
ing catalog file in a location of your choosing (no 
photos are included in this backup). 

I will assume you already have some sort of 
full system backup running that regularly backs 
up all your important files, and so you may won-
der if you really need this option running too. 
Based on the experience of helping people with 
Lightroom problems over the years I feel that it is 
in your best interests to take advantage of this 
built-in functionality. Sure, it may be redundant, 
but it is free, it is easy, and it may just one day 
make you weep with gratitude. I set mine to run 
every time I quit Lightroom, which make Light-
room throw up this prompt every time I exit. 

It is only in this prompt that I can choose 
where I want my backup copy to be saved by 
clicking the Choose button and selecting a loca-
tion. I recommend that you choose a different 
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drive than the drive where your working catalog is 
stored. In my case, my laptop has a single internal 
drive, so I direct the backup to be saved to my 
Dropbox folder, which is automatically synced 
with the cloud and my other computers. I also 
take this opportunity to check the boxes for test-
ing integrity and optimizing the catalog. Now, just 
because it prompts me each time doesn’t mean I 
backup every time. There is a Skip button that I 
use when I’m in a hurry and just want to quit. 

I try to create a backup at least once a week or 
after I’ve done a whole lot of work. Each time this 
function runs it saves a copy of your catalog to the 
folder you chose. Lightroom does not overwrite 
existing backup copies. As a result you end up 
with a folder of iterative copies of your catalog. 
This can be very handy for recovering from self-
inflicted problems or from the rare case 
of catalog file corruption. 

7. Know How to Restore From Your 

Backup 

Since a backup copy of the catalog is an exact 
duplicate of your working catalog at the time the 
backup was created all you must do to restore 
from the backup is the following: 

Close Lightroom (if open). 

Open the Lightroom folder containing your 
working catalog file in Finder/Windows Explorer. 

Move the “bad” catalog file out of that folder to 
another location for safekeeping. 

Move the latest/greatest “good” backup catalog 
copy into the Lightroom folder to replace the bad 
one. Starting with Lightroom 6/CC 2015 the back-
up copy is also compressed into a zip file to re-

duce file size (and keep people from accidentally 
opening a backup copy), so you may need to un-
zip the backup before you can move it into the 
Lightroom folder. 

Once placed in the Lightroom folder, double-
click the catalog file to open it into Lightroom 
and take it for a test drive. 

The backup copy of the catalog has the same 
name as your working catalog, so you should be 
good to go. It will only contain all the work up 
until the moment you made that backup copy, 
so backup frequently. If restoring from the 
backup solved your problem, don’t forget to de-
lete the “bad” catalog that you moved out earli-
er. 

8. Manage those Backup Copies 

The only downside to running the catalog 
backup function (aside from the time it takes to 
run) is that Lightroom will keep putting new 
copies of the catalog into that folder until the 
drive is full. The management of the backup 
folder falls on us. Since we only value the most 
recent version(s) of the backup copies I periodi-
cally go into that folder and delete all but the 
most recent 2 or 3. Note that Lightroom doesn’t 
backup the preview caches because those can 
automatically be regenerated if lost. I’ve seen 
people regain hundreds of gigabytes of free 
space after clearing out old backup copies. 

9. Know How to Rename Your  

Catalog 

I often hear from people who are using the 
most up to date version of Lightroom, but have 

a catalog file named with an older version of 
Lightroom and it may also have some other num-
bers in it, such as Lightroom 5 Catalog-2. They 
wonder if this is a problem, and they want to 
know how to rename the catalog. First, it is not a 
problem at all. You can call your catalog file any-
thing you want to call it. Lightroom doesn’t care. 
However, if you want to rename it to something 
that makes more sense to you, here’s how: 

With Lightroom closed, go to the folder where 
the catalog resides using your operating system’s 
file browser; Finder on Mac, and Windows Ex-
plorer on PC. 

Using your file browser you can rename the 
catalog file, but keep the file extension the same 
(.LRCAT). Then rename the Preview cache and 
Smart Preview cache (if applicable) the same way, 
but retain the word Previews and Smart Previews 
in the name along with the original file extension. 

So, for example if your catalog and preview 
cache was named: 

Lightroom 5 Catalog-2.lrcat and Lightroom 5 
Catalog-2 Previews.lrdata 

And you wanted to change it to “Lightroom 
Catalog,” you would end up with: 

Lightroom Catalog.lrcat and Lightroom  
Catalog Previews.lrdata 

Once renamed, double-click the catalog file to 
open it into Lightroom. Now you can give it a 
quick test drive to make sure all is well, and this 
writes the new catalog name into the Lightroom 
preference file. Be sure to update your Default 
catalog setting to point to this renamed catalog 
(see Tip 1). 
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10. Create a Custom Camera Raw  

Default 

OK, all those tips were focused on library man-
agement, so let’s end on a Develop tip that could 
speed up your workflow. Lightroom has a set of 
default processing settings that are applied to all 
raw photos after import. Did you know that you 
can customize those settings to start your raw 
photos down the processing pipeline using your 
preferred choices? I’m not talking about a preset 
selected on the Import screen, but rather the built
-in default settings. Save your import presets for 
something creative, and customize the baseline 
settings. 

Let’s go through the steps to customize the de-
fault settings to include two of the most common 

adjustments 
people ask me 
about, lens 
corrections 
and camera 
profiles, but 
feel free to add 
any other set-
tings you want to 
customize your pro-
cess (or not include 
these if you’d rather 
not). 

 Select a raw 
photo that has not 
been processed at 
all beyond the de-
fault settings and 
press D to jump to 
Develop. Click the 
Reset button for 
good measure to 
ensure it has no 
other settings ap-
plied because every 
adjustment (even 
set to 0) is included 

in the default settings. 

 Expand the Lens Corrections panel, click 
the Profile tab if not active already, and 
check Remove Chromatic Aberration and 
Enable Profile Corrections. 

Note: Including profile corrections can be 
resource intensive, so exclude this from your 
defaults if performance is degraded. 

 (Optional) Expand the Profile Browser in 
the Basic panel, choose the camera pro-
file you prefer to be the starting point. 

Note: The list of camera profiles varies with 
the camera model used to create the selected 
photo. 

 Go to Develop > Set Default Settings to 
open the Set Default Develop Settings dia-
log box. Default settings are specific to 
each camera model, in this case a Nikon 
D850, so if you are using multiple camera 
models you will need to update the de-
faults for each model separately. 

Tip: You can also hold the Option (WIN: Alt) 
key and watch the Reset button change to Set 
Default and click that button to open the Set De-
fault Develop Settings dialog box. 

 Click Update to Current Settings to cus-
tomize the default settings to include the 
changes you made. 

Note: While it states the changes are not un-
doable, this just means that you can’t revert back 
to the Adobe defaults via the Edit > Undo menu. 
You can always open this dialog box and click 
Restore Adobe Default Settings if you want to go 
back to the original settings. 

This will only affect raw photos from that spe-
cific camera model as they are imported in the 
future, and if you hit the Reset button on a previ-
ously imported raw photo from that specific cam-
era model. You must repeat that process to set 
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defaults for any other camera models you are us-
ing. This does not change the settings on any pre-
viously imported photos. 

Rob Sylvan 

Text and images © Rob Sylvan 
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Every photo needs some amount of adjust-
ment to enhance its presentation, even really 
good photos can benefit with the right adjust-
ment. However, if you ask 5 different people what 
needs to be done, you’ll get 5 different answers, or 
worse, no answers, simply, “it looks fine!” Things 
become really difficult when there is no obvious 
problem. There are simple things to check for, 
like making sure there is a good black point (and 
possibly white point) in the image to insure that 
there is maximum tonal range. Other choices are 
purely personal, according to taste, or creative 
choice, but careful consideration can often reveal 
a correction strategy that can bring out the best in 
any given image. 

I think most photographers have a hard time 
stepping back from the moment of capture in or-
der to really evaluate the image as it would pre-
sent itself to a viewer who is not intimately con-
nected to the experience of taking the photo. We 
remember how good our subject looked in our 
minds eye, and this alters our perception of the 
collection of pixels that is the result of the picture 
making process. The truth is that the photo we 
take elicits a response that is dependent on our 
memory of the experience – when you take that 
memory away, as it would be for anybody who 
was not there at the moment of capture, the re-
sponse is only dependent on the photo. This is 
one reason it is so hard for us to edit our own 
work! It’s almost impossible to be objective 
enough. 

Color Correction 

I have found that careful attention to basic 
color correction principles can help re-calibrate 
our subjective evaluation of an image to a point 
where effective adjustment choices can be 
made. I also find it extremely helpful to get as 
much practice as possible working on other 
people’s images, as this helps us become more 
objective about our own work! I have the good 
personal  fortune  of  benefiting  from  the  
work  of  my  fiancé, the amazing Bobbi Lane, 
who happens to be a really extraordinary por-
trait photographer! I will examine my decision 
making process in a recent color correction of 
one of her images in the remainder of this arti-
cle. 

The image at right is as it was given to me, 
already processed into a TIFF file from the 
original DNG.  Bobbi gave me this file to look 
over and make fine-tuning adjustments. This 
was the result of her Lightroom adjustments.   

The numbers show just a little too much sat-
uration… 

The screenshot on the next page shows a 
reading from the skin color at the chin – there 
are two columns of numbers here because I had 
already added a Curves layer when I did the 
screenshot, normally there is only one for RGB 
and CMYK. The two columns are identical at 
the moment because no adjustment is being 

Color Correction for the Best Skin Tone 
By Lee Varis (MA) Sponsored by Fujifilm 

Not bad right? But… there is just something 

about the color, maybe it’s just a little too color-

ful? The skin is approaching what I call the 

Pumpkin Tone – just a bit too orange! A look at 

the info panel will confirm this. I move the cur-

sor into the image and hover over some points 

on the face: forehead, chin, and onto the shoul-

der and chest.  

©  Bobbi Lane 

http://www.fujifilmusa.com/products/digital_cameras/
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made, this allows you to compare adjusted with 
non-adjusted numbers. Even though the image is 
in RGB, Photoshop allows for a secondary set of 
colors in the info panel. By default, this extra read
-out is in CMYK (this can be changed in the panel 
options drop down at the upper right corner of 
the info panel) 

What I’m noticing here is the ratio of C to M to 
Y – the basic skin color is good, but… ideally, with 
a fair skinned blond, I’d like to see the magenta 
value just a little closer to the yellow value, and 
the cyan should not be much lower than 1/4 of 
the average between magenta and yellow. In the 
numbers above, that average would be 53 – cyan 
at 10 is just a little low, not horribly low, but that 
combined with the slightly elevated yellow 
(relative to the magenta) confirms my suspicion 
that the skin is just too colorful. In fact, this skin 
color is very reminiscent of an artificial tan, spray

RGB and that 2 percent is missing in the reds! 
Anyway, 

I digress… I usually check for clipped-to-white 
values to see if there is a serious problem. This 
image is easily adjustable with a Curve because 
there is no clipping in the red channel. However, 
I do feel that a Curve adjustment might be a bit 
easier if the red channel were just a little darker. I 
know that I’m going to raise the blue channel val-
ue in the skin to counteract the overly yellow 
tone, and this will lighten the skin overall. I’d like 
to keep the value of the skin close to the current, 
tan look, so darkening the red would help. I could 
use the same Curve to achieve this darkening, but 

-on type of color that is sometimes used by 
body builders in competitions! 

Another thing I like to do, when analyzing 
any image, is look at the individual channels of 
the RGB image. This image shows a very pale 
red channel with skin values approaching 
white! 

Now, this image is in Adobe RGB because I 

haven’t been able to convince Bobbi that sRGB 
is perfectly adequate for portrait photography, 
and this affects how pale the red channel is. In 
Adobe RGB there is a bit darker tone in reds 
than there would be in sRGB so you have to 
keep that in mind when judging colors. Adobe 
RGB can contain much more saturated reds 
than can be displayed on just about any moni-
tor – even the expensive, so-called, Adobe RGB 
monitors can only display 98 percent of Adobe 

Skin color is best analyzed by looking at 

the CMYK values in the info panel. 
Here the blend of green into red shifts some 

darker tone into the red channel by reducing 

red to 70%, and putting back the 30% from the 

green channel.  

The red channel looks very pale – the skin value is very white. 

©  Bobbi Lane 
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I’m going to use another adjustment to achieve 
the same result in an easier way! 

The green channel has a much darker skin val-
ue, so I will blend a bit of that darker tone into 
the red channel using a Channel Mixer Adjust-
ment layer… 

By replacing 30% of the red channel with the 
darker tone of the green channel, I get a darker 
skin value in the red channel (see image at right). 

This technique can work wonders to repair a 
clipped-to-white red channel but it can also make 
the following Curves adjustment easier by elimi-
nating the extra wiggle in the red channel curve. 

After the Channel Mixer blend the extra yellow 
in the skin color really shows up and things look 
worse, but this is just to set up the Curves move 
that follows. 

Now this actually looks worse over all – just 
remember that we’re not done yet! If you are par-
ticularly observant, you will have noticed that 
there has been some retouching applied here—
look at the first image again—I cloned over a dark 
area in the background and smoothed out a rough 
area on her chest! It is almost always best to do 
any retouching in layers underneath any color 
adjustments. If you change the color later, any 
retouching done above the color adjustment lay-
ers would have to be re-done – save yourself the 
extra work and keep the pixel-editing under the 
adjustment layers! At the moment, the color of 
the hair has become overly green by the Channel 
Mixer adjustment, so I’ll take note of that, and 
plan on fixing it later. 

Now for the Curve adjustment… 

Raising the blue value has given the skin an 
appropriately pinker hue by reducing the yellow 
ratio. I always keep an eye on the Info panel while 

I place a point on the curve in the blue channel, and move 

it up, brightening the blue to reduce the yellow value in 

the info panel. 

Using a bit of the green channel into the red channel gives a 

little bit darker skin tone. 

©  Bobbi Lane 

Here is what the image looks like now… 

After a Curves adjustment, the color looks much better! 

©  Bobbi Lane 
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I’m adjusting the color to confirm that I’m doing 
the right thing. 

Here the Info Panel numbers show an ideal 
ratio for the CMY values of the skin color. Cyan is 
between 1/4 and 1/3 of the average value between 
yellow and magenta – yellow is just about 10% 
higher than magenta, good for a fair skinned 
blond. The blond hair has a very slight green cast 
however – this is something to look out for with 
blond hair! It’s very easy for blond hair to take on 
a green cast especially in shadow areas of the 
hair. 

Now this is pretty subtle, but easily fixed with 
a Hue/Saturation adjustment… 

Targeting Yellows, and shifting towards red. 

The subtle Hue/Saturation move eliminates 
the green cast to finish the color correction! 

 

The Info Panel numbers confirm that the 

yellow value has come down and the cy-

an value has gone up! The hair has a very slight green cast mostly noticeable in the 

darker shaded areas. 

©  Bobbi Lane 
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Compare the final corrected image to the origi-
nal… 

The final image seems much “cleaner” and cer-
tainly more natural! 

Most people wouldn’t have thought that the 
original color was particularly bad, and most pho-
tographers wouldn’t have bothered to correct it 
any way! But it pays to apply a little numerical 
analysis to any image, just to see if there is any-
thing that could stand some improvement. 

Sometimes I am surprised to find 
problems when my first impression 
was good, but one can almost al-
ways improve on a default render-
ing, and you never know how good 
an image can look unless you try! 
The take away here is the Channel 
Mixer adjustment – try correcting 
the original image with a single 
Curve – its possible to improve 
things, but it requires a more com-
plex multi-point shape in the red 
channel curve because the point has 
to be placed very high up, near the 
upper end point, and its hard to 
move that point without damaging 
other parts of the image! The Chan-
nel Mixer fixes the problem of red-
saturation easily and makes the fi-
nal curve very simple! You can grab 
a copy of that first image with a 
right-click, just remember that eve-
rything on this site is copyrighted & 
this particular image is ©2014 by 
Bobbi Lane! 

Have fun with your pixel wran-
gling! 

Lee Varis 

Text © Lee Varis 

Images © Bobbi Lane 
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Many people don't go beyond the basic editing 
techniques in Lightroom. Lightroom can do much 
more than simply adjust exposure, fix blown 
highlights, open up shadows, change white 
balance and add contrast!  This session is geared 
towards those who want to take their editing to 
the next level and do more with their images as 
well as add creative style effects without ever 
having to launch Photoshop or other editing 
software. 

Simulate the Look of a Polarizing 

Filter 

I will cover how to simulate the look of using a 
polarizing filter to enhance skies and bring out 
the color without using a filter on your camera 
lens in the field. The sliders in the HSL panel are 
ideal for this. Instead of just moving the blue 
slider in the HSL panel, I will show you how the 
targeted adjustment tool works for this purpose 
as that tool is designed to analyze the colors and 
tonality on specific parts of the image without 
affecting other colors/tonalities so you can 
achieve more precise results. 

The HSL Panel 

First, it is important to understand the 
difference between Hue, Saturation and 
Luminance.  Let's look at the color blue as an 

Select Luminance in the HSL panel. Click on 
the targeted adjustment tool (TAT) in the upper 
left hand corner of the HSL panel to activate and 
then place it over the area with the color you want 
to affect on your image. In this case, we'll place 
the TAT on the blue area of the sky. Now, click 
and hold and while holding, slide the cursor up or 
down to adjust the lightness or darkness of the 
particular color. For instance, if I want to deepen 
the blue color in a sky, I would click on the TAT to 
activate and place it on the blue portion of the sky 
and then I would click and hold and slide the 
cursor DOWN to deepen the color blue (or slide 
up to lighten the blue color).  You may also notice 
that the aqua slider is also moving if you are 

example. By clicking on Hue and moving the 
various sliders, you are changing the actual 
color.  For example, you can change the hue of 
blue to make it appear more green.  Saturation 
affects how saturated a color looks and you can 
make the color blue more saturated or less 
saturated by clicking on Saturation and moving 
the sliders for that color. Luminance, on the 
other hand, affects how DARK or LIGHT a 
particular color looks.  For instance, to make 
the color blue lighter or darker, you would click 
on Luminance at the top of the HSL panel and 
then move the sliders to the right or the left. 

To achieve a "polarizer" look on a sky, we 
will select Luminance since we don't want to 
saturate the blue, but just make it deeper 
and richer. First, navigate to the HSL panel 
and select Luminance.  Then move the blue 
slider to the left to deepen the blue color in 
the sky.  Sometimes I move the aqua slider 
a little.  You can also click on saturation 
and deepen the saturation of the blue and 
aqua colors by moving the sliders to the 
right a bit.   

Targeted Adjustment Tool 

You can also use the targeted 
adjustment tool in the HSL Panel to affect 
colors more precisely and for a Polarizer 
Effect on a Sky. 

Creative Editing Techniques with Adobe Lightroom Classic 
By Betty Wiley (MA) 

in the screenshot below, I show how to add blue color to an otherwise 

blown-out, light sky using the graduated filter and moving the 

exposure and temperature sliders. 
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using this method to deepen the blue color of a 
sky.  This is because the TAT tool may also detect 
aqua tones in the sky in addition to the color blue. 

Click and drag UP to brighten the blue color in 
the sky.  Note you can use this method to darken 
or brighten other colors elsewhere in the image.  

 

this technique has endless possibilities.  I often 
use this technique when I want to add a splash of 
color to simulate out of focus flowers in a 
background for floral images or to make water 
more blue.  Using this technique, you can add 
"blush" and lipstick to portraits and even eye 
shadow! 

First you will darken the entire image by using 
the adjustment brush. Use a lower exposure by 
moving the exposure slider to the left, and paint 
completely over the image so that the image is 
much, much darker.  Then hold down the opt key 
(Mac) or alt key on a PC.  You will see the plus in 
the middle of the circle turn to a minus.now paint 
back (erase) over just the areas where you want to 
reveal the light that you just removed.  This 
technique can be useful for adding rays of light.  
Tip: this works best if you have "Auto Mask" 
unchecked at the bottom where brush settings are 
located. 

Most people think of the Adjustment Brush in 
Lightroom for brightening or darkening areas 
(dodging and burning) of an image but it can do 
so much more.  You can actually "paint" or add 
color to the image using the Adjustment Brush as 
well.  To paint in color, simply click on the 
Adjustment Brush in the tool bar and navigate 
down to the bottom of the basic panel and you 
will see a rectangle with a "x" next to the word 
"color."   Click on the rectangle to bring up the 
color picker window and use the eye dropper tool 
to select the color you want.  Note that if you click 
and hold and drag the eyedropper to an area of 
your image, it will sample that particular color in 
the image. 

Graduated Filter Tool 

I often use the Graduated Filter Tool (found 
at the top of the basic panel where the 
adjustment brush and other tools are located) 
to darken a sky and bring out drama.  I first 
reduce the exposure to taste and then click and 
drag the tool from the top of the image.  If you 
hold down the shift key as you drag it will keep 
the line straight.  Sometimes, I also like to add 
a little blue to a sky by moving the temperature 

slider to the left (towards blue). 

"Tilt Shift Effect" or To Add Blur 

to Photos 

This is a fun effect which can be used to 
blur the bottom of an image to simulate a 
shallow depth of field or to create a "tilt 
shift" look to an image.  Start by clicking on 
the Graduated Filter Tool.  Move the clarity 
and sharpening sliders all the way to the 
left.  Now click and drag from the bottom 
up (or from the top down).   

Painting Light/Dramatic 

Lighting Using the Adjustment 

Brush 

While I'm on the subject of enhancing 
skies, another technique which I will show 
you involves adding color, such as a nice 
blue color to otherwise, colorless, light grey 
or whitish skies.  I will also show you how 
to add color at the horizon line for sunset 
and sunrise images.  I will also demonstrate 
how to "paint" in color on your images and 

screenshots above showing use of the targeted adjustment tool to 

deepen the blue of the sky and creative a "polarizer" effect. 
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"Selective Color" Technique 

Use this method to desaturate part of the 
image but to preserve color in a particular area 
(e.g. black and white image of a garden with a 
red rose where the color red on the rose is 
preserved). 

Use the Adjustment Brush but select 
"saturation."  Move the saturation slider all the 
way to the left and paint over the image to 
remove color.  Remember to uncheck "auto 
mask" so it doesn't try and find edges.  Then 
when you get close to the area where you want 
to preserve color, reduce the brush size and 
click on "auto mask" so it will find the edges on 
the object with color. 

Painting on Warmth  

Use the Adjustment Brush and select 
temperature, similar to what we previously did to 
add blue color for skies. However, this time we 
will move the slider to the right (yellow color 
spectrum).  Then brush on the areas where you 
want to add a warm "glow."  I will do this to add a 
warm glow to windows, street lights, etc and also 
to add more color at the horizon for a sunset, etc.   

Painting on Cooler Blue  

Use the Adjustment Brush and select 
temperature.  Move the slider to the left (i.e. 
making the temperature cooler or more blue).  I 
will do this when it's cloudy or overcast resulting 
in a greyish or colorless look to the water.  You 
can also select a blue color at the bottom of the 
basic panel by clicking on the rectangle next to 
the word "color" at the bottom of the basic panel.  

Using the Radial Filter Tool 

To create a dark or colored vignette effect 
around your subject or around the borders of an 
image use the radial filter tool.  Draw an oblong, 
circle around the image and reduce the exposure.  
This will darken the area in a graduated fashion.  
Remember you can move, shape the circle 
anyway you want.  If you want to confine the 
filter to the borders of the image, hold down the 
command key (Mac), control key (PC) and 
double click inside the radial filter.  Now you can 
place your cursor inside the circle and move it 

around and then apply the affect (e.g. exposure) 
you want.  You can also use technique to add a 
blur to the edges of an image or even color.  
Remember, if you check the box for "invert," it 
confines the effect to the INSIDE of the circle or Once the desired shade of blue (or any other 

color you choose) is selected, the rectangle next 
to the word "color" at the bottom of the basic 
panel will reflect that particular color. 

Blurring and Smoothing 

Backgrounds 

Use the Adjustment Brush with 
sharpening slider all the way to the left and 
Clarity slider moved to the left about 
halfway or more, to taste.  Make sure auto 
mask is turned off at the bottom at first as 
you paint over the background with a large 
brush.  When you get closer to the object 
that you want in focus, switch to a smaller 
brush size and click on auto mask so it 
protects the edges of your subject.  
Remember, the effect is cumulative so if 
you don't get enough blur, hit "done" and 
go over a second and even a third time. 

In the example of the little girl whose face was dark when I took the 

image, I simply added "light" by using the radial filter as shown 

below. 

I sometimes use the Radial Filter instead of the Adjustment Brush to 

add warm light or color as well. 
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oblong shape.  If you want to apply the effect on 
the outside, make sure that "invert" is unchecked. 

Adding dramatic light selectively using the 
Radial Filter Tool is a favorite technique of mine 
and I use it often for landscapes and portraits. 

To add light:  increase exposure and draw a 
circle with the radial filter tool but to confine the 
light to the inside of the circle, click on "invert."  I 
use this a lot to brighten faces or add light to 
particular areas in a landscape. 

Adding "Sun" 

I often like to add "sun" to a corner of an 
image to simulate a bright sun outside the 
frame which is casting light onto my subject.  
This is very easy to do by simply grabbing 
the radial filter and clicking to drag out a 
circle.  I then adjust the temperature slider 
to the right for a warm tone and increase the 
exposure slider.  Note that you will want to 
make sure you have the "invert" box checked 
at the bottom so that the effect is confined to 
the inner portion of the circle and not the 
outside.  Also, make sure you have feather 
setting at 100. 

Pseudo-HDR Grunge Look 

Another favorite technique of mine is 
to create a "pseudo-HDR" or grunge-
type look.  I find this to be particularly 
useful for images of machinery, cars, 
trains or abandoned buildings.  This 
look is surprisingly easy to create and 
simply involves moving several sliders 
in the basic panel and depending upon 
the look you want, you can also boost 
the saturation by moving the 
saturation slider as well.  The rationale 
for using the shadows slider in the 
basic panel is that you first want to 
open up your shadows so that they 
become mid-tones.  Then, adjust the 
clarity slider as necessary to bring out 
the details in the mid-tones and 
achieve the look you want. 

Great for cars, anything with chrome, 
metal. 

screenshot above shows the use of the split toning panel to add 

warm tones to the highlight areas of an image. The two screenshots 

below show the effect that split toning can have to a landscape 

image. 
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toning example screenshot I have provided 
you can see where I've added a warm tone 
to the highlights in this image of a cowgirl 
wearing a fancy glove. In this situation, I 
chose not to add any color to the shadow 
areas of the image. 

Presets 

I will discuss using presets and I will 
show you how to create your own presets.  
There are many websites that offer 
wonderful presets for Lightroom.  Some 
are free and others can be purchased for a 
reasonable fee.  I have provided links at the 
end of this document for sites where I have 
found presets that I like. 

Curves 

Many of you are familiar with using 
curves in Photoshop however, many don't 
use this powerful editing feature in 
Lightroom. I'm going to take you beyond 
using curves to create contrast and I will 
show you how it is possible to affect color 
tones.  For instance, I often add yellow or 
magenta to my sunset images by simply 
using the curves adjustment tool in 
Lightroom and selecting a particular color 
channel, such as green or blue. 

Use of the tone curve can be much more 
precise than using the sliders for highlights and 
shadows.  Right below the tone curve, you will 
see the word channel and next to that, you'll 
probably notice that it says RGB for the red, 
green and blue color channels.  Many people 
don't realize that if you change the channel 

Move the shadows slider to the right (I usually 
move it all the way, more or less) to open up 
shadows and reveal mid-tones. 

Next, grab the clarity slider and move to the 
right (to taste) 

I then increase the saturation slider as well. 

Split Toning 

Split-Toning involves adding color to the 
highlight and/or shadow areas of an image. By 
using the split tone sliders, you can create some 
of the popular looks that you see on Instagram 
and other forms of social media.  The split-tone 
sliders have their own dedicated panel (located 
below the HSL/Color/B&W panel).  For example, 
you can add a cool blue tone to the darker, 
shadowy areas and a warm, yellow tone to 
highlights.  Using a combination of cool and 
warm tones can result in a very pleasing effect. 

Navigate to the split-toning panel in the 
Develop module. You can move the hue slider to 
the color range you want and then move the 
saturation slider to adjust the intensity. You can 
do this for highlights or shadows or both. Another 
way to do this is by clicking on the rectangle next 
to  "Highlights" or "Shadows."  If you move your 
cursor into the color picker window that appears, 
you'll notice that your cursor changes to an eye 
dropper tool.  Click on the color that you want 
and then adjust the saturation slider as necessary 
to adjust the intensity of the effect.  You can 
follow the same steps to adjust the tones in 
shadow areas by clicking on the rectangle next to 
where it says "shadows."  Tip:  you can also 
preview what the effect will look like by simply 
holding down the option key (mac) or alt key (pc) 
and moving the saturation slider.  In the split 

from RGB to an individual color channel, such as 
blue, you can affect color.  For instance, on a 
color wheel, the opposite of blue is yellow.  So, 
that means if you change to the blue channel 
(instead of RGB), and click and drag the upper 
portion of the curve downwards, you will add 
yellow to your highlights.  If you were to drag the 
curve upwards, you would be adding more blue 
color to the highlights.  If you want to add 
magenta to your image, you can follow the same 

screenshots above show the new location for profiles in the Develop 

Module as well as the various creative options when you click on 

"browse". 
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analogy.  Except you would select the green 
channel and drag the slider for either the 
highlights or shadows down to add magenta 
(since magenta is the opposite of green on the 
color wheel).  If you dragged the slider upwards, 
you would be increasing the green colors in your 
image. 

New Feature – Profiles 

I'll show you the new profiles feature in 
Lightroom, which at the time these notes were 
prepared, were newly announced by Adobe.  
Profiles can provide a great starting point for the 
editing of your images and offer creative choices 
that's weren't previously available in earlier 
versions of Lightroom. 

Adobe recently changed the location of profiles 
to a location that makes a lot more sense.  Now, 
instead of being at the bottom of all the panels in 
the Develop module, Adobe moved them to the 
top in the Basic panel.  In addition, they made 
improvements to the profiles themselves for 
better results.  You can chose a particular profile 
as a starting point and then make further edits 
from there for RAW images.  In addition, by 

Note that you can use the masking tool to 
remove sharpening effects from skies and smooth 
areas.  Hold down the option key (Mac) or alt key 
(PC) click on masking.  Everything will be white 
meaning that sharpening is applied to the entire 
image. Then move the slider to the right to 
remove sharpening effect from skies, etc.  You 
will notice the image turning to black as you 
move the masking slider to the right, the areas 
outlined in white indicate where sharpening is 
being applied. 

Adding a Vignette 

On the Effects Panel, I use post crop vignetting 
in Lightroom to add a vignette to direct the 
viewer's eye to the center of the image (move the 
sliders to the left slightly to darken).  You can also 
use the radial filter for this which is the method I 
prefer.  Handy hint: if you use the radial filter and 
draw out a circle, to fit the oblong to the inside of 
your image, simply hold down the command key 
on a Mac (control on a PC) and double click on 
the inside of the circle.  I prefer this method 
because I can then create and off-center vignette. 
I like to use the radial filter because then I can 
apply a creative vignette such as a blur or even 
color and I can change the center point and shape 
the vignette any way I like by making it more oval 
or more round. 

Betty Wiley 

Text and images © Betty Wiley 

www.bettywileyphotography.com 

For useful links, look at Betty Wiley’s 
bio information at the end of her notes on 
Lightroom Mobile by clicking here 

selecting browse in the profile option 
dialog box, you can also select various 
artistic look profiles for creative looks and 
effects.  Further, you can control the 
intensity of the effect to get just the look 
you want. 

Color Cast and White Balance 

You can use the white balance presets by 
clicking on the two-sided triangles next to 
WB in the upper right section of the basic 

panel.  However, I prefer to use the eye dropper 
tool and you can also achieve some unique 
looks this way. To custom correct or change 
white balance, use the eye dropper tool in the 
basic panel to select a neutral area in the image.  
You can preview the effect in the navigator 
pane at the top left.  I move the eyedropper 
around until I see the effect I want.  (Note that 
if you shoot in jpeg you won't see all the WB 
preset options available but the eye dropper 
tool method will still work.) 

Bleach Bypass Look 

Reduce saturation, increase clarity and 
contrast to taste.  Remember you can save it as 
a preset by clicking on the + in the presets 
dialogue box on the left hand panel.   

Sharpening 

My typical settings are: Amount usually 
around 100, Radius around 1.  Remember to 
zoom in to make sure you are not over 
sharpening the edges. 

http://www.bettywileyphotography.com
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Traditional Still Life Photography 
By Charles Batchelder (CT) 
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Charles Batchelder is a local 

photographer from CT who in 

2002 purchased a small digital 

camera and discovered the new 

world of digital post-processing.  

Upon his retirement, he became 

increasingly obsessed with 

photography and having 

graduated to bigger cameras; he 

decided to seek out others 

similarly obsessed and joined the 

Flagpole Photographers Camera Club in Newtown, CT.  In 

this photographic environment he was able to progress 

as a photographer and to find a niche of unexpected 

expertise as a still life photographer. Charles is also 

conducting a “hands on” session to go with his 

presentation on photographing still life in Photo Ops 

room CC 170 on Sunday -9-11 am.   

Charles Batchelder 

Text and images © Charles Batchelder 

www.facebook.com/charles.batchelder.9 

http://www.facebook.com/charles.batchelder.9
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Photography has been a passion of mine for 3+ 
decades.  Like most people, I started taking pic-
tures of my vacations and of my family, with my 
very first camera, a Fuji XT605. 

I definitely caught the photography bug and 
my interests branched out from family vacations 
to nature photography, landscapes, birds, and 
flowers; travel photography with the goal of cap-
turing the culture of my destinations; and urban 
landscapes…street, people, and decay. 

Since I started with film, I was compelled to 
learn every aspect of development and at one 
point had built my own darkroom so that I could 
process my images.  I have, like many, converted 
to the digital format.  For my nature photog-
raphy, I am a purist…and use post-processing 
software at a minimum.  For all other subject 
matters, digital photography allows such a limit-
less freedom of expression.  Each image can be 
manipulated in multiple ways to express a desired 
mood or state of mind.  Although I don’t have my 
original camera, I do have a collection of antique 
cameras and often shoot film which I process at 
home and then transfer to a digital image. 

In college, I studied and obtained a degree in 
graphic arts.  These studies aided me in develop-
ing perspective and have definitely impacted how 
I compose my images.  I hope you enjoy my gal-
leries, as these are a true expression of how I see 
our world. 

Visualization (Seeing) In Black & 

White  

Learning to evaluate the scene to determine 
whether it would best rendered in black & white. 

Consider the following ideas as we look at im-
ages on the next page from Kenilworth Aquatic 
Gardens, The Palouse and the National Zoo that 
are good candidates for conversion to Black & 
White. 

Subject Matter 

Flow & Rhythm of Subject 

High Contrast Scene 

Directional Light  

Storm Clouds 

Distracting Colors 

Distracting Background 

Photographers that have inspired my Black 
& White work: 

 Cole Thompson  

 Arthur Ransome  

 Tahsin Memis  

 Nathan Wirth  

 Ansel Adams 

Color Photography 

Color photography is very literal.  It depicts 
the world as we see it. 

Black & White Photography 

Black & white photography, on the other 
hand, gives us a new way of seeing as we are 
not being overpowered by the colors in an im-
age.  Removing color from an image takes us a 
step away from reality and towards creating an 
artistic interpretation.  Shape, form, tone and 
texture are revealed to the eye. 

Black & White Photography 
By Geffrard Bourke (VA) 
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Kenilworth Aquatic Gardens 

©  Geffrard Bourke 
©  Geffrard Bourke 

The Palouse 

©  Geffrard Bourke ©  Geffrard Bourke 

The National Zoo 

©  Geffrard Bourke 

©  Geffrard Bourke 
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Software 

 Lightroom 

 Photoshop 

 DXO  

 Nik Collection 

7 Steps to Better Black & White  

Images 

Shooting in Color RAW and B&W jpg 

 

 

 

 

DSLR 

 Color RAW  

 B&W jpg 

 Screens shows color  

 Live View shows in B&W 

for your subject, giving it room to breathe within 
the composition. 

Lighting and Shadows 

Playing with light and shadow can simplify 
forms in order to get a graphic and attractive 
B&W photograph. 

Lines, Textures and Shapes 

Use lines, textures and shapes to help define 
your subject. 

Infrared Photography 

Infrared is another take on B&W. 

Geffrard Bourke 

Text and images © Geffrard Bourke 

GeffrardBourkePhotography.com 

RoadRunnerPhotographyTours.com 

 

 

 

 

 

Mirrorless 

 Color RAW  

 B&W jpg 

 Screens/Viewfinder shows color or 
B&W 

Metering 

Spot metering allows the main subject to be 
correctly exposed and the background dark.  
Not all subjects work with spot metering, but 
for B&W it really helps in the subject stand out. 

Bracketing (HDR) 

Bracketing allows you to pick up more dy-
namic range than just a single exposure.  This 
allows more creative license in post processing. 

Tonal Range and Contrast 

Black and White images should express the 
entire tonal range.  In other words, deep blacks 
and bright whites should be present. 

Simplicity and Negative Space 

Negative space is the area surrounding your 
subject and does not contain much detail.  In 
black and white photography, it would be an 
area of white, black or grey that creates a frame 

Geffrard Bourke (VA) has had 

a passion for photography for 

nearly 30 years.   For his 

nature photography, he is a 

purist, using post-processing 

software at a minimum. For 

all other subject matters, he 

finds digital photography 

allows a limitless freedom of 

expression. Each image can be manipulated in 

multiple ways to express a desired mood or state of 

mind. Geffard will also be co-leading (with Denise 

Silva) a hands-on Photo Walk (pre registration is 

required) involving the use of Neutral Density Filters.  

http://www.GeffrardBourkePhotography.com
http://www.RoadRunnerPhotographyTours.com
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Tom and I love to explore new places, redis-
cover history, and capture the essence of a place. 
We seek to portray what we feel through our art. 
We strive to capture the essence of wherever we 
are. We see the beauty in decay and abandon-
ment. Old, historic, grand, dramatic, unique—
those characteristics draw us to explore the es-
sence of these locations. There is a silence, a rev-
erence if you will, in experiencing grand architec-
ture, seeing machines now mute and motionless, 
and viewing bygone historical eras. 

Urban Exploration 

Urban exploration (UrbEx) is the art of finding 
and investigating abandoned locations. Not all 
locations are technically “urban” or even 
“abandoned.” The term “abandoned” is used very 
loosely. It is not “being abandoned” that attracts 
us to a place; it is the history, beauty, decay, 
charm, and architectural details (which contrast 
drastically with today’s vanilla architecture). An-
other definition of UrbEx is the investigation of 
seldom seen man-made structures. This is a defi-
nition more consistent with our quest, as our sub-
jects may be far from abandoned (like the bus-
tling Grand Central Terminal or the surprising 
drama of the [empty] neo-Gothic Eastern State 
Penitentiary), but these sites count as “unseen” 
because few people stop to appreciate beautiful 
prison architecture or the jaw-dropping details of 

Processing 

Most of the photos in this program are high 
dynamic range (HDR) images. HDR allows great 
detail to be shown in both the highlight and shad-
ow areas of the photograph. All of the photos in 
this program were created using HDR processing, 
long exposures, and/or light painting in order to 
better capture the colors and depth of the scenes.  

Grand Central Terminal, a place that many 
rush through daily. 

Equipment 

Note that all the photos in this program 
were taken with the camera on a sturdy 
tripod. We purchase our gear from Hunt’s 
Photo. A PDF file containing links (and 
discounts) to the equipment we use can be 
downloaded at http://tinyurl.com/cuchara
-gear. A wide-angle lens and a macro lens 
are must-haves. Faster lenses are better 
(f/4, f/2.8) because they let in more light. 
(The Canon 24–70mm f/2.8 is our favorite 
lens; Nikon offers an equivalent fast lens.)  

We also bring knee pads, a remote or 
cable release, lens wipes, flashlights, a 
headlamp (headlamp with RED light: 
http://tinyurl.com/lisatom-headlight), 
and extra batteries and memory cards. You 
might also consider packing a polarizing filter 
or a neutral density filter to remove glare, satu-
rate the greens and reds, or allow more time for 
your image. Tip: Download a PDF of your cam-
era manual to your smartphone so that it 
is always on hand. 

Create Fine Art Images from Historic Places and Rusty Things 
By Lisa Cuchara, HonNEC and Tom Cuchara, MNEC (CT)  

http://tinyurl.com/cuchara-gear
http://tinyurl.com/cuchara-gear
http://tinyurl.com/lisatom-headlight
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You can tone map images using the HDR fea-
ture in Adobe Camera RAW (ACR) in the Creative 
Cloud (CC) versions of Photoshop and Lightroom. 
The resulting tone-mapped image is a DNG 
(digital negative) file which is equivalent to a 
RAW file, which means that you have all of the 
RAW editing tools at your disposal when editing 
the tone-mapped image. Another option for tone-
mapping multiple exposures is Photomatix 
(http://tinyurl.com/cuchara-photmatix; you can 
try Photomatix for free or enter BREAphotos for a 
15 percent discount on your purchase). The Pho-
tomatix website has some good tutorials for cap-
ture and processing: www.hdrsoft.com/real-
estate/. We also use Topaz Clarity and Adjust a 

think you will find this +2, 0, -2 satisfactory for 
95% of situations. An exception, for example, 
would be shooting a theater with very bright 
lights and dark shadows or the interior of a house 
where the house is dark and there are windows 
where the outside light is very bright.  

Set your AEB to -2, 0, +2. You can take more 
than 3 shots by starting off at -2, then you would 
take -4, -2 and 0 and then without moving the 
camera or changing the focus, change the camera 
to +2 and you will get 0, +2 and +4.  You now 
have five (5) images to import into your HDR 
processing software (you can delete or ignore one 
of the two 0's. 

Our favorite scenes for HDR include: 

 Interiors of buildings (architecture): Once 
you see them in HDR you will never look 
at them again! Train stations, abandoned 
places, churches, etc. Interior scenes are 
very contrasty, with light coming in from 
the outside and dark shadows inside.  

 Abandoned places: Once you see them in 
HDR you will never look at them again!  

 Rusty and old things look wonderful when 
tone-mapped for HDR  

 When there is a big difference between the 
shadows and highlights. Exposing for the 
highlights would leave this scene with a 
lot of dark shadows and exposing for just 
the shadows would create blown out por-
tions.  

 Skies and Clouds! There are so many ex-
posures in clouds, this is what first at-
tracted me to HDR! For this you often on-
ly need two exposures, one for the sky and 
one of the foreground. 

lot. Enter code breaphotos at http://
tinyurl.com/ topaz-cuchara for 15 percent off 
Topaz products. 

HDR 

Typically, photographers avoid contrasty 
scenes, preferring to photograph when the sky 
is low at sunrise and sunset, and even on over-
cast days (bright cloudy is the answer to most 
photographers dreams). HDR has changed the 
way I think, because I no longer avoid those 
high contrast scenes. In the past you had to 
choose between the shadows and highlights, 
often sacrificing one for the other. Your photo-
graph would have blown out highlights or dark 
shadows with no details. If the tonal range was 
not too great you could certainly double process 
your RAW file and recover some details in the 
shadows and highlights.  

Photographers have typically dealt with con-
trasty situations by avoiding them, by directing 
and redirecting light and by using graduated 
neutral density filters. But now HDR (High Dy-
namic Range) processing now allows you to 
photograph interiors of buildings and contrasty 
scenes with dramatically beautiful results. For 
HDR capture you definitely want to be shooting 
RAW files. 

http://beforethecoffee.com/bracketing-
number-of-images/ has a good bracketing tuto-
rial and includes a great visual. 

If your camera take 5 exposures --> then try 
setting your bracketing to EV (Exposure Value): 
-4, -2,  0,  +2, +4 (the center will be on 0) 

If your camera only take 3 exposures, then 
increments of 2 can be a good starting place. I 

http://tinyurl.com/cuchara-photmatix
http://www.hdrsoft.com/real-estate/
http://www.hdrsoft.com/real-estate/
http://tinyurl.com/%20topaz-cuchara
http://tinyurl.com/%20topaz-cuchara
http://beforethecoffee.com/bracketing-number-of-images/
http://beforethecoffee.com/bracketing-number-of-images/
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Things to Think About 

 Take multiple photographs at various ex-
posure levels either manually or via AEB 
(auto exposure bracketing).  

 Keep aperture, ISO and White balance 
constant for each series.  

 Auto WB is not good for HDR capture as 
shadows and highlights can have different 
color temperatures.  

 Look at your histogram after every series 
of images, display "blinkies" so you can 
quickly see any overexposed areas.  

 Make sure that you have at least one im-
age where the histogram does not touch 
the left side (exposing for the shadows) 

 Make sure that you have at least one im-
age where the histogram does not touch 
the right side (exposing for the highlights) 

 Merge the photos into an HDR image us-
ing ACR (Adobe Camera RAW) in PS  

 You can also tone mapping your exposure 
in Lightroom. 

 Both PS and LR have older poor HDR fea-
tures, use ACR in PS and Photo merge in 
LR – if you do it correctly it will yield a 
DNG file. 

Creativity 

Creativity comes in many forms, in camera 
(choice of camera lens, aperture, shutter speed, 
white balance, filters, lighting, etc.) and in post-
processing. We often use a wide-open aperture to 
selectively focus on a specific aspect of a scene. 

©  Lisa Cuchara 
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Alternatively, the aperture can be stopped down 
to provide greater depth of field or to create a 
starburst light.  

Tom and I love adding textures (artistic tex-
tures, brush strokes, wood, rust, wallpaper, pa-
per, water, rain, water drops, cracked mud, etc.) 
to our images to enhance good photographs (not 
“fix” bad ones). As Scott Kelby once said, “There 
is no ‘unsuck filter’ in Photoshop.” To create the 
effect, place your texture file on top of your origi-
nal photo in Photoshop and then change the 
blend mode to one of the 20+ options available. I 
use all of the blend modes, but my three favorites 
for textures are Multiply, Soft Light, and Overlay.  

Creativity can also arise from visiting a place 
more than once. The lighting is different every 
time. Each time you visit, you are also different, 
you come with a different mood and vision, and 
perhaps even an improved skill level. Tom and I 
love going back to a place time and time again. 
Doing so allows us to really get to know the loca-
tion and create images that capturing “the feel-
ing” of the location.  

We lead numerous photo tours and workshops 
with small groups. We would love to have you 
join us at an upcoming location and be inspired 
and learn. For more information, go to http://
tinyurl.com/lisatomworkshops.  

Throughout this program, we have shared a 
variety of creative effects made in-camera and in 
post-processing. We hope that our images have 
inspired you to visit and get to know new “old” 
places and that our lessons will compel you to 
capture HDR images and paint with light. Moreo-
ver, it has been our goal to inspire you to create 
art from decay. We hope that we have enthused 

 

Above:  Auto Exposure Bracketing (AEB) set to three 

images. Your camera will take 3 exposures, one dark, 

one light and one properly exposed. 

Below:  Auto Exposure Bracketing (AEB) set to seven 

images. Your camera will take 7 exposures, three 

dark, three light and one properly exposed. For  

cameras that take 3, 5, or 7 AEB, you can shift the 

starting point to get easily 9, 10, or 14 exposures. Or 

use Manual and adjust your shutter speed.  

...continued on page 130 

One way to find new locations to photograph is make 

an old place new by visiting it after dark. For example, 

visiting on a late Fall night allowed us to view these 

architectural enchantments under, literally, a different 

light. Cemeteries are a place to remember loved ones 

and honor the past, but they are much more than that, 

with grand art, architectural, and landscape designs. I 

used the Smith-Wesson Galaxy 12-LED  http://

amzn.to/22x-1l0e to light-paint green the Clark Monu-

ment. With an exposure of ~2.5 minutes, we can see the 

beginnings of star trails (yes, even in the light-polluted 

Bronx) and the streaking of the clouds across the sky. 

©  Lisa Cuchara 
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Seven exposures were taken. You can see the histogram all the way to the left in the underexposed images 

(exposing for the highlights), the middle image, 0, as properly exposed, and three images overexposed 

with the histogram to the right (exposing for the shadows). You want to capture one image where the 

histogram is not touching the left and another where the histogram is not touching the right. The eighth 

image is the final tone mapped image showing details in the shadows and in the highlights.  

When out photographing we seek shadows. 

However, many of the places that we shoot 

are very dark or even pitch black. This lack of 

light allows us to get creative and introduce 

our own shadows and light. The basement of 

this opera house was very dark (in certain 

areas totally dark) so I placed my favorite 

light, my Savage LED, in the office to make 

the light to spill out through the partially open 

door and transom, making it look like the 

clerk’s office was open late. 

©  Lisa Cuchara 
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Left: One exposure, details in both 

the highlights and in the shadows 

are lost. 

Right: Five exposures blended 

(tone-mapped).  Now the details in 

both the highlights and in the 

shadows are evident.   Tone map-

ping is essentially the computer 

deciding which exposure is best 

for each pixel in the image and 

compiling them to create a bal-

anced image like our eye can see. 

©  Lisa Cuchara ©  Lisa Cuchara 

Below: 

When creating panoramas, shoot verticals, overlap images 

by ~33% 

When creating vertoramas, shoot horizontals; again, over-

lap images by ~33% 

Process these in Adobe Camera RAW (or Lightroom in 

PhotoMerge, right next to HDR) to yield a DNG file. 

Use Boundary Warp to fill in the edges and bites resulting 

from the HDR process.  

When creating HDR panoramas, tone-map the RAW im-

ages (the various exposures) first and then stitch the tone-

mapped images.  

©  Lisa Cuchara 
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you with our “Creativity is contagious, pass it on” 
philosophy and our “Don’t shoot what it looks 
like, shoot what it feels like” (David Alan Harvey) 
approach. You can view more details about these 
images in our book Create Fine Art Photographs 
from Historic Places and Rusty Things that is for 
sale here at the conference, at local bookstores, 
and it can also be ordered from Amazon http://
tinyurl.com/lisatom-urbex.  

Lisa and Tom Cuchara 

Text and images © Lisa and Tom Cuchara 

www.PhotographyByLisaAndTom.com 

Lisa Cuchara, HonNEC (CT) 

who along with her 

husband Tom, are the 2018 

NECCC Conference 

Chairmen.  They are known 

throughout the  New 

England Area and beyond 

for their expertise in 

photography and in 

Photoshop, and for their 

informative photo tours, 

classes, and workshops. 

She is very active in local, national, and international 

photography organizations and her work has been 

accepted into the Professional Photographers of 

Association (PPA) loan collection.  Lisa and Tom have 

published two books with Amherst Media, Create 

Fine Art Photographs from Historic Places and Rusty 

Things and The Frog Whisperer  

http://tinyurl.com/lisatom-urbex
http://tinyurl.com/lisatom-urbex
http://www.PhotographyByLisaAndTom.com
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Put Together A Winning Portfolio 

Have a “look.” 

Make Your Photography Collectible 

by themes, triptychs and series.   

Price Your Work Accordingly 

Don’t brand yourself as cheap.   

 

 

Selling Your Photography As Fine Art 
By Peggy Farren (FL) 
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Niche, Niche, Niche 

What do you enjoy?  Find a niche market for a 
ready-made audience.   Example Niches: 

 Pets or specific animals or breeds 

 Spiritual or religious 

 Wine lovers 

 Vintage car buffs 

 Tournament fishing 

 Extreme sports 

 Your home town 

Understand Your Buyer 

Why are they buying art?  Emotional triggers 
help sell art.  Brainstorm as many emotional trig-
gers as you can come up with.  Write them down.  
Include them in your stories.   

Joe Fitzpatrick— Cityscapes at Night 
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You Need A Story  

…behind you as an artist and behind each art 
piece.  Give your buyer something to talk about 
when he shows off his art. 

Make Offers – All The Time 

People need to be led.  “Do you mind if I put 
you on my mailing list?” “Would you like a cata-
log?” 

List Potential Markets And Options 

Choose one or two avenues to begin with. 

 Art Fairs 

 Online 

 Art Galleries 

 Co-op Galleries 

 Stock Photography 

 Art Licensing 

 Corporate Art Market 

 Commissions 

Put Together Systems For Follow Up 

Document everything and stay organized or 
you will burn out.  Especially have a system for 
following up with potential investors.  Quarter-
ly newsletter, email to say hello, friend them on 
Facebook, etc. 

Clyde Butcher’s Story 
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Warm Leads Are Better Than Cold 

Calls 

Who do you know who can make introduc-
tions?  Join your local art association and attend 
the openings.  Network!   

Put Together Your Plan – In Writing 

Hang it on your wall where you will look at it 
daily. 

Peggy Farren 

Text and images © Peggy Farren 

www.UnderstandPhotography.com 

“We Simplify the Technical!” 

The Fastest Route To Selling Your 

Art 

 Specific Niche that has an audience with 
money.   

 Art Fairs 

 

Heather Pilkenton at her booth 

Peggy Farren (FL) is an 

award winning, professional 

photographer, instructor and 

speaker. She is the host of 

The Understand Photography 

Show that focuses on travel, 

nature and fine art 

photography.  You can see 

her pictures gracing the 

covers of many local 

magazines, as well as 

national publications. With a 

motto of “We Simplify the Technical,” Peggy has a 

way of simplifying the technical side of photography. 

Along with her presentation “Selling your 

Photography as Fine Art,” Peggy is also conducting  a 

hands-on session on Abstract Photography in Photo 

Ops room CC 168 (lower level) on Friday – 1:30 pm – 

4:30 pm.   

http://www.UnderstandPhotography.com
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Develop “You-Attitude” In All Your 

Business Dealings 

“You-Attitude” means that you are always 
thinking of what benefits you can provide to oth-
ers. 

 Produce products that provide strong ben-
efits to your customers. 

 Market your products based on benefits 
rather than your credentials 

 Write emails and letters that focus on the 
recipient 

 Follow-up with customers and business 
partners with personalized thank you 
notes. 

Learn To Write Effectively 

Writing well is one of the most important as-
pects of publishing, including self-publishing. 

 Read a lot, focusing your critical eye on 
how others write effectively 

 Take courses at a local college or  
university 

 Find and work with peer editors on all  
important documents 

 Follow-up with anyone who helped you 
succeed with gratitude. Send thank you 
notes, offer them services, or send them 
gifts. 

Build Partnerships 

People are not successful on their own. Team-
work is always necessary. 

 Find what partners can help you succeed. 
Propose work together by showing how it 
helps them and you. While you should al-
ways share what benefits your partner will 
receive, partners can be suspicious if they 
don’t clearly see how their involvement 
benefits you. 

 Show appreciation for your partners any 
time you succeed. 

 Connect your partners with other part-
ners. They will appreciate you connecting 
them with other winners. 

 If a partnership is not working out, recog-
nize this early to cut losses. Then find an-
other partner. 

 Make your writing concise and focused 
on “You-Attitude” 

 Become proficient at One Page  
Proposals 

 Follow standards for all business prac-
tices 

Ask Stakeholders In Your Success 

To Help You With Your Publishing 

Identify the people around you who can aid 
you in achieving you publishing goals and then 
ask them to help you. 

 People are usually very willing to help. 
Ask for assistance, and do it with an in-
viting smile. Even smiles can be heard 
over the telephone. (If you don’t know 
what this means, try recording your 
voice saying something. Then record it 
while smiling. You’ll hear the differ-
ence.) 

 Look closely for the people who will 
benefit from your success. Asking them 
for help is mutually beneficial. Before 
you ask for assistance, identify how your 
success will benefit others; then make 
sure to share these benefits as you see 
them as you ask for help. 

Grabbing the Brass Ring of Self-Publishing 
By David FitzSimmons (OH) Sponsored by Sigma  

http://www.sigmaphoto.com/lenses
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Leverage One Success To Another 

Success breeds success. Show potential part-
ners and clients your track record to encourage 
further business. 

 When you succeed, share this success 
modestly but confidently. Successful  
people like to work with other successful 
people. When you have one important 
team member on-board, share this with 
other potential team members. 

 As you succeed, develop ways to share 
your success: blogs, email signatures, 
marketing pieces, and lectures and 
presentations. 

 Played properly, each success will help 
you achieve another bigger success. 

Think Outside The Box 

Sure, you can continue to do what other suc-
cessful people and businesses have been doing, 
but you will find greater success by developing 
your own unique products and services. 

 Study your competition and then improve 
upon some aspect of what they are doing. 
Look for what is not being done well 
enough or what is missing. 

 Give yourself time and space for creative 
thinking. Take walks. Practice meditation. 
Try dream-control techniques. Talk with 
others. Do whatever it takes to get your 
creativity flowing so that you can come up 
with novel ideas.  

 Maintain A Positive Attitude 

Attitude is a huge part of success. 

 If you believe that you will be success-
ful, you will radiate this confidence. 
People around you will see you as a  
winner based on you attitude. 

 Be positive in every situation. If you lose 
a contract, see this as an opportunity to 
improve your proposal techniques or to 
take your business in another (perhaps 
unknown but exciting) direction. 

 Surround yourself with other positive 
thinkers, and avoid being pulled down 
by negative thinkers. 

 Whatever happens, look for what was 
good in the process or outcome and be 
grateful. Even during down times, share 
your gratitude with others. 

David FitzSimmons 

Text and images © David FitzSimmons 

www.fitzsimmonsphotography.com 

davefitzsimmons@yahoo.com 

www.curious-critters.com 

instagram.com/
davidfitzsimmons.photos 

facebook.com/FitzSimmonsDavid 

twitter.com/CCritters 

Sponsored by Sigma 

David FitzSimmons  (OH) is an 

award-winning free-lance 

photographer and writer who 

photographs and writes for 

various magazines, including 

Outdoor Photographer, and 

Shutterbug. With over 100 

calendar credits he is also the 

author of several publications 

which include many Curious 

Critters titles. His books have 

won 14 national book awards 

and sold close to quarter of a million copies. One of 

nine Sigma Pros in North America, David presents 

seminars and workshops to a wide variety of 

audiences.  Sponsored by Sigma.  Along with his 

presentation, David is also conducting a hands- on 

session on Curious Critters in Photo Ops Room CC 

170 Saturday – 1 pm – 4 pm .  

http://www.fitzsimmonsphotography.com
mailto:davefitzsimmons@yahoo.com
http://www.curious-critters.com
http://www.instagram.com/davidfitzsimmons.photos
http://www.instagram.com/davidfitzsimmons.photos
http://www.facebook.com/FitzSimmonsDavid
http://www.twitter.com/CCritters
http://www.sigmaphoto.com/lenses
http://www.sigmaphoto.com/lenses
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Mandy’s Mission 

Show people things they would not normally 
get to see, to inspire them to do things they would 
not normally do. 

5 Tips to Success on the Road 

 Believe in You 

 Give Yourself Credit 

 Take Chances 

 Work Hard 

 Define Success 

Mandy Lea 

Text and images © Mandy Lea 

www.mandyleaphoto.com 

Sponsored by Nikon 

The Nomadic Photographer 
By Mandy Lea (Nomad) Sponsored by Nikon 

Mandy Lea leads a nomadic life 

and has been on the road for 

nearly two years.  After 

spending years at Precision 

Camera in Austin, her 

wanderlust became 

unavoidable and she left to 

pursue freelance landscape 

photography while living out of 

her teardrop trailer. Her 

photography has been featured 

in photo and outdoor themed 

magazines, corporate advertisements, podcasts and 

television. When not on assignment she teaches in-

the-field photography workshops and speaks at 

events relating to photography and tiny living. 

Sponsored by Nikon  In addition to her camera college 

presentations, Mandy will be one of your co-hosts at 

the Panel Discussion Saturday in Thompson 102 at 2 

PM and is a Conference Speaker Image Reviewer.  in 

addition she will have her “Teardrop” trailer outside 

the Campus Center for you to tour Saturday 8:30 to 

11am.    

©  Mandy Lea 

©  Mandy Lea ©  Mandy Lea 

http://www.mandyleaphoto.com
https://www.nikonusa.com/en/index.page
http://www.nikonusa.com/
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Macro photographers often hang up their cam-
eras during the winter months when the blossoms 
and the bugs disappear, but it can be one of the 
most lively and magical times to shoot small 
things. From snowflakes to freezing soap bubbles, 
frost and other sculptures in the ice, there is so 
much to explore.  

Soap Bubbles  

Freezing soap bubbles are the most approach-
able subject to work with, requiring very little in 
special equipment – you might already have eve-
rything you need. The first step is getting a sub-
ject worth photographing, and that requires a 
specific bubble mixture: 

6 parts water 

2 parts standard dish soap 

1 part white corn syrup 

The first two ingredients will create a normal 
bubble solution, but these bubbles are likely to 
burst on impact with the snow. The white corn 
syrup functions as a cushion when the bubble is 
blown correctly and prevents the bubble from im-
mediately being destroyed when it lands. I have 
heard of others using glycerin as a substitute for 
the corn syrup, but in either case you need this 
extra ingredient to toughen up the bubble. 

Bubbles can be blown through a bubble wand, 
but the results are unpredictable. The best tech-

from the frame. In microscopy you’d call this 
“dark field illumination,” allowing for the effect of 
the light to be seen without directly seeing the 
source. This makes the bubble, as it’s freezing, to 
magically glow. 

The best images are usually made when the 
bubble is partially frozen, when lines of growing 
frost are reaching toward each-other like puzzle 
pieces about to connect. My method generally 
requires a “test bubble” to stand in completely 
frozen while I establish the proper exposure set-
tings and light angle, then a new bubble is blown 
and placed, photographed continuously as it 
freezes. The best image is chosen from the series, 
usually just before it freezes solid. 

nique is with an ordinary drinking straw. By 
blowing the bubble through the straw, you are 
easily able to have the bubble dangle off the 
end of the straw. Simply tap the bubble onto 
the snow (or other desired surface) and it usu-
ally transfers without issue. This allows you to 
carefully place a bubble exactly where you want 
it, and it gives you control over the size as well. 

When should you be doing this? When the 
temperatures drop below -8C or 18F. You also 
need a completely sheltered area with zero 
wind, or a completely calm day. I usually 
choose to work with this subject during a calm 
night when I can have greater control over the 
lighting. 

Lighting is key. If you have the ability to 
backlight the bubble with a sunrise or sun-
set, I’m envious. I use very bright LED 
flashlights to illuminate my freezing soap 
bubbles, and a “sheet magnifier” (also 
called a Fresnel Lens) to refocus the light 
beam to hit just the bubble itself. A single-
LED light works best for this, not the 
flashlights with a cluster of LEDs. 800 lu-
mens+ is ideal to ensure a fast enough 
shutter speed. I’m a fan of the NiteCore 
SRT7GT flashlight, but there are countless 
options. 

When lighting, you want the flashlight 
almost directly behind the bubble, but just 
enough off-center that you can exclude it 

Frozen Magic: Universe at Our Feet 
By Don Komarechka (Ontario, Canada) 

©  Don Komarechka 
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Procedure 

Focus and framing is done handheld, by mov-
ing the camera forward and back. Autofocus is 
largely unreliable and will often hit the back of 
the bubble instead of the front. Seeing the focus 
perfectly in the viewfinder is tricky, so a gentle 
sway forward and back as you shoot will give you 
some focus options to choose from afterwards. 
This no-tripod approach is freeing, compared to 
being locked on a tripod. Every bubble behaves 
differently and you need to work fast to find the 
perfect angle of shooting – they freeze solid many 
times in under 10 seconds. 

Since freezing soap bubbles can be rather 
large, a standard macro lens or a normal lens 
with extension tubes is more than enough to get 
you where you need to be in terms of magnifica-
tion. For snowflakes and frost, on the other hand, 
you need everything you can get. 

Snowflakes 

The gem of the winter months, snowflakes of-
fer an unending variety of structure and form at a 
microscopic scale. Often measuring only a few 

Zhongyi Mitakon 20mm f/2.0 4.5X Super 
Macro Lens 

You can also reverse-mount a lens in front of a 
macro lens or adapt a microscope objective at 5x 
magnification in front of a normal camera lens. If 
you own a teleconverter, you can add this to your 
existing macro lens (using extension tubes to cov-
er the protruding lens element that most TCs 
have). There are many ways to get close – do your 
research to figure out what works best for you. 
Most of my snowflakes images are taken between 
5x and 12x magnification, and the most extreme 
work I have done is with a 20x microscope objec-
tive. All of this is done handheld. 

Procedure  

The reason why you should handhold the cam-
era is to find the best lighting angle. Illuminated 

millimeters in diameter, they are also one of 
the most challenging macro subjects to photo-
graph. 

Equipment 

The first challenge is magnification. How 
can you fill the frame with a snowflake? Adding 
extension tubes to a regular macro lens will 
help, but even for the biggest crystals you’ll be 
excessively cropping. How do we push into the 
microscopic world? 

Canon shooters have long had access to the 
Canon MP-E 65mm F/2.8 1x-5x macro lens, 
which gets five times more magnification than 
an ordinary macro lens right out of the box, 
and a set of extension tubes boosts that to 6x 
magnification. In recent years there have been 
a number of third-party lens manufacturers 
that are selling lenses that go beyond 1:1 mag-
nification for multiple lens mounts – here are a 
few to consider: 

Laowa 60mm 2x F/2.8 Ultra Macro 

Laowa 25mm F/2.8 2.5x-5x Ultra Macro 

©  Don Komarechka ©  Don Komarechka 
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with a ring flash, the surface of the snowflake will 
only reflect light back to the camera at very spe-
cific angles, like glare on a window. You need to 
rotate the camera around the snowflake as the 
center of the rotation in order to find this sweet 
spot – the snowflake will shimmer and showcase 
all of its texture contours. You also need to work 
quickly as snowflakes are actively sublimating – 
evaporating back into thin air the second they 
begin to fall to Earth. 

You’ll likely only get a tiny sliver of focus in 
any given image because of the angle required, so 
focus stacking is a huge benefit. The average 
number of images I use for focus stacking purpos-
es is 40, though it has been as many as 70. Since 
I’m shooting handheld, I don’t know if I have all 
the slices I need, so drastic overshooting is re-
quired. On average, 200-300 photos of each 
snowflake are taken. If that seems excessive, it is. 
But if you have the perfect snowflake with a line 
of soft focus running through it, you’ll understand 
why it’s necessary the next time you shoot. 

These snowflake photographs are all taken on 
a homemade black mitten. The black fabric gives 

like a stained-glass window. The more you experi-
ment, the more ideas you’ll get!  

Don Komarechka  
Text and images © Don Komarechka 

www.donkom.ca 

contrast to the subject while the fibers often lift 
the snowflake away from the background. Since 
only one or two fibers are making contact with 
the snowflake, the mitten also acts like an insu-
lator and prevents the snowflake from melting 
when the temperatures are near the freezing 
point. 

In order to isolate a single snowflake, it’s 
easy to use a small artist’s paintbrush to clear 
away any debris. The paintbrush can also serve 
as a visual guide: once the snowflake has been 
isolated, lay the brush down pointing to the 
snowflake, but far enough away that it will not 
show up in the image. Through the camera 
viewfinder you don’t need to find the snow-
flake, you just need to find the brush and follow 
it to the one you’re after. 

Frost can often be photographed using the 
same techniques as snowflakes, and you can get 
creative with a little bit of science as well. Ice, 
with certain structures and thicknesses, can 
create colourful patterns when cross-polarized. 
A recent experiment with ice that formed in an 
old mop bucket resulted in an image that looks 

 

Don Komarechka traveled from 

Canada to be here with us this 

weekend. From auroras to 

pollen, insects to infrared, much 

of Don’s photographic 

adventures reveal a deeper 

understanding of how the 

universe works. Exploring the 

world that we cannot see with our own eyes has been 

a common thread in Don’s career as a professional 

photographer.  Don is also conducting a “hands on” 

session to go with his presentation on photographing 

frozen snowflakes in Photo Ops room CC 168 (lower 

level) on Saturday 8:30-11:30am.  

©  Don Komarechka ©  Don Komarechka 
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Social Documentary Photography 

With so many photographs available on the 
internet, it is important to find a unique and 
interesting way to tell a story about a destination 
and its inhabitants. Rather than focus on 
“destination images,” I think of the photography I 
do when I travel as social documentary. As a 
photographer, you can achieve this unique look in 
a couple of different ways – by using 
photographic techniques that help emphasize 
your message and by digging deep into the 
changes happening to the local culture.  

photography connections to grease the wheel are 
critical. 

Shaping The Light 

Since the vibrant colors of Cuba are a part of 
the island’s look, I decided to incorporate them 
into my project as a way of differentiating my 
images.  I wanted an upbeat, happy tone to the 
story I was telling and I knew that the bright and 
open colors would convey that message.  
Whenever possible I added my own light source, 
not a simple, small speedlight, but a large battery 
operated Profoto unit in either an umbrella or 
octabank. Although having my assistant carry a 
large light source through the Cuban streets was 
not easy, the quality of a large source looked 

Research 

Researching your destination before you go 
is a must.  This pre-planning enables you to 
find subjects that will help illustrate your point 
of view. I have been going to Cuba since 1997 
on assignment for the National Geographic 
Magazine. Although the subject matter for 
those assignments was predetermined, I was 
able to tell the story, creatively through my 
images.  

When Cuba started to “open up” as a 
destination, the number of photographers 
going to the island increased. Suddenly the 
floodgate burst with photos of old cars, paint 
peeling buildings and colorful people, all 
announcing Cuba. 

I decided to focus on baseball in 2013, when 
I realized that change was rapidly coming to the 
Island. Since baseball has been part of the 
Cuban culture for almost as long as in the US, I 
wanted to document the purity of the sport 
before it became a big business. I was lucky 
enough to find a connection to the Cuban 
sports world that opened many doors for me. 
An important part of being a photographer is to 
find connections that can make your picture 
taking easier. If you have to spend more time 
getting permissions and doing logistics than 
taking photos, you are being inefficient. As a 
photojournalist, documentary or travel 

Taking World Class Cultural Images 
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great. In many instances I also wanted to 
overpower the natural daylight and I needed a 
powerful light source to do so. And in addition to 
shaping the look of the light the big, diffused light 
source also made my colors pop.  

Wait For The Moment To Happen 

Having the luxury of time on a long-term 
project means you can play the waiting game. To 
achieve dynamic images you need to wait – as a 
photographer, being obsessive compulsive is a 
normal trait. If you find a situation that has 
potential, then wait. Wait for the better light, wait 
for your composition to come together, wait for 
the moment to happen. And to achieve all of 
these, you really need to wait. It is the addition of 
a lot of small, yet important elements that make a 
strong image. Just as it is the addition of ‘bad’ 
elements that can ruin a potentially great photo. 

flashlight and ‘painted’ in the light on the subject 
(the Yurt). You don’t need a very powerful light 
and an old fashioned flashlight with a tungsten 
bulb gives a better color than the newer LED 
flashlights. My exposure for this image was ISO 
4000 f/2.8 for 25 seconds using a 16mm wide 
angle lens. Less is always better when painting 
the light on the foreground subject as you don’t 
want it to be overexposed. 

Easier Access 

I switched to the lighter smaller Sony cameras 
because they are less obtrusive, so it is easier to 
get close to people.  

I don’t like shooting with long lenses; I prefer 
a wider lens where I can get close to someone and 
still include some of the environment. My 
equipment varies from assignment to assignment 
but my standard kit is: 

Sony a7rIII 

Sony a9 

Great Light & Anchor 

When I do shoot landscapes, I try to make 
sure that there is something special about 
them. I like to have either great light or an 
‘anchor’ – something in the foreground that 
will be large and lead the viewer into the image. 
For the photo of the temples and hot-air 
balloons in Bagan, Myanmar, I scouted for a 
nice foreground overview as I knew where the 
balloons would be flying at sunrise. The 
balloons, the sunrise and the great shapes of 
the temples added drama and drew the viewer 
into the scene. Night photography is always 
dramatic and has a different look than the 
traditional landscape. Before I shot this 
Mongolian Yurt, I researched where the Milky 
Way would rise in the sky and then set up for 
the photograph. For an image like this you need 
total darkness, no light pollution as the 
exposure is from 20-30 seconds. A longer 
exposure would cause star trails due to the 
movement of the earth. I find that using a wide 
angle, fast lens gets more of the expanse of the 
sky in your frame. During the exposure I took a 
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16-35mm f/2.8 G master 

24-70mm f/2.8 G master or 

24-105mm f/4 G lens 

70-200mm f/2.8 G Master or 

100-400mm G Master 

I always have a tripod packed and a small 
flash. 

If the job requires more light I bring Profoto 
B2 units with modifiers and stands. 

Carrying extra batteries is important but with 
the new Sony Z batteries and their great 
performance I can carry fewer than in the past. 

Ira Block 

Text and images © Ira Bloc 

www.irablock.com 
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Sports and fast action photography use the 
same tools and methods to catch the winning 
photos.  The first key to great images is great 
glass, the most important part of any camera sys-
tem. The next is lots of practice shooting. Not 
every image is a keeper and not every image will 
win a prize in a photo contest. There will be many 
out of focus images (don’t blame camera or lens). 

There are lots of tools to add to the tool box 
and techniques to practice. Whatever camera sys-
tem you choose to shoot is up to you, but you 
should take the time to really get to know your 
camera as well as possible. Understand exposure, 
metering and reaction time. In a perfect world 
you will shoot the biggest, fastest, most amazing 
camera out there…..in reality shoot what you have 
and what you can afford. 

It’s very possible to shoot fast subjects with a 
slower or entry-level and mid-range camera, just 
get used to the idea you will need to learn how to 
anticipate your next frame. Timing is key.  Also 
taking lots of images helps too. 

So let’s get started ….. 

Full frame cameras or crop sensor cameras, it 
really does not matter. What is more important is 
if you can get a camera with a high frame rate the 
more keepers you will create. Understanding 
depth of field, movement and controlled bursts 
on the shutter and recomposing will get more re-
sults and better images. Slower frame rates will 

I also have a list of wide angle lenses that work 
really well for side lines, tight spaces and close up 
subjects too. Sometimes the up close and person-
al thing works better for an image. That is more 
of a photojournalist thing, photo editors LOVE 
wide angle shots, you immerse the viewer into the 
scene. 

I also use a mono pod more so than tripod for 
many reasons, one being—on a professional field 
tripods are a no no. Besides the mono pod allows 
you to be mobile and functional. I do have a spe-

require you to pay close attention to movement 
and learn how to anticipate the next shot. 

So I have a long list of lenses that I will go to 
depending on the event that I am shooting or 
where I might be traveling to shoot that event.  
In a perfect world, I would have a MONSTER 
roller bag and take it all at one time, but in re-
ality only pack what you need to shoot with, the 
bag gets heavy fast and you have to worry about 
securing your gear. 

I have a bunch of different long telephotos 
that I like to work with and 
each gives a different angle 
of view and need for differ-
ent places. While some 
might be too long for an 
event, others can be too 
short by a lot. That said 
there is a list of short zooms 
that fit in the mix as well. 
Something important to re-
member is that the days of 
single length lenses being 
better than a zoom are over. 
Some telephotos perform 
better and give advantage to 
being versatile and very 
functional. Plus with the 
ISO capabilities of today’s 
cameras you don’t always 
need an f/2.8 lens to shoot 
an evening event. 

Sports and Fast Action Photography 
By Marc Farb (NY) Sponsored by Sigma 
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cific model that I use for being able to shoot a 13 
pound beast on any terrain. 

The last little tool that is a must for working in 
bright light is the Hoodman loop, this allows me 
to look at images on my LCD in really hard light 
so I know if I got the shot or not and how to fix 
exposures too. 

Some of the go-to lenses that I am working 
with are the 150-600mm lenses, there are two 
versions and a small list of differences.  Another 
lens is the 120-300mm f/2.8 with a constant 
f/2.8 through the whole range and minimum fo-
cus distance of just 7 feet which makes it a serious 
workhorse for more than just sports. 

mmmmmm, Bokeh. Shot with a long telephoto 
lens, breaks the myth about variable aperture 
lenses not being able to produce pleasing bokeh.  
Not only can you get bokeh with a fast prime lens 
you can achieve pleasing bokeh using a long tele-
photo lens. 

Safety is important!!!! 

Shooting bull riding is fun, but distance and 
safety are at a premium here. Using the 300-

Positioned almost on course (dangerous) 
about 15 yards from car at this point, passes me 
within 20 feet of where I am standing. Close 
enough to get sprayed with dirt and gravel. Time 
to throw in the dust and weather sealing. 

This is where I shoot MX from….on the track. I 
like getting close to shoot short, wide and fast. 
There is a very different feel to the images when 
you are as close to the action as possible. The 
wide angle glass also has a different feel to the 
image. Wide angle lenses have more inherent 
depth of field even when you shoot shallow, but 
also allow for more environment in the image to 
tell more of a story.  

This was the shot and the day I decided to only 
shoot on the track with expert riders, not begin-
ners or intermediate…… She lost her line almost 
hit me. I had to dive off a 30 foot high hill to keep 
from getting smashed by the bike. 

More things to be mindful of are changing 
conditions whether it’s the weather or physical 
objects always be aware of your surroundings. 

Techniques that you will work on are panning/
shutter speed/ aperture combinations to get 
sense of motion and showing speed. 

So when we started I mentioned cameras with 
high frame rates. This is where this comes into 
play.  Keep in mind that this applies to all levels 
of sport or action, pro, semi pro or just hobbiest. 
Now for starters, we have all captured TONS of 
great action shots, but when you go back and look 
at them some are okay, some are MEH…. There 
are a few key elements that really make an action 
shot a Sports Illustrated worthy image and that’s 
the one you want to print, frame or get used for 
year books or just hang on the wall and admire 
and brag about. 

800mm lens at f/5.6, I am shooting from the 
back of the coral positioned on the tailgate of a 
pickup truck shooting over the fence. You don’t 
want to be close to 1200 pounds of really pissed 
off steak……All the animals want to do is stomp 
a mud hole in someone. I have watched them 
kick the rider and go for the fence which is at 
least six foot high. One bull made it halfway 
over the fence chasing the rodeo clown.   

Today’s office is the inside of a WWII C-47 
with the marine paratroopers documenting a 
tandem jump for them. We are at 9000 feet as 
the team lead gets ready to drop his marker. 
Yes I am wearing a chute and yes that door is 
open and yes there were no seat belts or tethers 
holding us in…using a rectangular fisheye in 
the plane to get all the details even as they step 
out. 

Using a mid-range zoom to do some BTS 
shots of my friend Lee. Here we are doing year 
book shots on the sidelines. He is shooting ul-
tra wide as the girls come running through a 
line of team mates clapping and high fiving the 
seniors for the yearbook shots of girls college 
lacrosse. Still need to be mindful of surround-

ings easy to step backwards 
on a stick, ball or other gear 
and break a leg or worse 
break the camera gear!!! 

Looks safe right??? Not so 
much, within minutes we 
are in the line of fire for 
cars and trucks hitting 
speeds of 75-95 mph on 
this section of track. Using 
long glass for safety and 
being able to track on sharp 
turns in beginning of 
course. 
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For composition there are times you want to 
position yourself where you can single out the 
player to isolate him/her and use the long glass 
for compression and blur some of the background 
to make the environment less distracting.  

So here are a series of images using my go to 
lens the 120-300mm, There are a bunch of great 
action shots but the ones that would be news wor-
thy are one or both eyes open and in shot along 
with ball or object as close to the release from the 
hand. Remember that frame rate thing by being 
able to shoot 6-10+ frames a second gives you 
that window of opportunity to get a full range of 
motion on the player and get the expression and 
positioning of the body that you are looking for.  

With a slower camera you can do it too but you 
will work much harder for that hero shot and 
need to practice the timing and movements of the 
action. What you will see many times over is that 
the real shot you want is during the mirror black 
out moment when you want the camera to be cap-
turing a new frame. I can’t tell you how many 
times I have watched the killer shot happen in the 
finder but the camera did not capture it. 

So you may or may not have access or want to 
be on the field for safety reasons. But how many 
times is this the image captured. Here is where 
you want to play with manual focus. All AF sys-
tems work on contrast so the camera will attempt 
to focus on the closest thing to the camera regard-
less of if it’s what you wanted or not. By going 
manual, you can hyper focus past the fence mak-
ing it disappear. 

Auto focus on its best day……..bad composi-
tion, should be tighter to get a more personal feel 
and loose distraction of school as best as possible. 
Time to go manual focus. Depending on crowd, 
maybe remind them the difference of manual fo-

cus and manual exposure. Like talking F-stops 
and Bus stops…..  

So by going vertical with a tighter crop and 
more zoom in manual focus I can shoot 
through the fence and make the fence disap-
pear from the image. 

Marc Farb 

Text and images © Marc Farb 
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Connecting With Your Subject 

I think one of the telltale signs of a truly great 
portrait is that the viewer can not only see the in-
dividual being photographed but the viewer also 
gets a feel for the authentic personality of the sub-
ject. You are telling two stories as a portrait pho-
tographer:  how beautiful or intriguing or compel-
ling or striking your subject is and what they are 
really like as a person.  

As a photographer, that combination of story-
telling becomes even more challenging to achieve 
when you are photographing a group or a family. 
In those cases, you are photographing multiple 
individuals as a “one,” as a collection of individu-
als who care for each other and belong to each 
other but are still, nonetheless, separate and dif-

ferent from each other. To pull this off, you need 
to step back and get a better idea of what your 
subjects are truly like and what they each natu-
rally respond to.  

Knowing your subjects means taking full ad-
vantage of that magical door that can open be-
tween you and them. When you make a point of 
showing people that you are genuinely interest-
ed in listening to them, in seeing them, they 
begin to trust you enough to interact comforta-
bly and honestly.  

Author David Augsburger wrote that “Being 
heard is so close to being loved that, for the av-
erage person, they are almost indistinguisha-
ble.” The sense that we are being seen and heard 
is critical to how we perceive the depth of our 
relationship with another person. We all want to 
be seen for how beautiful and interesting and 
worthy we are, and a portrait photographer who 
is already looking for that, who can be trusted 
with that vulnerability, is the one who can pho-
tograph the most powerful portraits of another.  

Think about a time you’ve been in a conver-
sation with another person and felt like they 
weren’t at all interested in what you had to say, 
that they were just going through the motions of 
nodding along to your words. Genuine connec-
tion is pretty much the opposite of that. I note 
this because it’s all too common for photogra-
phers to be so consumed by the technical con-
siderations of a shoot - lighting, exposure, white 

balance, focusing modes, and all - that they al-
most forget there’s a living, breathing person in 
front of them who they are basically ignoring. 
And the last thing you want your subjects to feel 
is alone - with you. Enabling your subjects to 
move away from aloneness, fear, self-
consciousness, and even disinterest, is a critical 
aspect of the portrait photographer’s role.  

The Power of Authentic Expression 
By Tamara Lackey (CA) Sponsored by Nikon, On1, Imagely 
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What NOT To Say  

What is the most common word you hear peo-
ple say when someone lifts a camera to their face 
to photograph someone?  

CHEESE!!!!  

Ugh. That word makes me grimace. (And not 
just because I don’t eat dairy). It’s because saying 
CHEESE is pretty much the same thing as saying 
“Okay, you know the drill! Give me the most fake, 
the most practiced, and the most immediate rote 
response you’ve got ... right now!” Children have 
been especially trained in this particular practice. 
Since near infancy, they’ve learned to grit their 
teeth, pull their lips back and say “Cheeeeese” 
while looking at the camera. So when you lift a 
camera and look towards your subject, why would 
you say something that automatically triggers a 
preconditioned response that isn’t remotely what 
you’re looking to capture.  

The other word you hear a lot?  

SMILE!!!!  

That’s like saying “Okay, this is the time for 
you to act like you are happy for just the instant 
this shutter is clicked. Ready? Okay, everyone 
get together and pretend like you are all happy 
… right now!” If you ever step back and watch 
this common style of interaction, it can be abso-
lutely striking to watch those smiles fall just as 
quickly as the camera falls away.  

Do I want to capture a group portrait where 
only some people are smiling and others look 
miserable? No, not generally speaking. But I al-
so think it’s my job to coach them into a genuine 
expression, at least for the length of time my 
shutter is open. In fact, I consider it a significant 
aspect of what I am being hired to do as a pro-
fessional photographer.  

How do you break them out of a precondi-
tioned response? There are a multitude of ways. 
First of all, start with doing or saying something 
that sparks their curiosity, something that elicits 
wonder or significant interest, something that is 
actually funny or silly or unexpected. Do some-
thing that distracts them from the lens. Or just 
simply use different words. Instead of saying, 
“Smile”, maybe say, “Okay, now, just express 

yourself fully in this moment as transparently as 
you can!” Ironically, it’s cheesy and a bit confus-
ing because it’s also surprising and different - and 
far more likely to garner an actual smile than the 
fake one you were getting earlier.  

When photographing kids who offer their 
clenched smiles with jaws clamped together in 
those nearly painful manners, try recognizing that 
they are just trying to please you. Or their par-
ents. They are trying to do what they think is the 
right thing to do in that scenario. So your job, in 
that instance, is to distract them from what they 
feel like they have to do. And to do so casually and 
comfortably.  

Sometimes when you are working with a very 
resistant subject, it can feel kind of nerve-
wracking to be the photographer. Even anxiety-
provoking. Note this: Kids smell fear. They can 
sense your anxiety, but they don’t really under-
stand it because it seems weird to them that an 
adult would be nervous around them. Because 
that doesn’t really make sense to them. So they 
can translate the energy of a nervous photogra-
pher as someone who doesn’t like them, is off, or 
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makes them feel uncomfortable. And they don’t 
know why! So they go with an even bigger cheese 
smile to try harder.  

And, thus, the maddening cycle continues.  

When I am photographing a smiling-like- the-
fate-of-humanity-is-in-their-teeth child, I imme-
diately try to change the focus. Not in the camera 
but in the interaction. I talk to other people, I 
mention something about a tree, I ask what they 
think of my new camera bag - whatever. It doesn’t 
matter. The point is that I am making myself less 
of the subject of their focus. I don’t want to be the 
subject, I want to be in the background. I want 
them to think of my voice as simply background 
noise, so they can get back to the business of 
simply being themselves. I want them to forget 
the camera is there, so they can truly be their own 
beautiful selves with me.  

Tamara Lackey 

Text and images © Tamara Lackey 
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Portable flash, or speedlights as most people 
call them, can be either very frustrating or very 
creative. Everyone has one, yet most photogra-
phers find them a mystery and don’t like the re-
sults. Learning to use the flash effectively and cre-
atively is easier than it seems! This article covers 
Fill Flash, use of Flash on camera (with and with-
out modifiers) and Flash off camera, using modi-
fiers and radio remotes. Flash can be used in one 
of two ways, as a fill flash, or as a main light. 

 It must be mounted on the camera point-
ing straight at the subject to fill evenly 

 It must be diffused for a pleasing quality 

 It needs to balance with the existing light 
so normally using TTL, the fill flash is set 
to around -1 
stop.  

Fill Flash TTL 

Fill flash means that there is already existing 
light, but it might not be very good quality or 
direction, so it’s not flattering.  There could be 
shadows under the eyes, or the existing light is 
too contrasty resulting in black shadows. Using 
fill flash is easy with only three things to re-
member:  

Portraits with Flash: Simple and Effective 
By Bobbi Lane (MA) Sponsored by Fujifilm 

This series of images show how and why to use a 

fill flash. This image is all natural light partly  

under a tree and partly skylight. The light is soft, 

but the direction is from above, so the eyes are in 

shadow, and there are shadows under the cheeks 

resulting in a mottled skin tone. It’s a lovely setting, 

but not flattering light on her face. 

Next is using a flash on camera with no modifier, 

just straight contrasty flash set at 0. The quality of 

light is very contrasty resulting in specular high-

lights on the skin, and it looks unnatural.  

The Rogue Flash Bender with Diffusion is now  

attached to the flash, so the light is bounced and 

much softer, with beautiful skin tones, and it looks 

natural. The flash in on TTL at -1 stop.  

The flash with the Rogue Flash 

Bender with Diffusion is now off 

camera, being triggered with a 

radio remote, so the direction has 

changed. The flash is now acting 

more like a Main Light instead of 

a fill, even though there still is 

some existing light on her face.  

©  Bobbi Lane ©  Bobbi Lane ©  Bobbi Lane ©  Bobbi Lane 

http://www.fujifilmusa.com/products/digital_cameras/index.html
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Each kind of diffuser you use might require 
different exposure compensation, so doing a cou-
ple of test shots first to adjust the amount of light 
is necessary. This is true of various lighting situa-
tions as well. 

Flash on Camera on TTL (With and 

Without Modifiers) 

We all know what flash on camera looks like – 
contrasty, hard edged shadows, specular high-
lights, flat lighting with no dimension, and with a 

Grid Spots are used to concentrate the light 
into a spotlight, just the same as on a theatrical 
stage.  

The Venice Carnival is a magical place where 
each year hundreds of costumers arrive from all 
over the world to celebrate before the start of 
Lent. The photo of the two sisters is shot before 
dawn, using the Rogue Grid Spot on camera, TTL, 
and using a slower shutter speed to bring in the 
ambient light in the background. Dragging the 
shutter is a technique where the subject is lit by 
the flash and they shutter is set to slower to pull 
in the ambient light. Since the shutter speed is 
slow, let’s say 1/8 or 1/15, the camera can be 

hard shadow behind. There are so many crea-
tive ways to use the flash right on the hotshoe 
using TTL and either bouncing the light or us-
ing a light modifier.  The size of the light source 
is very important to the quality of light, so the 
larger the light source the softer the quality. 

Using the Large Rogue Flash Bender 
(without diffusion) provides a softer light by 
pointing the flash up into the slightly bent 
(hence the name Bender) white material. Any 
time you bounce light, it softens and travels in 
all directions.  

A great technique to use for gorgeous light is to bounce the 

flash off a wall, or a reflector if you don’t have a wall 

handy!  For this image, the flash is on the camera, on TTL, 

and pointed to camera right at a white wall.  This turns the 

tiny little flash into a huge light source, with the flash  

illuminating about an 8 foot area, which bounces back onto 

the subject. It’s lovely skin tones and can light full length  

evenly.  

©  Bobbi Lane 

For this shot, the model is leaping in the air and the 

flash is freezing the movement because the flash 

duration is around 1/2000 of a second. The model 

is placed closer to the background to incorporate 

the shadow, but notice how much softer it is than a 

direct flash. Shot TTL on “0”.  

©  Bobbi Lane 

Using the Rogue Grid Spot, this image of the woman and 

her goose is shot flash on camera, TTL, with grid,  

balancing to the ambient light. The grid is directed just at 

her face and upper body holding the goose. The light is 

contrasty, but can be used very effectively.  

©  Bobbi Lane 
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shaken, or zoomed, or panned to create blurred 
effects on the background with the subject re-
maining sharp because they are lit by the instan-
taneous flash.  

Flash Off Camera on Manual 

Getting the flash off the camera opens up a 
great range of moods, descriptions and effects to 
enhance the story telling portrait. The flash is 
now acting as the main light source on the sub-
ject. The direction of light is used to define the 
form and mood of the subject and the placement 
of the light in relationship to the subject places 
the highlights and shadows.   

This year I acquired the Profoto A1 with the 
shell bounce. I brought it to Venice with me on 
a small stand so I could place it where I wanted 
without having to enlist the aid of my voice ac-
tivated light stand, my fabulous husband, Lee 
Varis. The shell bounces and directs the light, 
similar to a small umbrella.  

For this shot, the double grid was used to narrow the spot-

light and directed at the person on camera left to create the 

feeling that she is lit by the street lamp.  

©  Bobbi Lane 

For this young man in Grand Central Station, the grid is 

directed at his upper body and the lens is zoomed during 

the exposure to create an explosion effect. This takes 

some practice, a lot of trial and error, to get the  

technique just right.  

©  Bobbi Lane 

I’ve been leading a Photo Tour to Venice Carnival since 2012 

and only one year did we have fog. It so added to the  

magical and mystical feeling. I spend a lot of time on the 

ground looking up and this image includes the hazy back-

ground of Doge’s Palace and St. Mark’s square. Shot with the 

Rapid Box off to camera right.  

©  Bobbi Lane 
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Bobbi Lane 

Text and images © Bobbi Lane 

(see next page for Bobbi’s bio) 

www.bobbilane.com   

Facebook: https://www.facebook.com/
bobbilane 

https://www.facebook.com/Bobbi-Lane-
PhotographerEducator-

236096583088791/ 

 

Instagram: https://www.instagram.com/
bobbilanephoto/  

flickr: http://www.flickr.com/photos/
bobbilane/ 

Twitter: https://twitter.com/blanephoto 

YouTube channel: https://
www.youtube.com/channel/

UC0N0ZlUpZYM61wip1VlQpgA 

Google Plus: https://plus.google.com/
u/0/+bobbilanephoto/posts 

 

 

For the image of the girl in the library, the flash is 

mounted on a Westcott Rapid Box, which has a  

difflector plate (makes is a beauty dish) and a  

diffuser. The light is soft, but also has a lot of cover-

age. The placement is above camera pointed  

directly at the subject.  

Using a grid from a low angle from the side makes 

a film noir portrait of the man in a train station. 

The light is low so it’s spooky and he’s only lit by 

part of his face turned into the light.  

The woman with the flowing material behind her 

incorporates both bounce and off camera. The flash 

in on a stand to camera right, pointed into a 3 x 4 

foot reflector. That makes a huge bounced light 

source so she is evenly lit full length.  

All of these images were created using one light off camera, with the camera and flash exposure mode on manual, so that the photographer controls all the set-

tings. Radio remotes have two parts: the transmitter sits on the camera hot shoe and sends out the radio pulse to the receiver, which is attached to the flash. I use 

the Phottix Ares II remotes, which I consider to be the best in terms of reliability and durability.  

©  Bobbi Lane ©  Bobbi Lane ©  Bobbi Lane 

http://www.bobbilane.com
https://www.facebook.com/bobbilane
https://www.facebook.com/bobbilane
https://www.facebook.com/Bobbi-Lane-PhotographerEducator-236096583088791/
https://www.facebook.com/Bobbi-Lane-PhotographerEducator-236096583088791/
https://www.facebook.com/Bobbi-Lane-PhotographerEducator-236096583088791/
https://www.instagram.com/bobbilanephoto/
https://www.instagram.com/bobbilanephoto/
http://www.flickr.com/photos/bobbilane/
http://www.flickr.com/photos/bobbilane/
https://twitter.com/blanephoto
https://www.youtube.com/channel/UC0N0ZlUpZYM61wip1VlQpgA
https://www.youtube.com/channel/UC0N0ZlUpZYM61wip1VlQpgA
https://www.youtube.com/channel/UC0N0ZlUpZYM61wip1VlQpgA
https://plus.google.com/u/0/+bobbilanephoto/posts
https://plus.google.com/u/0/+bobbilanephoto/posts
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Bobbi Lane (MA) is an 

award-winning 

commercial 

photographer with over 

40 years of experience 

specializing in creative 

portraits on location 

and in the studio.  Bobbi 

is known for teaching 

lighting techniques for 

portraits, both natural 

and artificial with any 

method of lighting. Combining her love of travel, 

photography and teaching, she leads international 

photo travel workshops and is the author of several 

portraiture books. Her classes are offered online 

through Craftsy and Peterson School of Photography 

and she is a speaker at conventions across the USA 

and Gulf Photo Plus in Dubai. Sponsored by Fujifilm  

Bobbi is also a pre-conference workshop presenter 

with speaker Lee Varis on “Demonstration- 

Techniques for Real People Portraits” Saturday 

CC163-2pm (Double Session) and is a Conference 

Speaker Image Reviewer.    

For this shot, the shell provided excellent soft coverage from 

a distance since if it was closer then it would be in the  

photograph. I underexposed the background for drama. 

This was shot using the TTL transmitter for Fujifilm  

Cameras.  

©  Bobbi Lane 

The final image in this series is of Karo Tribal Chief in the Omo 

River Valley in Ethiopia. The chief is lit with one flash in a small, 

20” x 20” soft box off to camera left. The shutter speed is high to 

match the background light, about 1/250. The boys in the back-

ground are in the shade but there is still enough light for detail.  

©  Bobbi Lane 
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Photographing strangers can be unnerving. 
What are some of the things you need to know 
before you start pointing your intimating lens in 
someone’s face. 

This presentation will give you some of the 
knowledge and preparation needed to overcome 
your fears. 

One of the questions I hear most often is what 
are your post-processing procedures. I will be 
taking you through capture, my raw editing and 
finally through my final retouching. 

Some of the topics I will be covering: 

 Shooting with available light (I leave my 
flashes in my bag). 

 Understanding your histogram (trust it). 

 Storytelling 

 Noise (both good and bad). 

 Black and White conversions (the do’s and 
don’ts). 

 3rd Party Plugins (Topaz, Alien Skin Ex-
posure X3, Silver Efex). 

 Equipment Choices (From Wide to Tele-
photo) 

 Printing 

 DSLR’s or Mirrorless 

After leaving this workshop, you will have a 
better understanding how not only to be more 

comfortable photographing on the street but to 
be able to get your images to look their best. 

Things to bring 

Laptop/ Mac/PC 

Photoshop (latest version preferred). 

Adobe Lightroom/Adobe Bridge 

Google/Nik Plugins (we will be working with 
SilverEfex/Alien Skin) for B&W 

Alien Skin Exposure X3 

Topaz plugins - Some of these plugins are 
free and have a 30 day trial period as well. 

Wacom Pad/Any Tablet for retouching 

Finally, a slideshow that will touch your 
hearts. 

Since the 2010 earthquake that hit the coun-
try of Haiti, I have made it a personal goal to 
capture and share my experiences that have 
changed my life. We as photographers have the 
power to bring a story to life with just the click 
of the shutter. 

Jim LaSala 
Text and images © Jim LaSala 

(see samples of Jim’s work  
on the following pages) 

www.jimlasala.com 

jim@jimlasala.com 

Working On The Street: Capturing The Whole Story 
By Jim LaSala Sponsored by Moab/Legion Paper/Topaz Labs 

Jim LaSala (NJ) is an 

educator, 

documentarist and 

Moab Master 

specializing in Fine Art 

Photography, 

portraiture and 

electronic imaging. Moab Master Photographers are 

a group of artists connected by their unique visions 

and love of reproducing their images on Moab paper. 

Jim embarked on a Humanitarian Project in 2010 

documenting the people and of Haiti and has been 

involved with One Heart for Haiti, a non-profit, whose 

mission is to give children there the gift of education. 

He has had numerous exhibitions and many of his 

images have made it into the PPA Print Publications 

Loan Collection. Presentations Sponsored by Moab; 

Models Sponsored by Sigma  In addition to his 

camera college presentation, Jim is a pre-conference 

workshop presenter and is a Conference Speaker 

Image Reviewer. He will also be conducting a 

Character Model Natural Light Photo Session (pre 

registration is required)  

http://www.jimlasala.com
mailto:jim@jimlasala.com
https://www.moabpaper.com/moab-masters/jim-lasala
http://www.topazlabs.com/
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©  Jim LaSala 
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©  Jim LaSala 

©  Jim LaSala 
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Conference Special Event Presenters 

(pre-registration is required) 

Special Character Model Photo  
Sessions (Models Sponsored by Sigm a; 
Lighting Sponsored by Savage) 

 Constant Lightening Session with Models: 
Mark Farb, ANEC (NY)  
(Sponsored by Sigma) 

 Natural Light Session with Models:  
Jim LaSala (NJ) (Sponsored by Moab) 

 Lifestyle Portraiture Session with Models: 
Tamara Lackey (CA) (Sponsored by 
Nikon, On1, Imagely) 

Sony Photo Walk: Ira Block (NY)  
(Sponsored by Sony) 

iPhone/Smartphone Hands –On Walk:   
Melissa Fraser (MA) & Charles Needle (CA) 

Photography with Neutral Density Filters Walk: 
Denise Silva (VA) & Geffard Bourke (VA) 
(Filters Supplied by Hunts) 

Conference Speaker Image Critique 

Reviewers 

Hector Astorga (TX) Ira Block (NY) 
Mark Bowie (MA) Ella Carlson (MA) 
Kathleen Clemons (ME)  Jennifer King (NC) 
Bobbi Lane (MA) Mandy Lea (Nomad) 
Jim LaSala (NJ)  Denise Silva (VA) 
John Slonnia (MA) Cusi Taylor (AZ) 
Lee Varis (MA)  Betty Wiley (MA)  

 

 

Pre-Conference Event Presenters 

 
Quick 10 Minute Workflows in Adobe Pho-

toshop CC: Hector Astorga (TX)  
(Sponsored by Santa Clara Ranch) 

Innovative Night Techniques: Beyond the 
Milky Way: Mark Bowie (MA) (Sponsored by  
ADKPI) 

Digital Artistry with Photoshop:  
Ella Carlson (MA) 

The Joy of Selective Focus: Kathleen Clemons 
(ME) (Sponsored by Lensbaby) 

My Backyard-3 C’s Colorful, Creative,  
Conceptual: Darrell Gulin (WA)  
(Sponsored by Canon) 

Photograph Birds of Prey and Raptors:  
Ken Hubbard (NY) (Sponsored by Tamron) 

Macro Water Droplet Workshop:  
Don Komarechka (Ontario, Canada) 

Portraits Unplugged: Natural Lighting  
Techniques -  Graffiti Wall: Bobbi Lane (MA) & 
Lee Varis (MA) (Sponsored by Fujifilm ) 

From Capture to Print: Jim LaSala (NJ) 
(Sponsored by Moab) 

Light Painting Flowers and Still Lifes:  
Jose Leiva (ME)  

Take Control of your Lightroom Workflow: 
Rob Sylvan (NH) (Sponsored by W acom ) 

Creative Editing Techniques in Lightroom:  
Betty Wiley (MA) 

VISION: Capturing Moments on All 7 

Continents 

By Darrell Gulin (WA)  
Sponsored by Canon 

Darrell has been photographing for over 36 years, 
marketing his work for the last 34 years and has 
been a full time Nature/Travel Photographer for the 
last 22 years. He markets his work through Stock 
Agencies, Editorial Markets, Photography 
Workshop/Tours, Seminars and Speaking 
Engagements. His work is represented by 
GettyImages, Danita Delimont Agency, DRK Photo, 
and Super Stock Agency. He is one of Canon's 
Explorer of Light Photographers. He is the past 
President of the North American Nature 
Photography Association (NANPA). He has been 
their keynote speaker and has led many workshops 
and programs at their Annual Summits.  

His photographs have been published in: Outdoor 
Photographer, Newsweek, National Geographic, 
Audubon, National Wildlife, Birder's World, Sunset, 
Nature Conservancy, Popular Photography, 
Natures Best and many more. He has been 
showcased in almost every major nature calendar 
including: Audubon, Inner Reflection, Sierra Club, 
Kodak, Browntrout, Cedo, Nature Conservancy, 
Greenpeace, World Wildlife Fund, and Day Dream. 
He is an accomplished speaker/teacher whose 
credits are too numerous to mention. Also, Darrell 
was featured on Five Canon Photo Safari television 
programs where he taught actors/actresses to 
photograph in the field. He leads the Gulin/Ken & 
Lydia Strange Workshops as well as Joe Van Os 
Photo Safaris. He travels around the world capturing 
special moments photographically. You can learn 
more about Darrell and his images at his website 
below. 

www.gulinphoto.com 

Additional Conference Event Presenters 

http://www.gulinphoto.com
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Jacob Mosser, HonPSA, EPSA, HonNEC (MA)  

Jake has been obsessed with photog-
raphy for the past 45 years and has 
earned top honors from the Photo-
graphic Society of America (PSA), 
NECCC and the Greater Lynn Photo-
graphic Association (GLPA) for both his 
skills with the camera and his efforts on 
behalf of the photographic community. 
He has been the recipient of the PSA 
“Stuyvesant Peabody Award” for his sig-
nificant contributions to pictorial pho-
tography and along with his wife Susan, 
has had the NECCC Conference dedicat-
ed to him. Jake is a member and past 
Chair of the Massachusetts Camera Nat-
uralists (CamNats), past Chair of PSA’s 
Nature Division, and PSA’s Ethics Re-
view Committee, past  President and 
Honorary Life Vice-President of both 
GLPA and NECCC.  A multi Galaxy and 
Diamond Star competitor in Interna-
tional Exhibitions, he has judged and 
lectured throughout the USA and Cana-
da. His work has been published in vari-
ous magazines and calendars including 
the PSA Journal and the Nature Photog-
rapher magazine. Jake is one of the 
three 2018 pre-conference image cri-
tique reviewer and is on the Print Com-
petition judging panel.  

Sarah Musumeci, MNEC (MA)  

Sarah is a member of the Merri-
mack Valley Camera Club and one of 
the 2018 pre-conference image cri-
tique reviewers and a member of the 
Print Competition judging panel.  She 
has been taking photos for most of 
her life, but in the last ten years her 
passion has been architectural, travel 
and portrait photography. She began 
taking interior photographs for small 
Bed and Breakfasts in New England, 
but soon advanced to major hotels in 
Boston and NYC. Having had thirteen 
magazine covers, she has had much 
experience in the editorial world. She 
has given presentations at many New 
England camera clubs, the NECCC 
and Photographic Society of America 
(PSA) Conferences and has been a 
Portfolio Reviewer at the Conference 
for six years. A highly talented and 
sought after judge, she has judged 
throughout New England on the local 
camera club level, over twenty PSA 
and NECCC interclub competitions 
and several International Exhibitions 
in both projected images and prints. 
She photographed and produced the 
conference videos for the past two 
years which have been posted on our 
website, Facebook and YouTube.  

www.smBuildings.com  

Pre-Conference Image Critique Reviewers 

William Barnett, APSA, GMPSA, AFIAP, 
MNEC (CT) 

Bill is a frequent lecturer and judge 
for camera clubs throughout New Eng-
land. He is a member of the Photo-
graphic Society of America (PSA), the 
New Haven Camera Club, and the Con-
necticut Association of Photographers 
and is a VP on the NECCC Executive 
Board in charge of the Interclub Pro-
jected Image Competitions. For his 
work on behalf of the photographic 
community, he was elected an 
“Associate” (APSA) by PSA, and 
“Master Member” (MNEC) by NECCC 
and for his photographic skills he has 
received the distinction of “Grand 
Master” (GMPSA) from PSA and 
“Artiste” (AFIAP) from the Federation 
Internationale de L’Art Pho-
tographique.  Bill is a multi star, dia-
mond and galaxy exhibitor in PSA In-
ternational Exhibitions in four divi-
sions and has earned numerous 
awards both locally and international-
ly. He has written multiple feature ar-
ticles for the PSA “Journal” and his 
work was featured in a “Distinctive Im-
age” author article.  Bill is one of the 
three 2018 Pre-Conference Image Cri-
tique reviewers.    

https://vimeo.com/wbarnett  

http://www.smBuildings.com
https://vimeo.com/wbarnett
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Sponsors of 
the 73rd 
NECCC Annual 
Photography 
Conference  
 
by Dennis Goulet,  
Vendor Liaison 
 

Our sponsors support the 
NECCC Conference in a variety of 
ways:  sponsoring speakers, 
loaning equipment, donating door 
prizes, and providing services. We 
would not be able to organize the 
quality programs that we have 
without their generous 
sponsorship. 

Click on the logo to visit their 
websites. In addition to 
descriptions of their products, 
many manufacturers provide 
articles and video with 
instructions, demonstrations, tips 
and techniques to improve your 
photographic skills and inspire 
creativity.   

 

https://www.acdsee.com/en/index
https://www.adkpi.org/
https://www.alienskin.com/
https://alpinelaboratories.com/
http://www.amherstmedia.com/
https://aperture.org/
http://www.autumncolor.com/
https://support.bayphoto.com/
http://www.blackrapid.com/
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http://www.boltflashes.com/
http://www.camsnappers.com/
http://www.camerabits.com/
http://www.usa.canon.com/home
http://cansoninfinity.com/en
https://www.canvaspop.com/
https://www.cognisys-inc.com/index.php
https://www.delkindevices.com/
https://www.fastrawviewer.com/about-and-features
https://www.rawdigger.com/
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http://www.filterforge.com/
https://www.reikanfocal.com/
http://www.fujifilmusa.com/products/digital_cameras/index.html
https://www.garyfong.com/
http://www.hivedesignfactory.com/
http://hufaholder.com/
http://www.huntsphotoandvideo.com/
http://www.ilex.press/
https://www.imagely.com/
http://imagenomic.com/
https://jcristina.com/?v=7516fd43adaa
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Joe LeFevre Photography  

https://kgear.eogear.com/
http://www.leefilters.com/index.php/camera
http://www.joelefevrephoto.com/Home.html
https://lensbaby.com/
http://www.lenspen.com/
http://www.litra.com/
https://www.meredithimages.com/creative-photography-conference/
https://www.mindshiftgear.com/
http://miops.com/
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https://www.moabpaper.com/
https://www.mpix.com/
http://www.nanpa.org/
http://www.nationsphotolab.com/
http://www.neatimage.com/
http://www.nikonusa.com/
https://www.nixplay.com/
http://shop.nodalninja.com/
http://www.obensupports.com/
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http://www.getolympus.com/
https://www.on1.com/
http://shop.panasonic.com/cameras-and-camcorders/cameras
http://www.photodex.com/
http://www.hdrsoft.com/
http://www.photopills.com/
http://photosol.com/
http://www.mahaenergy.com/
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http://www.precisioncamera.com/
http://www.redriverpaper.com/
https://rockynook.com/
http://www.expoimaging.com/
http://santaclararanch.com/
https://savageuniversal.com/
http://www.sigmaphoto.com/lenses
http://www.sony.com/electronics/cameras
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http://www.squarejellyfish.com/
http://www.takeway.tw/eng/
http://tamron-usa.com/
http://www.thinktankphoto.com/
http://www.topazlabs.com/
http://www.vellogear.com/
https://www.videomaker.com/
http://www.wacom.com/
http://www.fjwestcott.com/
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Notes: 

https://www.whcc.com/
https://www.tripodhead.com/
http://www.skyhuntersinflight.com/
https://platypod.com/
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NEW ENGLAND CAMERA CLUB COUNCIL 

Honorary Member New England Camera Club Council (HonNEC)  

Harold T. Ahern 
Mary Campagnolo 
Leslie A. Campbell 

Richard Cloran 
Lisa Cuchara 
Michael DiStefano 

John C. Fuller 
Antoinette Gombeda 
Dennis Goulet 

Raymond A. Guillette 
Leroy Marshall 
Hazel Meredith 

Jacob Mosser III 
Susan C. Mosser 
Barbara Rozavsky 

J. Owen Santer 
Rick Sereque 
Art Vaughan 

Audrey A. Weigold 
Olive M. Weingart 
David Yankee 

Honorary Life Vice Presidents of NECCC  

Harold T. Ahern  
 

John C. Fuller 
Antoinette Gombeda 

Jacob Mosser III 
Susan C. Mosser 

J. Owen Santer 
Audrey A. Weigold 

Olive M. Weingart 
 

Master Member New England Camera Club Council (MNEC)  

Malcolm Anderson 
Aurelle Appel 
Ted Appel 
William B. Barnett 
Patricia Benham 
Robert Binette 
Mary Dyer Boucher 
Thomas Briere 
Patricia Brundage 
Charles Burke 
Daniel D. Charbonnet 
Marilyn Cloran 
Adele Collins 
Kenneth E. Cook, Jr.* 
E. Kent Crossley 
Rhonda Cullens 
Peter Curcis 

Nick DeCondio 
Tom Cuchara 
Paul E. Deegan, Jr. 
Leonard D. Dessormeau 
Josephine DiMauro 
James L. Dionne 
Brenda Driscoll 
A. Cemal Ekin 
Robert Fedder 
Edie Francoeur 
James Gately 
Karen Geaghan 
Chris Germain 
Dave Godin 
Gail Hansche-Godin 
Joshua Goldin 
Loretta Paul-Goldin 

Bernard Gombeda 
Michael R. Goodman 
Merle Gordon 
Robert B. Gorrill 
Cynthia Gosselin 
Glenn Guaraldi 
Jane W. Guaraldi 
Mary K. Hall 
Meredith Harris 
Dana Hoffman 
Carlton (Skip) Hoyt 
Gary Hoyt 
Judi Hoyt 
Gordon Johnson 
Kenneth Jordan 
Ruth E. Kahn 
Elizabeth M. Keery 

Richard E. Kenyon 
John Kerns 
Martha Kerns 
Alan Kidawski 
Robert Lehanka 
Pamela S. Lintner 
John C. Lowe, Jr. 
Fran MacDonald 
Rob MacFarlane 
Maureen Mathieson 
Todd Mathieson 
Daniel McGrath 
Michael McNeill 
David Meredith 
Hazel Meredith 
Ron Morse 
Amy Musinsky 

Sarah Musumeci 
Bud Morton 
George H. Nieske 
Tom Noonan 
Richard A. Novak 
Michael J. O’Connor 
Winifred Pannebaker 
David Parsons 
Dana Patch 
Robert Patterson 
Paul Penning 
Charles H. Perry 
Paul Peterson 
Jude Plante 
Marian M. Rich 
Bruce Ricker 
Karolyn Ricker 

Michael J. Roman 
James Santerre 
Kathleen Savage 
Richard Savage 
Karl Schanz 
Bert Schmitz 
Charlotte I. Seidl 
Peter M. Selig 
Jean Simmons 
Richard Simmons 
Harold G. Simms 
David Singer 
Robert K. Singer 
Harold Sisken 
Lincoln A. Smith, Jr. 
Paul Smith 
Gary W. Stanley 

Ruth Tabor 
Linda Thomas 
Steve Tierney 
Arthur Tribou 
Christine Tribou 
Shiv Verma 
Marilyn Wagner 
James Warner 
Henry Weisenburger 
Kenneth Wiedemann 
Milt Williamson 
Ann Yost 
Arthur Yost 
Gordon Yu 

Frank Zaremba 

Associate Member of NECCC (ANEC)  

Marc Farb 
Gary Farber 
 

Richard M. Frieders 
Gil Lopez-Espina 
 

Andre Gallant 
Roman Kurywczak 
Steven Inglima 

Lou Jones 
Joe LeFevre 
Peter Van Rhijn 

Albert L. Sieg 
Robert Watts 
 

Leonard Zorn 
Maria Zorn 

* Deceased since last conference    BADGES MUST BE WORN AT ALL TIMES  

Honorary Vice Presidents of NECCC 
Diane Burns  Shelley Gibbons  
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OFFICERS OF THE NEW ENGLAND 
CAMERA CLUB COUNCIL, INC. 

President 
Daniel Charbonnet,  
HonPSA EPSA MNEC 
91 Mayfair Dr. 
Westwood, MA 02090  
ddrc3@msn.com 

 

Treasurer 
Richard Cloran,  
HonPSA MPSA HonNEC  

802 Humphrey Street 
Swampscott, MA  01907 
mrcloran@comcast.net 

Secretary 
Mary Campagnolo, APSA HonNEC   

14 B Berry Street 
Danvers, MA 01923 
ml.cam@verizon.net 

Chairman of the Board 

Antoinette Gombeda,  
APSA HonNEC 
817 Chickadee Lane 
Stratford, CT 06497 
agombeda@optonline.net 

Steering Committee - VP 

Susan Mosser, HonPSA HonNEC 

173 Central Street   
No. Reading, MA 01864 
s.jmosser@comcast.net 

2018-19 Conf. Co-Chm. VP 
Lisa Cuchara, HonNEC 

60 Braeside Drive 
Hamden, CT 06514 
photographer67@comcast.net 

2018-19 Conf. Co-Chm. VP 
Tom Cuchara, MNEC 

60 Braeside Drive 
Hamden, CT 06514 
tlcbam@comcast.net 

Clerk 
Richard Cloran,  
HonPSA MPSA HonNEC  

802 Humphrey Street 
Swampscott, MA  01907 
mrcloran@comcast.net 

 

 

HONORARY LIFE VICE PRESIDENTS 

Harold T. Ahern, FPSA HonNEC 
6 Cypress Lane 
Wilbraham,  01095  
lhahern@aol.com 

John Fuller,  
HonPSA AFIAP HonNEC  

135 Rob Road 
N. Brooklin ME 04616 
jfuller97n@aol.com 

Antoinette Gombeda,  
APSA,  HonNEC 
817 Chickadee Lane 
Stratford, CT  06497 
agombeda@optonline.net 

Jacob Mosser III,  
HonPSA EPSA HonNEC 
173 Central Street 
No. Reading, MA  01864 
s.jmosser@comcast.net 

Dr. Owen Santer, APSA HonNEC 
15 Pleasant Place 
E.Longmeadow, MA  01028 
osanter@charter.net 

Susan Mosser, HonPSA HonNEC 

173 Central Street 
No. Reading, MA  01864 
s.jmosser@comcast.net 

Olive Weingart, APSA HonNEC 
130 Gillette Road 
New Hartford, CT 06057 
omweingart@sbcglobal.net 

Audrey Weigold, APSA HonNEC 
29 Wallens Hill Road 
Winsted, CT  06098 
aaweigold@charter.net 

  

GENERAL ACTIVITIES  
VICE PRESIDENTS 

Color Print Circuit 
Judi Hoyt, MNEC 
Gary Hoyt, MNEC 
P.O. Box 393 
Middleton, MA  01949 
gaju@comcast.net 

B&W Print Circuit 
Michael DiStefano, APSA HonNEC 
22 Orchard Street 
No. Providence, RI  02911 
madmanmiked@hotmail.com 

Digital Circuit 
Shiv Verma, APSA, MNEC 
562 Dedham Street 
Wrentham, MA  02093 
s.verma@me.com  

Electronic Image Competitions 
William B. Barnett, APSA GMPSA MNEC 
5003 Ashlar Village 
Wallingford, CT  06492 
wbbbarnett@gmail.com 

Print Competitions and 
NECCC Best Print 

Arthur Vaughan, HonNEC 
124 Boston Street 
No. Andover, MA  01845 
thylacine1936@verizon.net 

AND 
Cindy Gosselin, MNEC 
801 Highcroft Place 
Weatogue, CT  06089 
cgosselin@sbcglobal.net 

Special Projects 
Roy Marshall, HonNEC 
55-9 S. Meadow Village 
Carver, MA  02330 
roymar2@comcast.net 

Taped Commentary and 
Recorded Lectures 
Daniel Charbonnet, HonPSA EPSA MNEC 
91 Mayfair Dr. 
Westwood, MA 02090  
ddrc3@msn.com 

Trophies & Ribbons  
Jacob Mosser, III,  
HonPSA EPSA HonNEC 

173 Central Street 
No. Reading, MA  01864 
s.jmosser@comcast.net 

Club Service Packet 
Rhonda Cullens, MNEC  

9 Founders Lane 
Sandy Hook, T  06482 
Rhonda@ccullens.com 

SPECIAL SERVICES 
VICE PRESIDENTS 

Speakers & Judges Listing 
Daniel Charbonnet,  
HonPSA EPSA MNEC 
91 Mayfair Dr. 
Westwood, MA 02090  
ddrc3@msn.com 

Honors Committee Chm. 
Paul Smith, MNEC  
117 Upland Road 
Marlboro, MA  01752 
diffangle@aol.com 

 

Historian&Memorial Fund Chm  
Richard Novak, MNEC 
157 Forest Hills Road 
Springfield, MA 01128 
richard.afn@gmail.com 

General Fund Chairperson 
Susan Mosser, HonPSA HonNEC 
173 Central Street 
No. Reading, MA  01864 
s.jmosser@comcast.net 

Scholarship Committee Chm. 
Antoinette Gombeda,  
APSA, HonNEC 
817 Chickadee Lane 
Stratford, CT 06497 
agombeda@optonline.net 

Individual Conference Mailing 

Dennis Goulet, HonNEC 
164 Plain Street 
Rehoboth, MA  02769 
dennis.goulet@comcast.net 

Club Conference Mailing 

Raymond Guillette, HonNEC 

P.O. Box 596 
Attleboro, MA  02703 
ray.guillette@comcast.net 

Club Membership 
Maureen Mathieson, MNEC 
maurmath@comcast.net 
Todd Mathieson, MNEC 
toddmathie@comcast.net 
13 Ontario Drive 
Hudson, MA  01749 

NECCC Website Bulletin 
Paul Smith, MNEC  
117 Upland Road 
Marlboro, MA  01752 
diffangle@aol.com 

Website & Social Media 
Lisa Cuchara, HonNEC 

60 Braeside Drive 
Hamden, CT 06514 
photographer67@comcast.net 

NECCC Information 
P.O. Box 2544 
Springfield, MA  01101 
Website:  www.neccc.org 

NECCC News Blog 
www.necccnews.blogspot.com 
www.neccc.org 
Subscribe to NECCC Blog  

http://NECCCnews.blogspot.com 

Publicity Chairmann 
Rhonda Cullens, MNEC  

9 Founders Lane 
Sandy Hook, T  06482 
Rhonda@ccullens.com 

To Post Photo Event, Email  
photographer67@comcast.net 
Put NECCC Blog in Subject Line 

CONFERENCE COMMITTEE VICE PRESIDENTS 
2018-19 General Co-Chairmen 
Lisa Cuchara, HonNEC 

photographer67@comcast.net 
Tom Cuchara, MNEC 

tlcbam@comcast.net 
60 Braeside Drive 
Hamden, CT 06514 

Conference Venue Signs 
**James Dionne, MNEC 
131 Pembroke Court 
Meriden, CT 06450 
jimski42@gmail.com  

Door Prizes and Vendor Liaison 
Dennis Goulet, HonNEC 
164 Plain Street 
Rehoboth, MA  02769 
dennis.goulet@comcast.net 

Youth Director 
Karen Geaghan, MNEC 
15 Addison Road 
Wilbraham, MA  01095 
karen@karengeaghanphotos.com 

Hospitality & Information 
Terri Smith 
55 Yacht Street 
Bridgeport, CT  06605 
tsjewelian@aol.com 
 

Pre-Conference Activities 
Antoinette Gombeda, APSA HonNEC 
817 Chickadee Lane 
Stratford, CT 06497 
agombeda@optonline.net 

Equipment Director 
**Becky Lauderback 
**Craig Lauderback 
189 Groton Road 
Ayer, MA  01432 
kathrynspride@aol.com 

Door Prize Assistant 
Sue Babin 
3 Lloyd Bowen Court 
Glocester, RI  02814 
sulybab@cox.net 

Photo Ops 
Chris Germain, MNEC 
62 Valiant Way 
Salem, MA  01970 
germain9898@gmail.com 

Conference Photographer 
Paul Smith, MNEC  
117 Upland Road 
Marlboro, MA  01752 
diffangle@aol.com 
 

Equipment Coordinator and  
Camera Loaning Liaison 
Susan Mosser, HonPSA HonNEC 

173 Central Street 
No. Reading, MA  01864 
s.jmosser@comcast.net 

Speakers’ Notes and Projected 
Image Competition 
Pam Lintner, MNEC 
18 Weatherly Drive, #6 
Salem, MA  01970 
pamlintner53@gmail.com 

Vendor Assistant 
Nancy Marshall 
20 Long Pond Road 
Brewster, MA 02631 
nancyrdh@comcast.net 

AND 
Barbara E. Rozavsky, HonNEC  

62 Valiant Way 
Salem, MA  01970 
barbphoto@mac.com 
 

Committee & Speaker 
Registration 
Meredith Harris, MNEC 

4 Crestwood Circle 
Farmington, CT 06032 
maharris22@sbcglobal.net 

Production Director 
David Yankee, HonNEC 
22 Johnson Avenue 
Chicopee, MA  01013 
yankeedry58@gmail.com 

Print Competitions 
Arthur Vaughan, HonNEC 
124 Boston Street 
No. Andover, MA  01845 
thylacine1936@verizon.net 
 
** Not an NECCC Officer 

Conference Printing 
**Hazel Meredith, APSA, HonNEC 
375 N. Abram Street 
Stratford, CT 06614 
hazel@meredithimages.com 

Model Photography 
Skip Hoyt, MNEC 

12 Ide Street 
Reading, MA  01867 
skiphoto@comcast.net 

Courtesy Enrollment 
Fran MacDonald, APSA MNEC 
131 Upswept Lane 
So. Burlington, VT  05403 
fmacdonald@verizon.net 
 

 


